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1. Getting Started with neoCatalog

Design Searching and Navigation

neoCatalog gives you the ability to search and navigate through the application for designs to focus on specific
keywords, statuses, customers assigned to designs, exclusivities, dates, and design types.

TABLE OF CONTENTS

Selection
Sorting
Quick Search
Advanced Search

Selection
Clicking on the preview in it will add the design or colorways to the selection and allows you to perform actions with
multiple items. From the right-top icon, you can select all items on the current page or deselect them.



Sorting
The tab situated at the top of the browser of the design allows you to select what designs you wish to view, or in what
order you want to see them. The default sorting you can set up in Administration.



Quick Search
The search field at the top bar allows you to search in a quick and simple way. For a detailed and accurate design
search use the advanced search option that opens on the left sidebar. You can do the search for designs when
selecting the 'By Design code' tab option, which will search for the design code, name, or alias name. Click on the



loupe button to start the search and you will get your results listed. Another way to search for designs is by selecting
the 'By Keywords' tab option which will search for designs that contain keywords. Simply select the existing used
keywords and click on the loupe button to start the search.

Advanced Search
If you wish to see your designs and apply filters, the loupe button next to the quick search field opens a sidebar with
searching options. Obviously, if designs contain no information the search will not produce results. Once your
choices are made, click on the 'Apply filters', in order to start the filtering for designs with search credentials. When
your search meets your needs, you can see the designs displayed in the browser.  With 'X' you can abort the
advanced search. Here every search can be extended in an accurate design search while starting searching by code
or by keywords. 

The neoCatalog desktop app version has limitations in fields. If you work with the neoCatalog 
Server version, you will be able to work with custom fields and custom dialogs and customize 
the server dialogs.

https://inedit.freshdesk.com/en/support/solutions/articles/14000139742-custom-fields-and-custom-dialogs-management


For multiple criteria search you can set search terms to match ALL or ANY in the search.

Search for ALL with custom fields is limited. It will show the same result for ALL and ANY. 

If you work with the image tags indexing function, you will have more options available in search options. Search
for visually similar images by a button in the header bar on the home design page:

Or use Advanced Search to search by image or tags:



Related articles:

Custom Fields and Custom Dialogs Management

Setup of categorization options

Design and Colorway viewing options

neoCatalog offers many options to view designs and colorways in different parts and cases to get the most out of the
design characteristics.

TABLE OF CONTENTS

Colorway View
Preview Modes
Design Size Dimension
Ruler on Detail view
Colorway Cover Image

Colorway View
If you wish to view a design colorway, double-click on it, or click on the 'View' button from the menu bar that shows the
option Colorways or Detail View . You can do this from each showroom. If your selected design contains more than
one embedded colorway, neoCatalog will show you all the colorways contained in the selected design. Double-click
on the colorway will direct you straight to the detail view colorway page.

https://inedit.freshdesk.com/en/support/solutions/articles/14000139742-custom-fields-and-custom-dialogs-management
https://inedit.freshdesk.com/en/support/solutions/articles/14000139303-setup-of-categorization-options




When opening a colorway, we access the detail view window, where we can view, edit or export such colorway.



This window shows you the colorway in real size by default. From the bar, you can zoom it in or out, or select a
zoom value. The ruler icon shows/hides the ruler around the preview. If the dimension doesn't match the real
size of your screen, you have the possibility to calibrate the dimension with the dpi icon.
General Information (i) in the upper left corner shows you the default design and colorway information. The
information fields and positions can be customized in custom dialogs . Clicking on the (i) icon can hide/show
this information.
Each color channel is shown below the colorway with channel order, channel name, and color. Colors name is
shown when moving the mouse over the channel. Pressing the 'eye' icon you will see, in black and white, the
separation of that channel.

INFO: Some viewing information can be changed or enabled in the advanced preferences in 
administration. Contact your admin.
- Channel coverage data can  be enabled and viewed in the channel color.
- The ruler can be hidden.

https://inedit.freshdesk.com/en/support/solutions/articles/14000139742-custom-fields-and-custom-dialogs-management


Channel coverage data can be enabled and viewed in the channel color.

Preview Modes
There are two preview modes: Grid and Accordion.

Use 'Grid' mode if you want to view the designs positioned next and below to each other.



Use 'Accordion' mode if you want to flip the designs from one to the other.



In both modes, simulation objects can be applied. Click the simulation icon, on the top-right corner to enable this
viewing mode. From the dropdown list, you can choose the model you want to simulate in the design previews. To
disable the simulation preview, simply click again on the simulation icon. You can associate simulation objects with
colorways, but selecting the object name in the individual colorway.

https://inedit.freshdesk.com/en/support/solutions/articles/14000149065


Browse through designs and colorways in a different way showing designs and colorways using the simulation
objects.



Design Size Dimension
When you select or open a colorway, a new button appears in the menu bar. The button unfolds 3 options that are
related to viewing modes.

Full Rapport - shows the design scaled so that it can be fully viewed, with its repetitions.



Real Size - shows 100% of the design's size.



Presentation Size - shows a scaled design without repetitions.



Ruler on Detail view
The ruler displays the dimensions of the design and can be set to either centimeters or inches. You can switch
between units by clicking the cm/in button located at the bottom-left corner of the ruler.

Colorway Cover Image



The design preview in the showroom is using by default the embedded colorway. 

If you wish to use any other colorway as a new design cover, the option 'Set as cover image' from the '...' button from

the menu bar can make this action. 

Select or open a colorway and the option becomes available.

Related articles:

Associate Simulation Object with Colorways

Custom Fields and Custom Dialogs Management

Setup of categorization options

How to change the offset in the design's preview

Differences between Standalone, Server, and Cloud
Versions of neoCatalog

Standalone
to The desktop application, also refered as nC Basic (.dmg for macOS, .exe for Windows), installed on user stations
with an embedded H2 database faces limitations in both features and usability, making it incomparable to the
functionality of neoCatalog Server.

Due to compatibility issues, neoCatalog Standalone has been discontinued and removed, as it is no
longer available for purchase.

Server

https://inedit.freshdesk.com/en/support/solutions/articles/14000149065
https://inedit.freshdesk.com/en/support/solutions/articles/14000139742-custom-fields-and-custom-dialogs-management
https://inedit.freshdesk.com/en/support/solutions/articles/14000139303-setup-of-categorization-options
https://inedit.freshdesk.com/en/support/solutions/articles/14000139930-how-to-change-the-offset-in-the-designs-preview


The Server version is an Application Service installed on servers, also referred as nC Enterprise. The Windows
server installer (e.g., neoCatalogWeb-X.X.X.exe) is intended solely for fresh installations and will not be publicly
released. Operating on a mySQL database and managed within instances in JavaMonitor, this deployment boasts
no limitations in features. To stay updated, including access to both release and beta versions , we recommend
using the Application Administration interface.

Cloud
Functionally identical to the Server application, the Cloud version is deployed on cloud infrastructure instead of local
servers. Similarly, for updates, including both release and beta versions, we advise utilizing the Application
Administration interface.

Find attached the neoCatalog specification data sheet for every model.

Attachments:

neoCatalog - specification data-sheet (EN)-v19-20200818_145847.pdf 
Fitxa tècnica de neoCatalog (CA)-v4-20200818_145934.pdf 
neoCatalog - Scheda tecnica (IT)-v8-20200818_145951.pdf 
Ficha técnica de neoCatalog (ES)-v5-20200818_145925.pdf 
Fiche technique de neoCatalog (FR)-v3-20200818_145942.pdf 
neoCatalog - Spezifikation Datenblatt (DE)-v11-20200818_150000.pdf 

How to invite users to neoCatalog

Once your neoCatalog is installed and set up , you can invite users via email to join neoCatalog. The invited recipient
will receive one email to accept the invitation and to create their own password to be able to enter neoCatalog.
Optionally, as an administrator of the program, you can create new users from user management .

Step-by-Step
1. As a logged-in user in neoCatalog, from the wheel icon and click on the 'Send invitation Mail' option. 

2. In the dialog enter the email address of the recipient that will be invited to connect to the neoCatalog Server. 

3. Give the recipients a name and select the system group to which the user has to be assigned. neoCatalog
provides system default groups using predefined privileges . For user privileges information check the information
button.

https://inedit.freshdesk.com/en/support/solutions/articles/14000134315
https://inedit.freshdesk.com/en/support/solutions/articles/14000148835
https://inedit.freshdesk.com/helpdesk/attachments/14137537126
https://inedit.freshdesk.com/helpdesk/attachments/14137537127
https://inedit.freshdesk.com/helpdesk/attachments/14137537128
https://inedit.freshdesk.com/helpdesk/attachments/14137537129
https://inedit.freshdesk.com/helpdesk/attachments/14137537130
https://inedit.freshdesk.com/helpdesk/attachments/14137537131
https://inedit.freshdesk.com/en/support/solutions/articles/14000133430
https://inedit.freshdesk.com/en/support/solutions/articles/14000139304
https://inedit.freshdesk.com/en/support/solutions/articles/14000139300


4. The user that has sent the invitation will be notified when the sending invitation has succeeded.

5. The recipient will receive one email providing a link to click on 'Accept Invitation'.



6. Before entering to neoCatalog, it is required that the new user create a personal password. Once created, the
user will be logged in automatically.

7. For starting a new session in neoCatalog, the user needs to be on the login page after opening the neoCatalog
URL in a web browser and entering neoCatalog with the email address where the invitation was received and the
personal password.

Related articles:

Users and Groups Management

User Privileges Management

Start a new login session in neoCatalog

How to register devices and apps in neoCatalog

neoCatalog offers to register devices (neoCatalog iOS) and to register Apps (neoMatch, neoTextil, Control Center)
with QR-code, to establish a fast and easy connection. Using the function makes the sharing of files and data more
efficient.

https://inedit.freshdesk.com/en/support/solutions/articles/14000139277
https://inedit.freshdesk.com/en/support/solutions/articles/14000139304
https://inedit.freshdesk.com/en/support/solutions/articles/14000139300
https://inedit.freshdesk.com/en/support/solutions/articles/14000139277


Using the QR code that neoCatalog creates to connect to other Inedit apps. To do this, go to neoCatalog and log in
with your username and password. In neoCatalog, click on the wheel icon next to the user name tab and select the
option to 'Link App' giving you the options of apps to choose from.

TABLE OF CONTENTS

Link with iOS
Link with Apps

Link with iOS
A new dialog opens with instructions and requests you to install the free app on your device and scan the QR code to
link your neoCatalog iOS with your account. The option to copy the content of the device connection QR code on the
click. It copies the URL to your clipboard. When you press ctrl + v, it pastes the URL.

NOTE: Register neoCatalog iOS requires minimum neoCatalog iOS version 5.3.3 and neoCatalog Web 
version 1.6.5.



Another option is to send an Email from neoCatalog to make the registration of your device. Click on the button Send
Email and it will be sent. Open the email in the device email app and click on the link to make the registration. Make

sure that the neoCatalog iOS app is installed before.  

neoCatalog iOS opens automatically with registration done. 

Link with Apps
A new dialog opens giving options to copy the QR to paste it into the panel. It copies the URL to your clipboard or
click on the application icon to link with the app.



Related articles:

Registered Devices and Apps Management

Licensing Management of neoCatalog

From Administration > Licensing you can manage, view, and update the licenses. The lower part of this page
belongs to the Registered Devices

License Details
Update License

https://inedit.freshdesk.com/en/support/solutions/articles/14000139732
https://inedit.freshdesk.com/en/support/solutions/articles/14000139732-registered-devices-and-apps-management


License Details
All licenses are listed under the labels:

Status
Dongle ID
Organization
Purchase Date
License Type and expiration date
Support and Updates period
Licensed Devices (nC iOS)
Licensed Users (Users with login access to neoCatalog)

With neoCatalog activation, one device is free without a license. With 'Request more' you can ask for more licenses.
A new email window opens, ready to be sent to sales@inedit.com . The Licensed users are based on the
neoCatalog application, where 5 users can be connected simultaneously. If you need to work with more users,
please contact sales@inedit.com .

Update License
With the 'Add license' button you can update your license to use on more devices. Simply select the dongle and fill in
the fields in the open dialog, with all provided license details. To start the activation, click on the Activate button, and
once applied restart the neoCatalog instance from JavaMonitor .

From the same dialog, you can request a new license with the corresponding button.

Related articles:

How to apply XDAT (offline) application license activation

Registered Devices and Apps Management

mailto:sales@inedit.com
mailto:sales@inedit.com
https://inedit.freshdesk.com/en/support/solutions/articles/14000139295
https://inedit.freshdesk.com/en/support/solutions/articles/14000130554-how-to-apply-xdat-offline-application-license-activation
https://inedit.freshdesk.com/en/support/solutions/articles/14000139732-registered-devices-and-apps-management


Registered Devices and Apps Management

neoCatalog offers to register devices (neoCatalog iOS) and to register Apps (neoMatch, neoTextil, Control Center)
with QR-code, to establish a fast and easy connection. Using the function makes the sharing of files and data more
efficient. In the management part, you can view the connected devices and disable/enable them once registered.

The devices cannot be deleted from the management page and needs to be removed from the 
database. Contact your administrator..

Registered Devices
From Administration > Licensing, you can manage and view registered device information. This section of the
management window shows the registered devices, with their device specifications and version. With the checkbox
at the beginning of the device details, you can disable the device, and use the device activation for another device.
Above the device list, you can view how many devices are purchased in your license(s) and used, or request more
device licenses.

Linked Apps
From the Administration > Licensing, on the last part of the page, is the section 'Linked Apps'. here you can manage
and view linked apps and device information. Once linked to apps, with the checkbox at the beginning of the app
details you can disable and enable the app. Once the app is disconnected from neoCatalog, the link must be
established again using the QR code.

Related articles:

How to register devices and apps in neoCatalog

https://inedit.freshdesk.com/en/support/solutions/articles/14000138978


Start a new login session in neoCatalog

Once you have access to your new neoCatalog by being invited o r created provided by an administrator of the
program, and you have the login page open after loading your neoCatalog URL, introduce your username or email
and password in the given fields.

TABLE OF CONTENTS

User Login
Quick Login

After login

User Login
To start a web browser management session, do the following:

1. Start your web browser on the neoCatalog server. 

2. In the URL field of the browser, enter the IP which is the default IP address of the server. If the connection is
open, use the name of the URL address. 

3. Select the language that you want to use during the session. 

4. You can enter your neoCatalog login username or email and password. 

5. Click 'Remember me' to save the username and password (optional). 

6. Press Log in.

 

In case you forgot your password ingredients, use the 'Forgot your password' option to reset 
and create a new password.

https://inedit.freshdesk.com/en/support/solutions/articles/14000142260
https://inedit.freshdesk.com/en/support/solutions/articles/14000139304


The 'Remember me' option in login, it will be stored for each URL and it will last for 1 
month.

To close the neoCatalog session, close the browser window or Logout from the tab with the user name. neoCatalog
web browser session remains active as long as you don't link to other sites or you do not quit the browser. The

session time without activity lasts 60 minutes, then a new login is required. 

Quick Login

Advanced option to enable and activate quick login feature for individual users. Once in use, just with only one click
the user is logged in. Contact your administrator to enable the feature .

Watch Video: https://player.vimeo.com/video/794041306

After login
The first window you get into is Designs View. The menu, header, tab, and navigation bars are indicated in every
design and colorway view.  In the use of optional features, more buttons and actions will be added to the bars.

The preview size and labels can be customized in A d m i n i s t r a t i o n .

https://inedit.freshdesk.com/en/support/solutions/articles/14000140639-quicklogin-to-authenticate-users-without-password-advanced-
https://player.vimeo.com/video/794041306
https://inedit.freshdesk.com/en/support/solutions/articles/14000139727-customize-preview-style


The header bar is on the top-right of the neoCatalog browser.

User Login The user login name and logout.

Administration Access to Administration management and device deployment.

Notifications With notifications, you'll be informed quickly about your activities.

The tab bar is located at the top of neoCatalog's browser. There are graphic tabs that take you to different pages in
the program. Click on any tab to go directly to that page.



Designs Displays the designs showroom in neoCatalog from every page.

Simulations Opens object models to view your design in 3D from every page.

Galleries Displays the galleries in neoCatalog from every page.

The navigation bar is in the center of the neoCatalog browser.

Search Options The search field lets you search for designs and opens advanced search
options.

Sorting Options Allows selecting what designs in which order you wish to view.

Reduce Thumbnails Reduces the size of the preview thumbnails.

Enlarge Thumbnails Enlarges the size of the preview thumbnails.

Grid Mode Shows designs in Grid mode preview.

Accordion Mode Shows designs in Accordion mode preview.

Simulations Designs and Colorways applied to one simulation object.

The menu bar sits at the bottom of the neoCatalog browser and consists of menu pop-up lists.

Import Items Import new designs, colorways, and other items.

Edit Items Manages design/colorway information and colors edition or elimination.

Print Items Print option to generate print files or send them to the printer.

Share Items Access the options to share designs/colorways.

Export Items Access the options of generating and exporting designs/colorways.

View Items Displays different options for design view.

Download Items Access the options of downloading designs/colorways.

More More options are available in feature customizations.

Related articles:

neoCatalog Server version installation in Windows Server

Download and install the neoCatalog App

https://inedit.freshdesk.com/en/support/solutions/articles/14000133430-neocatalog-server-version-installation-in-windows-server
https://inedit.freshdesk.com/en/support/solutions/articles/14000139296-download-and-install-neocatalog-app


Working with neoCatalog iOS App

This user guide empowers you with insights into the neoCatalog iOS app.

TABLE OF CONTENTS

Introduction
About neoCatalog iOS App
System Requirements

Installation and Setup
Initial Configuration

Navigating the App
Home Screen

Working with Designs and Colorways
Interface Customization

Interface Compatibility
Dark Mode and Light Mode
Device Rotation and Embedded Browser

Introduction
About neoCatalog iOS App
The neoCatalog iOS app is a powerful tool designed to streamline your design and colorway management process,
enabling you to enhance your workflow and productivity. With this app, you can access and interact with your design
libraries, create production orders, and utilize a range of features to meet your design and color management needs.

System Requirements
Before you start using the neoCatalog iOS app, ensure that your device meets the following system requirements:

iOS Version: iOS 13 or later.
Internet Connection: A stable internet connection is required for synchronizing data with the neoCatalog web
platform.

Installation and Setup
Download and Installation

1. Visit the App Store: Open the App Store on your iOS device.
2. Search for "neoCatalog iOS": In the App Store's search bar, type "neoCatalog iOS" and press "Search."
3. Install the App: Locate the neoCatalog iOS app in the search results and tap "Install" to download and install it

on your device.
4. Open the App: Once the app is installed, tap "Open" to launch it.

Initial Configuration
Upon opening the app for the first time, you will need to configure some initial settings:



1. Login: Enter the neoCatalog Server URL or scan the QR code to access your neoCatalog account. If you do not
have an account, please contact your system administrator to set up your account on the neoCatalog Server.

2. Installation of Design and Data: If prompted, follow the on-screen instructions to install design data for seamless
access to your design and colorway collections. Ensure that your device is connected to the internet to synchronize
data with the neoCatalog web platform, ensuring that you have access to the latest design updates.

https://inedit.freshdesk.com/en/support/solutions/articles/14000138978


Navigating the App

The home screen serves as the central hub for accessing various app functionalities. Here are some key elements:

Design Browser: Access, browse, and interact with your design and colorway collections seamlessly, with the
ability to easily locate, select, and explore various design-related actions and configurations.



Galleries: Easily create, work offline, and seamlessly publish your galleries.



Production Orders Queue: Efficiently oversee your production orders, from creating new ones and tracking
their progress to specifying details, making edits, and refining order details, all while seamlessly managing
order identification and tracking through temporary codes, within a streamlined production process. 



QuickPrint: Utilize the QuickPrint feature to expedite the printing of designs with ease.



Print Server in Control Center: Easily configure, manage, and monitor print jobs directly from the app for a
seamless and hassle-free printing experience.



Working with Designs and Colorways
The design browser is a fundamental feature that allows you to:

Color Channel Management: Manage color channels within your selected designs, view coverage values, and
customize your colorway preferences. Fine-tune color channels to create unique colorway variations.



Design Simulation: Simulate designs on objects to accurately visualize their real-life impact and access texture
group colors for a comprehensive understanding of design effects.



Adding Local Images: Import local images directly into your design library from sources like the Photo Library
or Camera.



Search and Filters: Efficiently search for specific designs or colorways using various criteria such as keywords,
creation dates, and status. Filters further refine your search results.



 Design
Information: Access comprehensive design information, including technical details, search information, and
total coverage values.



Interface Customization
Interface Compatibility
Adaptable interface for diverse devices:

The neoCatalog iOS app is compatible with both iPad and iPhone devices running iOS 13 or later.

Dark Mode and Light Mode
Personalized interface experience:

Choose between dark mode and light mode to tailor the app's appearance to your preferences.

Device Rotation and Embedded Browser
Effortless navigation:



The app seamlessly adapts to changes in device orientation, ensuring a consistent user experience.
Access the embedded browser to interact with the neoCatalog web interface without leaving the app.

Related articles:

Registered Devices and Apps Management

How to register devices and apps in neoCatalog

neoCatalog Help widget connected to knowledge
base

The help widget connects with the Freshdesk knowledge base that can be enabled with the preference "show
neoCatalog help" in the Administration Preferences in the Login Page section.

https://inedit.freshdesk.com/en/support/solutions/articles/14000139732
https://inedit.freshdesk.com/en/support/solutions/articles/14000138978
https://inedit.freshdesk.com/en/support/solutions/articles/14000139725-customize-login-page-and-logos


When enabled, the green button on the footer menu appears where you open the search panel to search for topics.



Related articles:

Customize Login Page and logos

2. User Management

Difference between Groups and Organizations in
neoCatalog

In neoCatalog, aligning users for effective teamwork is key to maintaining a stable workflow. There are several ways
to organize users and create collaboration in User Management .

Groups

https://inedit.freshdesk.com/en/support/solutions/articles/14000139725-customize-login-page-and-logos
https://inedit.freshdesk.com/en/support/solutions/articles/14000139304


What They Are: Groups allow you to organize users based on their roles and responsibilities within
neoCatalog, similar to job titles (e.g., Designers, Administrators, Sales). Each group is assigned specific
tasks and permissions.
Why They're Useful: Managing permissions is much simpler with Groups. Rather than assigning access
rights to individual users, you can configure them once for the entire group. This ensures everyone in the group
has the appropriate permissions, such as the ability to create or edit designs.

Key Features:

Assign specific roles (referred to as "categories") to each group, determining what they can view or edit.
Group settings apply to all members, so there's no need to configure permissions for each person individually.
Ideal for managing a large number of users with similar roles and responsibilities within the system.

Best for managing permissions based on roles (e.g., designers, salespeople). You define what actions group
members can perform.

Organizations
What They Are: Organizations allow you to group users and contacts under a company or client. Users within
an Organization can view all designs related to that company, though they cannot see user-specific designs
unless explicitly shared.
Why They're Useful: Organizations are perfect for managing clients or companies where multiple users need
to access shared designs. This setup is particularly helpful when collaborating with external partners or clients.

Key Features:

Users and contacts are both included in an Organization, granting them shared access to the same designs.
Designed for aligning multiple individuals working with or for a specific client or company, enhancing
collaboration.

Best for organizing users and contacts under a company or client. Members of an Organization share access to the
designs related to that company.



Related articles:

Users and Groups Management

How neoCatalog Agents manage galleries and
exclusivity

In neoCatalog, Agents (Users assigned to the Store category) have specific roles and permissions. They are users
responsible for managing galleries and designs, often working as intermediaries or sales representatives. Their
primary tasks include:

Gallery Ownership : Agents in the Store category can own galleries and are expected to see both public
galleries and their own galleries.
Exclusive Designs : Agents should only see exclusive designs in their galleries, not in general searches.
Advanced Permissions : Store Agents often require precise configuration to align their privileges with
business needs.

How Exclusive Designs Work for Agents

Exclusive designs are a special category of designs that are restricted:

They should see exclusive designs in their own galleries .
Exclusive designs should not appear in the general design search unless specifically shared.
Advanced search options for exclusivity are hidden to prevent unauthorized access.

This case highlights how configuration can impact what Agents can and cannot see.

Step 1: Set Preferences
Step 2: Assign the Store Category to the User
Step 3: Configure Privileges
Result

https://inedit.freshdesk.com/en/support/solutions/articles/14000139304


Step 1: Set Preferences

To configure gallery and exclusivity settings for Agents in the Store category:

gallery_owner_only_customer : Set to NO .
galleries_hide_exclusives : Set to NO .

Step 2: Assign the Store Category to the User

Ensure the user is assigned to the Store category in User Management. This category defines their role and sets the
foundation for their access permissions.

Step 3: Configure Privileges

Privileges control what the user can do and see. Use the provided screenshots as a guide to set up appropriate
permissions for gallery access and exclusivity:



Result

When configured correctly:

1. The Agent will see only their owned galleries and not other users' galleries.
2. Exclusive designs in their galleries will be visible to them.
3. The general design search will not show exclusive designs unless permissions explicitly allow it.

How to get Designers (Users) to own designs

Up until version 3.11.

Design and colorway ownership is a term that may lead to confusion initially.

Often ownership is wrongly assumed as the access to artwork by a user in order to change its colors or printing
layout, the kind of tasks that belong to users with the privilege to create or edit such artworks, that’s to say, Designers
and colorists, who have been hired for that.

Ownership is rather defined by a purchase. Whereas Designers or colorists are employees or collaborators,
customers are those who acquire their work outcome through a deal with the design supplier company.

On the "Management/Users" section, users with the "User" category can be added. This is the category in which
Designers and colorists belong.



Default "User" privileges:

Since "Owned" is their default privilege to edit designs and colorways, and Designers and colorists don't own either
designs or colorways, they are not allowed to do such actions when recently added to the user list.

User's privileges can be set to "Allowed" by the Administrator at any time, but this would apply for all designs or
colorways, and perhaps not all are suitable for that very user and privilege.

In case you are a neoCatalog Administrator and want to assign design and colorway ownership to Designers we
kindly ask you to contact Inèdit to get this privilege working like that.

Since version 3.12.0

A preference was added to change the behavior of the privilege "Owned" for Designers so that they are allowed to
manage designs and colorways without any restriction.

This preference is selected by default. Should Administrators decide to stop the "Owned" privilege from working like
this and take it back to the old behavior, they can unselect the checkbox located in "Administration/ Preferences/
Display Options". This change would only concern Designers.



Related articles:

Display Options Settings

User Privileges Management

https://inedit.freshdesk.com/en/support/solutions/articles/14000139728-display-options-settings
https://inedit.freshdesk.com/en/support/solutions/articles/14000139300-user-privileges-management


How to have only admins modify keywords in design
information

There are design information field data that can be restricted for some users. In this example, we show how one
admin user can add/remove while one user can view the data, but not remove it.  This can be managed by custom
dialogs management. You can create multiple dialogs for different categories.

In the case of the keyword data, the admin category would have one custom dialog setup to view and right the data,

https://inedit.freshdesk.com/en/support/solutions/articles/14000139890


While the user category has a customer dialog setup that allows one to view the data, but read-only.



The result would be, that the admin can add/remove the information in the keyword,



but the user will be able to view it only and still be able to access the Edit design dialog.

Related articles:

Custom Fields and Custom Dialogs Management

User Privileges Management

https://inedit.freshdesk.com/en/support/solutions/articles/14000139742
https://inedit.freshdesk.com/en/support/solutions/articles/14000139300


How to work with groups of users

neoCatalog offers very sophisticated management of groups of users. To access the group's management, go to
'Management' in administration and find the listed option in 'Accounts'.

Default system groups
There are some default groups, but administrators are free to set up and edit groups in any way they see fit.

The four special groups in neoCatalog are:

Administrators will be able to perform most of the administrative functions, like assigning privileges to other
users. They can also access the neoCatalog Administration page. 

Customers will be able to:
Designs: View (only owned), Export (only owned)
Colorways: Create, Export (only owned)
Simulations: View (only owned) 

Designers will be able to:
Designs: View, Edit, Create, Export



Colorways: View, Edit, Create, Export
Galleries: Edit, Create
Users: Create
Simulations: View 

Sales will be able to:
Designs: View, Edit
Colorways: Edit, Create
Galleries: Edit, Create
Users: Create
Simulations: View

Create Groups

Clicking on the 'Create Group' button opens a new dialog where you can introduce the group's name. Once the group
is created, you will see it listed alphabetically in the group view. Now, in this new group, the category and members
have to be assigned. Click on the group name to enter the group.

 

Or, from vertical dots  , you can do:

Edit: Direct you to the group information fields.
Duplicate: Creates a duplicate with name and category. Other required data has to be added and must differ
from the original.
Delete: Removes the group and the assigned user will be released.

Manage Groups
Before adding members, the group needs the category with permission. From 'Edit Group Permissions' you will
access the modification options.



Once entered, you will see three parts to select the according options:



Category: Select the category to which the group should be assigned.
Privileges: View the default privileges according to the selected category or set the privileges that fit best.



Filter: Assign search filters that the group users can see only in the neoCatalog. 

You can propagate privileges to the group's members, which means that the group privileges will overwrite single
users' privileges, or else take the group's privileges and assign them to a user when the user is selected.

Speaking of users, after the group category and privileges edition now is the moment to add group members. Go
back to the group view with '< Back to Groups' and search for the user name in the field, select and add it to the
group. From vertical dots  you can edit the user or delete from the group.

Back in the group's listed view, you can see the newly created group is using a category and has one member.



User Privileges Management

This is a key tab for Administrators of neoCatalog. Privileges are the possibilities of each user to Create, Edit, View,
Delete, or Export designs, among others. Each privilege permits one to choose between the choice Allowed or Not
Allowed , and Owned , which means that only the designs owned by the customer or designer user can be viewed,
exported, etc.

neoCatalog offers default privileges for the given user's categories. All of the default privileges can be customized to
match specific needs.

You need to be an administrator to grant user privileges using this method. Usually, the administrator is the person
who created the users, but they can also allow other admins. Members of the administrator's group can also do this.

Categories of Privileges
Default Privileges

Administrator
Users
Customers



Manager
Store
Printer

Categories of Privileges
1) Asset Management Permissions: This category defines user rights related to core actions, such as creating,
editing, viewing, deleting, and exporting assets. These include Designs, Colorways, Users, Galleries, Ambients, and
Attachments. Administrators can tailor access to these functionalities based on specific user roles.

2) Access to Design and Sales Information: Privileges in this category focus on controlling the visibility of
sensitive information. It includes options to grant or restrict access to detailed design viewing modes and sales data.
Additionally, this category enables specific rules for handling Exclusive and Owned designs, ensuring they remain
hidden when necessary. Advanced editing options also fall under this category, allowing restrictions on design
verification processes. 

3) Export and Sharing Controls: This section refines the export and sharing capabilities beyond the basic
permissions of the first category. It allows administrators to configure user access to export options, including file
downloads and sharing features, ensuring these actions are limited to authorized users.



Default Privileges
Administrator



Performs management tasks in neoCatalog and has no restricted access.

Users

Performs usage tasks in neoCatalog and has restrictions in interaction.

Feature Create Edit View Delete Export
Design Allowed Owned Owned Not Allowed Owned
Colorway(s) Allowed Owned Owned Not Allowed Owned
Users Not Allowed Not Allowed Not Allowed Not Allowed Not Allowed
Customers Not Allowed Not Allowed Not Allowed Not Allowed Not Allowed
Galleries Allowed Not Allowed Not Allowed Not Allowed Not Allowed
Ambients Not Allowed Not Allowed Not Allowed Not Allowed Not Allowed
Attachments Allowed Allowed Allowed Allowed Allowed
Options Permission
Allow disabling Watermarks Allowed
View separations Owned
View Full Rapport Owned
View sales information Owned
Advanced Edit Not Allowed
Export PDF/QuickPrint Owned
Share Items Allowed
Share Samples Allowed
Sections Allowed
View unowned designs Automatic (Allowed)
View exclusive designs Owned
View unverified designs Automatic (Allowed)

Customers

Performs usage tasks as a user for neoCatalog users and has restrictions in privileges.

Feature Create Edit View Delete Export
Design Not Allowed Not Allowed Owned Not Allowed Owned
Colorway(s) Allowed Not Allowed Owned Not Allowed Owned
Users Not Allowed Not Allowed Not Allowed Not Allowed Not Allowed
Customers Not Allowed Not Allowed Not Allowed Not Allowed Not Allowed
Galleries Not Allowed Not Allowed Not Allowed Not Allowed Not Allowed
Ambients Not Allowed Not Allowed Not Allowed Not Allowed Not Allowed
Attachments Allowed Allowed Allowed Allowed Allowed
Options Permission
Allow disabling Watermarks Not Allowed
View separations Owned
View Full Rapport Owned
View sales information Owned
Advanced Edit Not Allowed
Export PDF/QuickPrint Owned

Share Items Not Allowed
Share Samples Not Allowed
Sections Not Allowed
View unowned designs Automatic (Allowed)
View exclusive designs Owned
View unverified designs Automatic (Allowed)



Manager

Performs operating usage of neoCatalog.

Feature Create Edit View Delete Export
Design Allowed Allowed Allowed Allowed Allowed
Colorway(s) Allowed Allowed Allowed Allowed Allowed
Users Not Allowed Not Allowed Not Allowed Not Allowed Not Allowed
Customers Allowed Not Allowed Not Allowed Not Allowed Not Allowed
Galleries Allowed Allowed Allowed Allowed Not Allowed
Ambients Allowed Allowed Allowed Allowed Not Allowed
Attachments Allowed Allowed Allowed Allowed Allowed
Options Permission
Allow disabling Watermarks Allowed
View separations Allowed
View Full Rapport Allowed
View sales information Allowed
Advanced Edit Not Allowed
Export PDF/QuickPrint Allowed
Share Items Allowed
Share Samples Not Allowed
Sections Allowed
View unowned designs Allowed
View exclusive designs Allowed
View unverified designs Allowed

Store

Performs as one agent used to be linked to a customer.

Feature Create Edit View Delete Export
Design Not Allowed Allowed Allowed Not Allowed Not Allowed
Colorway(s) Allowed Allowed Allowed Not Allowed Not Allowed
Users Allowed Not Allowed Not Allowed Not Allowed Not Allowed
Customers Not Allowed Not Allowed Not Allowed Not Allowed Not Allowed
Galleries Allowed Allowed Allowed Not Allowed Not Allowed
Ambients Not Allowed Allowed Allowed Not Allowed Not Allowed
Attachments Allowed Allowed Allowed Allowed Allowed
Options Permission
Allow disabling Watermarks Not Allowed
View separations Allowed
View Full Rapport Allowed
View sales information Allowed
Advanced Edit Not Allowed
Export PDF/QuickPrint Allowed
Share Items Allowed
Share Samples Allowed
Sections Allowed
View unowned designs Allowed
View exclusive designs Allowed
View unverified designs Allowed

Printer

Performs as a storage unit that has functionality in the 'Save to Server' destination for Print option . Requires name in
Alias field to perform as storage.

Feature Create Edit View Delete Export
Design Allowed Owned Owned Not Allowed Owned
Colorway(s) Allowed Owned Owned Not Allowed Owned
Users Not Allowed Not Allowed Not Allowed Not Allowed Not Allowed

Customers Not Allowed Not Allowed Not Allowed Not Allowed Not Allowed

https://inedit.freshdesk.com/en/support/solutions/articles/14000139302-how-to-generate-and-send-print-files-from-print-option


Galleries Allowed Not Allowed Not Allowed Not Allowed Not Allowed
Ambients Not Allowed Not Allowed Not Allowed Not Allowed Not Allowed
Attachments Allowed Allowed Allowed Allowed Allowed
Options Permission
Allow disabling Watermarks Not Allowed
View separations Owned
View Full Rapport Owned
View sales information Owned
Advanced Edit Not Allowed
Export PDF/QuickPrint Owned
Share Items Allowed
Share Samples Not Allowed
Sections Allowed
View unowned designs Automatic (Allowed)
View exclusive designs Owned
View unverified designs Automatic (Allowed)

Related articles:

Users and Groups Management

How to generate and send print files from Print option

Users and Groups Management

neoCatalog offers very sophisticated management of users and groups. As the program has various levels of
management, what is achieved is that users with different professional profiles have access to the platform
according to their profiles.

The user profiles are defined into different types:

Administrator : Performs management tasks in neoCatalog and has no restricted access.
User : Performs usage tasks in neoCatalog and has restrictions in interaction.
Customer : Performs usage tasks as a user for neoCatalog users and has restrictions in privileges.
Manager : Performs operating usage of neoCatalog.

The other profiles are defined as:

Store : Performs as an agent that is linked to a customer.
Printer : Performs as a storage unit that has functionality in the 'Save to Server' destination for the Print
option . Requires name in Alias field to perform as storage.

To access the users and groups management, go to 'Management' in administration and find the listed options in
'Accounts'.

TABLE OF CONTENTS
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Users
On the Users admin page, all kinds of users can be searched with their names and categories.

Create User
Click on the 'Create User' button to create a new user. In the new dialog enter the email address of the recipient that



will be invited to connect to neoCatalog. Give the recipients a name, if it does not exist yet,  and select the system
group to which the user has to be assigned. neoCatalog will assign the default category 'user' using predefined
privileges.

The recipient will receive an email providing a link. Click on 'Accept Invitation' and you will be connected
automatically to neoCatalog Server. If you work with a Standalone app you need to download and install neoCatalog
app , if not done yet.  If the recipient is a new user, before entering to neoCatalog Server it requires creating a new
password.

Once the user is created, you will see it listed alphabetically in the user's list view. Now, this new user is ready for
further editions. Click on the user's name to enter the user information.  Or else, from vertical dots, you can do:

Edit : Direct you to the user information fields.
Duplicate : Creates a duplicate with username and company. Other required data has to be added and must
differ from the original user.
Remove Access : If the user is created with a password, the password will be deleted and the user will be
converted as a contact.

User's information
Personal data

In this tab, the section labeled 'Personal Info' serves the purpose of user identification.

When entering data into the 'Name' field, the system will generate a user's initials as follows:
If both first and last names are provided, the initials will consist of three letters.
If only one name is provided, the system will combine the name with the surname to create the initials.

The email is used for both logging into the system and receiving application notifications.

The alias will be displayed in counters for colorways.

The company field represents the user's relationship with an organization , as categorized under the customer
category.

Filling in the 'Billing address' section is straightforward, with no special features required.

https://inedit.freshdesk.com/en/support/solutions/articles/14000139296-download-and-install-neocatalog-app
https://inedit.freshdesk.com/en/support/solutions/articles/14000153034


Delivery Addresses

In this tab, the Delivery address information is to be filled in and doesn't have any special feature. You can add more
than one delivery address with '+ Add new delivery address.



Login setting
In this tab, the user name is the email that has been used to invite the user.
It allows changing the new password with ' Change Password' .
In 'Category' select the type of user, as explained above, you want to create which has by default its own
privileges . If the user changes to another category, then clicking on ' Apply privileges ' will take the default
preferences of the newly selected category.
The access limit date for each user can also be set through the calendar that unfolds from ' Until '.
The ' Security field allows defining what computers can be connected to neoCatalog, inserting their IP.
If the user has to be a part of a 'Groups', you can select the group name in the list and click on ' Add '.
The custom user Logo can be added with ' Add new logo' . Logo files must be JPG or PNG with an
approximate image size of 90px X 30px. This logo is used in emails when sharing samples .
customer and see their exclusive designs.  (optional) The Agent is available for category customers where you
can define an agent user (store) type to the customer and see their exclusive designs.

Privileges
The following tab is the user privileges section, but we think because of its specifications, it deserves its own article .
Otherwise, continue with the 'Filters' tab.

Filters

This last tab allows choosing the search filters for Collections, Keywords, Trademarks, and Status , which users can
see only in the neoCatalog.

https://inedit.freshdesk.com/en/support/solutions/articles/14000139300-user-privileges-management
https://inedit.freshdesk.com/en/support/solutions/articles/14000139301-share-samples-and-items
https://inedit.freshdesk.com/en/support/solutions/articles/14000139300
https://inedit.freshdesk.com/en/support/solutions/articles/14000139303-setup-of-categorization-options


Collections Filter : Select the collections available in neoCatalog from the unfolded list.
Keywords Filter : Select the keywords available in neoCatalog from the unfolded list.
Trademarks Filter : Select the trademarks available in neoCatalog from the unfolded list.
Status Filter : Select the status available in neoCatalog from the unfolded list.
Date filters : Select the creation dates for designs and colorways.

Api Key

The user's API key is used to interact with other applications.

Groups
Default system groups
There are some default groups, but administrators are free to set up and edit groups in any way they see fit.

https://inedit.freshdesk.com/en/support/solutions/articles/14000139730


The four special groups in neoCatalog are:

Administrators will be able to perform most of the administrative functions, like assigning privileges to other
users. They can also access the neoCatalog Administration page.
Customers are able to:

Designs: View (only owned), Export (only owned)
Colorways: Create, Export (only owned)
Simulations: View (only owned)
Attachments: Create, Export (only owned)

Designers are able to:
Designs: View, Edit, Create, Export
Colorways: View, Edit, Create, Export
Galleries: Edit, Create
Users: Create
Simulations: View
Attachments : Create, Export

Sales are able to:
Designs: View, Edit
Colorways: Edit, Create
Galleries: Edit, Create
Users: Create
Simulations: View
Attachments : Create, Export

Create Groups
Click on the 'Create Group' button to create a new group. A new dialog opens where you can introduce the group's
name.

https://inedit.freshdesk.com/en/support/solutions/articles/14000139300


Once the group is created, you will see it listed alphabetically in the group's view. In this new group, the category, and
members have to be assigned. Click on the group name to enter the group, or from the vertical three dots you can
do:

Edit : Direct you to the group information fields.
Duplicate : Creates a duplicate with name and category. Other required data has to be added and must differ
from the original.
Delete : Removed group and the assigned user will be released.

Manage Group
Before adding members, the group needs the category with privileges. From 'Edit Group Permissions' you will
access the modification options.

Once entered, you will see three parts to select the according options:

Category - Select the category to which the group should be assigned.
Privileges - View the default privileges according to the selected category or set the privileges that fit best.
Filter - assign search filters that the group users can see only in the neoCatalog.

You can propagate privileges to the group's members, which means that the group privileges will overwrite single
users' privileges, or else take the group's privileges and assign them to a user when the user is selected.



Speaking of users, after the group category and privileges edition now is the moment to add group members. Go
back to the group view with '< Back to Groups' and search for the user name in the field, select and add it to the
group. From the vertical three dots, you can edit the user or delete the group.



Back in the group's listed view, you can see the newly created group is using a category and has one member.

Contacts
Contacts are in relation to Users with the difference that one contact cannot access neoCatalog but act to be
assigned in items, such as designs, colorways, and galleries. The Contacts admin page can be searched with their
name and category.

If a contact was a neoCatalog user before that has access with a login and now is converted to a contact, the
previously login email is shown next to the Email in ():



Create Contact
Click on the 'Create contact' button and the page opens to enter the contact's personal data and delivery address, as
explained in the user's management.

Once the contact is created, you will see it listed alphabetically in the list view. Now, this new contact is ready for
further editions. Click on the user's name to enter the contact information, or else, from the vertical three dots you can
do the following:

Edit : Direct you to the user information fields.
Duplicate : Creates a duplicate with username and company. Other required data has to be added and must
differ from the original user.
Invite : Contact can be converted as a user. It will receive the access invitation to create a login in neoCatalog.
Refer to user creation for details.
Convert to User : Allows to convert a contact into a user by adding their email address.

Related articles:

User Privileges Management

neoCatalog API key

QuickLogin to authenticate users without password (advanced)

https://inedit.freshdesk.com/en/support/solutions/articles/14000139300-user-privileges-management
https://inedit.freshdesk.com/en/support/solutions/articles/14000139730-neocatalog-api-key
https://inedit.freshdesk.com/en/support/solutions/articles/14000140639-quicklogin-to-authenticate-users-without-password-advanced-/


How to have users access the Gallery page only (advanced)

Why Agents can’t see owned galleries in
neoCatalog

Issue Description

In neoCatalog, Agents assigned to a specific category Store are unable to see their owned galleries, but they can
still view public galleries. However, Agents assigned to a category store should be able to view both their owned
galleries and any public galleries .

Cause

This issue occurs when the user exists in the system both as a user and as a contact . In the gallery settings, the
ownership is assigned to the contact's email address instead of the user account's name.

Solution

1. Navigate to User Management and check if the affected user is also listed under Contacts.

2. Open the affected gallery and check if the ownership field is set to the user's email (contact record) instead of
the user's name.

3. Replace the email address with the user's proper account name.

4. If the user exists as both a contact and a user, decide whether to:

Rename the contact to distinguish it from the user account.
Delete the contact record to ensure it’s not actively used in other settings.

TIPS:
- When creating new users ensure they are not duplicated as contacts unless absolutely 
necessary. 
- Always assign gallery ownership using the user's name, not their email address.

Why I cannot create a new customer or designer
from advanced search

Problem
I cannot create a new customer or designer from the advanced search.

https://inedit.freshdesk.com/en/support/solutions/articles/14000143030


Solution
You cannot create a new customer or designer from the advanced search.



But you can create customers and/or designers from the Edit Design Info dialog . When you save the design and you
go to Administration > Management > Contacts , then you will see the new customers and/or designers in the list.

https://inedit.freshdesk.com/en/support/solutions/articles/14000139890
https://inedit.freshdesk.com/en/support/solutions/articles/14000139304




Related articles:

Design and Colorway Information

Users and Groups Management

neoCatalog API Key

neoCatalog's API token can be used to interact with other applications. Note that when you generate a new token,
the value will only be displayed once, so be sure to write it down.

In user management , from the user selection go to the tab API Key. In the field of token name, give a name for the
token and click on Generate token.

You will get the token displaced. Copy the token and paste it where you need it. The token has unlimited validation.
Below you will see all tokens listed that you can remove.

Related articles:

https://inedit.freshdesk.com/en/support/solutions/articles/14000139890
https://inedit.freshdesk.com/en/support/solutions/articles/14000139304
https://inedit.freshdesk.com/en/support/solutions/articles/14000139304-users-and-groups-management


User and Groups Management

3. File Importations

Another File Section in neoCatalog

Working with the new sections you can create new areas to define files like Artwork, Original, etc. Once enabled in
module administration and configured in categorization , you can start using it. The new section is located on the top
tabs and at the beginning having no data included.

Add files from create button (types digital or separated) to create the new files. The concept is the same when
importing designs. Make sure to use the check box " Move to: ..." to assign it to the new section. Else, it will be
created as a new design. Once created you can edit, print, or share the file.

https://inedit.freshdesk.com/en/support/solutions/articles/14000139304-users-and-groups-management
https://inedit.freshdesk.com/en/support/solutions/articles/14000139356-application-modules
https://inedit.freshdesk.com/en/support/solutions/articles/14000139303-setup-of-categorization-options




If you need to decide that this file should become a part of the design section and move to other designs, from the
edit option, click on the remove action and it will be removed from the new section and added to all other designs.

Related articles:

Setup of categorization options

Delete Designs and Colorways

Deleting Design and Colorway options can be accessed from the 'Edit' button from the menu bar that appears on all
pages once the design or colorway is selected.

When deleting the Design, it will delete all the included colorways of the design. Deleting Colorways won't affect the
design unless the design is using only one embedded colorway, which is fixed to the design file. Also available with
multiple selections. Be sure you have the correct selection chosen.

https://inedit.freshdesk.com/en/support/solutions/articles/14000139303-setup-of-categorization-options


Design files that have been used for importations and color information will be kept in the folders on the server.
Preview images will be removed from folders.

Related articles:

Import Designs in neoCatalog

Double deleting confirmation (advanced)

Reset design files in neoCatalog

Design Attachments

The attachments option allows you to add and download additional files to the design selected. Users with privileges
to edit and/or export designs will have this option available. Once the option is enabled in Administration , you will
see a new option in the button 'View' available on the bottom menu from the designs and colorways views.

Step-by-Step
1. Select one design and click on the button 'View' and choose 'Add Attachment...'. 

2. In the new dialog upload the attachment (single file upload only).

https://inedit.freshdesk.com/en/support/solutions/articles/14000139889-import-designs-in-neocatalog
https://inedit.freshdesk.com/en/support/solutions/articles/14000139892-double-deleting-confirmation-advanced-
https://inedit.freshdesk.com/en/support/solutions/articles/14000140196-reset-design-files-in-neocatalog
https://inedit.freshdesk.com/en/support/solutions/articles/14000139300-user-privileges-management
https://inedit.freshdesk.com/en/support/solutions/articles/14000139356-application-modules


3. Once uploaded, the file is attached with a time-stamp for better tracking, and you or others with privileges will be
able to download it. Clicking on the file icon you will be able to view the attachment.



4. To view all attachments, click on 'Show Attachments' and it will show all the attachments for the selected design
with the download icon.



Related articles:

Import designs in neoCatalog

https://inedit.freshdesk.com/en/support/solutions/articles/14000139889-import-designs-in-neocatalog


How to import designs with a folder

Currently, it is not possible to import files to neoCatalog in the upload option when using a folder. Instead,
neoCatalog offers you two options to import more than one design at once: Automatic Import in neoCatalog
DropBox or Multiple file import (Server).

TABLE OF CONTENTS

Automatic Import in neoCatalog DropBox
Multiple file import

Automatic Import in neoCatalog DropBox
neoCatalog offers a very practical option to import designs automatically from the hot folder Dropbox, which is
located on the same server where your neoCatalog is. DropBox is generally used to accelerate certain workflows.

The DropBox communicates with the file system and output processing with neoCatalog. neoCatalog scans the
contents of DropBox searching for changes or new files every minute to import or update the designs that are copied
in the Dropbox folder in neoCatalog. Once this process is over, the files will be removed from the Dropbox.

Contact your Administrator to configure Dropbox's shared folder.

If you go to the neoCatalog folder in your server and click on it, you will access all its folders, being Dropbox one of
those: /Library/WebServer/Documents/neoCatalog/DropBox

DropBox contains 2 subfolders: Designs and Photos. The designs folder is to import conventional (separated)
designs, Photos folder is to import digital (photographic) designs.

Supported image formats are:

Multichannel files: PSD, PSB, TIFF, ZIP, and XCM
Digital image files: JPEG, PNG, PSD, PSB, TIFF, and XCM

Multiple file import
One automated option that neoCatalog Server is offering is to import multiple files from connected folders. You can
define the path to the folder and run the background task.



The folder must be local or mounted (alias) to the server where neoCatalog is installed.

Having privileges to enter neoCatalog administration, you will see the option 'Multiple file import' on the top menu.
When selecting it, it will show the process and allows the creation of new import processes.

https://inedit.freshdesk.com/en/support/solutions/articles/14000139888


Follow the steps when creating a new process:

1. Add the path of the local folder to where the files are stored (copy-paste path)
2. Choose if you want to keep or delete the source files after the importation
3. Select the design type of the source files
4. Optionally, when working with Sections , here you can select the sections where all files of the path should

import.
5. When all points are defined, choose if you want to import (files will be imported immediately) or simulate

(checking the source files) the import process.

https://inedit.freshdesk.com/en/support/solutions/articles/14000139357-another-file-section-in-neocatalog


When all points are defined, choose if you want to import (files will be imported immediately) or simulate (checking
the source files) the import process.





After the import process run, you will see a process listed when clicking on the option 'Multiple file import'.  In the
process, you can view all processed source file results.

Related articles:

Import designs in neoCatalog

neoCatalog in external storage

https://inedit.freshdesk.com/en/support/solutions/articles/14000139889-import-designs-in-neocatalog
https://inedit.freshdesk.com/en/support/solutions/articles/14000139888


Import designs in neoCatalog

neoCatalog offers a very easy way to import designs automatically with drag&drop or selection functionality.
neoCatalog allows importing two kinds of design types, Digital or Separated .

In case we want to color the design in channels, the file must be Separated (Multichannel), in format PSD,
PSB, or TIFF.
Digital designs are supported in color modes RGB and LAB and in the formats JPEG, PNG, PSD, PSB, TIFF,
AI, and PDF.

Watch Video: https://player.vimeo.com/video/778921265

In order to do the importation from neoCatalog, make sure that you have the proper privileges 
for create designs. Contact your Administrator.

The design importation data field descriptions are based on the neoCatalog desktop app version 
and have limitations. If you work with the neoCatalog Server version, you will be able to work 
with custom fields & dialogs and customize the server dialogs.

TABLE OF CONTENTS

Import designs
Update designs
Import as New

Import designs
1. From the 'Create' button select Digital Design or Separated Design which will direct you to the import dialog.

2. Drag&drop a file here or click on 'Continue with 'Import'.

3. Once uploaded, it opens the Design Info window automatically to enter or modify design information. Continue with
'Save'. Using the same file name of one existing design in neoCatalog will update the existing design.

https://player.vimeo.com/video/778921265


Design information examples:

File name : Use the file name or counter for the next design number. Can be modified.
Design type : Digital or Separated.
Designer : By default the logged user.
Original: Define an original name (alias).
Customer : Type to search for the customer.
Exclusivity : By default is enabled.  Expiration date available when is exclusive.
Keywords : Select from the given options or type to create new keywords.
Collections: Select from the given options
Comments : Optional

TIP: Refer to Design and Colorways Info and learn how to edit design information in the same 
dialog after importation.

NOTE: Starting from version 3.16.13, importing designs via the "Create" button happens quietly 
in the background, skipping the usual upload progress display that is used to show the 
finished designs. However, there's an advanced preference that lets you use the upload 
progress if needed.

4. After the importation is completed it shows the detailed view of the design in neoCatalog.

https://inedit.freshdesk.com/en/support/solutions/articles/14000139890-design-and-colorway-informations
https://inedit.freshdesk.com/en/support/solutions/articles/14000148965


Update designs
Design update is one process that replaces the file in the application and updates design data.

1. From the 'Edit' button go to 'Edit Design Info...'. This action opens a dialog with design information. At the bottom
of the dialog click on 'Send File'.

2. It opens the drag&drop dialog to choose and upload a new file, as seen in the design importation. Drag&drop a
file here or click. Continue with 'Import'.

3. It will detect the file differences and compare them to the existing file. Continue with the confirmation button.



4. After the importation is completed it shows the detailed view of the design in neoCatalog.

Enbale in-app or email notification to be informed when the importaion is compeleted.

Import as New
Apart from the update you can import it as a new design. This option is enabled with advanced preference .

When importing a design with code 1008 and filename 1008.tif, the system will detect duplicates and prompt for an
update. You can select "Import as New," which opens the Upload Design dialog and renames the file to 1008v1.tif.

The new design will be saved with code 1009. Re-importing 1008.tif will create additional versions (1008v2.tif, etc.).
If no automatic counter is used, the filename (e.g., 1008v1) becomes the new design code.

https://inedit.freshdesk.com/en/support/solutions/articles/14000139388
https://inedit.freshdesk.com/en/support/solutions/articles/14000155839


Related articles:

Keeping upload progress when import design (advanced)

Custom Fields and Custom Dialogs Management

Design and Colorway Information

Delete Designs and Colorways

Design Attachments

How to import designs with a folder

User Notifications - How to receive notifications for activities

Reset design files in neoCatalog

Reset design files is an option and solution to update the new design image file or when an importation error occurs.
 It will remove and regenerate the new files using the original files. 

The button 'Reset design files' you can find at the bottom in the 'Edit Design Info' dialog which is accessible from the
'Edit'  button at the footer bar. 

INFO : This option is available in server versions only.

https://inedit.freshdesk.com/en/support/solutions/articles/14000148965
https://inedit.freshdesk.com/en/support/solutions/articles/14000139742-custom-fields-and-custom-dialogs-management
https://inedit.freshdesk.com/en/support/solutions/articles/14000139890-design-and-colorway-informations
https://inedit.freshdesk.com/en/support/solutions/articles/14000139891-delete-designs-and-colorways
https://inedit.freshdesk.com/en/support/solutions/articles/14000139932-design-attachments
https://inedit.freshdesk.com/en/support/solutions/articles/14000130803-how-to-import-designs-with-folder
https://inedit.freshdesk.com/en/support/solutions/articles/14000139388


Related articles:

Delete Designs and Colorways

Using nC Dropbox for File Import

nC Dropbox is a powerful file-sharing application that allows you to easily manage and transfer files between
different devices and locations. Unlike the Multiple file import function , nC Dropbox doesn't need administrative
configurations and permits all users to upload files using their API key tokens.

In this guide, we will walk you through configuring a neoCatalog URL and a specific folder to import files from one
place to another using nC Dropbox.

TABLE OF CONTENTS

Installation
Installing .app on macOS
Installing .exe on Windows
Connect with neoCatalog

Creating an Import Task
Advanced Settings
Uploading Files
Monitoring Upload Progress
Completing the Import

Accessing Imported Files

Installation
Installing .app on macOS

https://inedit.freshdesk.com/en/support/solutions/articles/14000139891-delete-designs-and-colorways
https://inedit.freshdesk.com/en/support/solutions/articles/14000130803


1. Get it from the internet, email, or a USB drive.
2. If it was in a .dmg file, right-click it and choose "Eject."
3. Double-click the .app file. It may take a moment to open.
4. Simply drag the application to the "Applications" folder in the Finder. It'll copy the app, which may take a bit.
5. Find nC DropBox.app and open it from the "Applications" folder or the Launchpad.
6. Start the app and create a new task.

Installing .exe on Windows

1. Get it from the internet, email, or a USB drive.

2. Double-click the .exe to start the installation.

3. It'll take a few minutes, and progress is shown on screen.

4. Open it from the Start Menu or the desktop if a shortcut is created.

5. Start the app and create a new task.

Connect with neoCatalog

1. Go to your neoCatalog application.
2. Click on "Link App" in the menu of settings.
3. Select "Link with nC Dropbox" and copy the QR code.
4. Paste the link the nC Dropbox required field

Watch Video: https://player.vimeo.com/video/921034062?share=copy

Creating an Import Task
1. Create a folder on your device. Give your folder a name, e.g., "Import Files."
2. Click on "Add new task"
3. Locate and select the folder to access it. You can do this by clicking on the button 'Select Folder' within the

application.

Watch Video: https://player.vimeo.com/video/919123983?share=copy

Advanced Settings

Folder Filtering Settings:

Whitelist Folders: Specify folders that are permitted for processing. (Folders that are allowed)
Blacklist Folders: Specify folders that should be excluded from processing. (Folders that are not allowed)
File Extensions to Include: List the file extensions you want to include in the processing.

https://player.vimeo.com/video/921034062?share=copy
https://player.vimeo.com/video/919123983?share=copy


Other Settings:

Folder Depth: Set the depth to determine how many subfolders will be considered during processing.
Max Items to Process: Define the maximum number of items (files) to process. 0 for no limit.
Max Files Resolution:  Set the maximum file resolution to determine the conversion of files with a DPI (dots per
inch) resolution. Files with a DPI resolution greater than this value will be automatically converted to match the
specified DPI.
Upon Completion (OK): Specify actions to be taken when processing is successful.
Upon Upload Failures: Define actions in the event of an upload failure.
Upon File Refusal: Determine actions to be taken when a file is rejected or refused.



Uploading Files

Once the import task is created, you will have it present in the application. Click on Start to upload files to the URL
destination.

Monitoring Upload Progress

1. nC Dropbox will start importing the file from the folder to the URL
2. You can monitor the upload progress through a progress bar and indicator.
3. Wait for the upload to complete. The time it takes depends on the file size and your internet connection.



Completing the Import

Once the upload is finished, you will see a notification that the process has been successfully completed.

Accessing Imported Files
Log in to your neoCatalog, and you'll discover your imported files on the main design page. From here, you can
begin working with these new files, creating fresh colorways, adding them to galleries, sharing with others, and
initiating print jobs.



Related articles:

How to import designs with a folder

What kind of importation option is the optimal

https://inedit.freshdesk.com/en/support/solutions/articles/14000130803


method for importing designs?

Choosing the most appropriate importation method, consider the following options based on your workflow and
volume of files.

1. Multiple File Import:

This feature, available in the administration section, enables you to organize and import multiple files simultaneously
from folders. This method is ideal for handling over 100 files per day. Learn More

https://inedit.freshdesk.com/en/support/solutions/articles/14000130803-how-to-import-designs-with-a-folder#Multiple-file-import


2. nC DropBox

A user-friendly tool that allows easy file importation for all user types. This method is suitable for handling up to 100
files per day. Learn More

https://inedit.freshdesk.com/en/support/solutions/articles/14000146939-using-nc-dropbox-for-file-import


3. From UI

The simple and quick option to import a single file by utilizing the "Create" button. Learn More

https://inedit.freshdesk.com/en/support/solutions/articles/14000139889-import-designs-in-neocatalog




4. nC neoCatalog Panel for Photoshop

For Photoshop users utilizing neoTextil, this tool allows seamless file importation directly from Photoshop, with a
capacity of handling up to 10 files per day. Learn More

4. Managing Information

Design and Colorway Information

Design and Colorway information are data-based. You can assign keywords to design, fabric to colorways, or make
both exclusive. However,  with custom fields and custom dialogs, you can create new fields and apply rules for
visibility and permissions. If your neoCatalog is connected to your company's database, most fields will be filled with
your database information. If content changes are required, they should be done from your external database.

Design and colorway edition can be modified only by an Administrator of the program or users that have the proper
privileges to edit information. Only unverified designs and colorways can be edited.  Contact your Administrator.

https://inedit.freshdesk.com/en/support/solutions/articles/14000141438-how-to-work-with-nc-neocatalog-panel-connected-to-neocatalog-web


INFO: The neoCatalog desktop app version has limitations in fields. If you work with the 
neoCatalog Server version, you will be able to work with custom fields and custom dialogs and 
customize the server dialogs.
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Edit Design Info
The Design edition options can be accessed through the Edit Design Info option from the button from the menu bar
that appears on all pages.

Design section

The first section of the dialog information relates to the design creation and ownership classification in neoCatalog.

Default fields:

Design Type : Indication if the design is digital(photographic) or conventional(multichannel).
Creation and Modification Date : The creation date is the date of design importation. The modification date
is the date when the design image file was updated.
Code : Code is used when the design moves to production.
Request ID (optional): Shown when the design is created from Request.
Name : The name is used as temporary identification until the design moves to production.
Alias : An Alias is using the original file name.
Designer : It embeds the user who does the design importation. Otherwise, it remains empty.
Stamper : Stamper is the reference of the printing producer. Otherwise, it remains empty.
Stamper design reference : The design reference can be specified for the printing producer. Otherwise, it
remains empty.
Coordinated designs : A reference to another design in neoCatalog.
Customer : Customer can be selected as long the customer exists in neoCatalog. Otherwise, it remains
empty.
Exclusivity and Expiration Date : Can be enabled and the date of exclusivity expiration selected. Otherwise,
it remains empty. When a design is marked as Exclusive, it is clearly visible in the showrooms.
Price : Can be introduced. Otherwise, it remains empty.
Status : Status unfolds a list. Otherwise, it remains unknown. The designations given in Status will be shown in
the design, in the browser of the main design.

https://inedit.freshdesk.com/a/solutions/articles/14000139742?lang=en


Technical Information Section

The second section of the dialog information relates to the design image technical data, which the program obtains
from its files.

Default fields:

File : The image file name and extension.
Low-resolution file : The program indicates the image file name of the generated LQ file.
Size : The image file size in centimeters and width-height proportion.
Resolution : The image file resolution is in dpi.
Number of channels : The number of channels for multichannel and photographic image files.
Rapport and Rapport rotation : The embedded image file rapport and direction.

Search Information Section

The last section of the dialog information relates to the design categorizations. Refer to the preferences to learn how
to create categorizations.

Default fields:



Verified : This action is reversible, but bear in mind that when it is activated, the other fields in the dialog
become inactive and some users depending on privileges won't see it. The verification of a design is done by
clicking under the label, and a tick with the current date will appear.
Finishing Method : Unfolds a list of production finishing methods that can be changed in preferences by an
administrator.
Color Library : The option unfolds a list of all visible color libraries that are in neoCatalog.
Keywords : Select or add new keywords to categorize the design.
Tags : Select or add a new tag to categorize the design.
Collections : Select or add new collections to categorize the design.
Trademark/Subtrademark : Editable field, although only trademark will be taken as a search filter.
Comments : Can be added. The default comment is ' Created using DropBox' .

Edit Colorway Info
When a Colorway is opened or selected, the option Edit Colorway Info from the button at the menu bar of the
window becomes selectable.

Colorway Creation Section

The first section of the dialog information relates to the colorway creation and ownership classification in
neoCatalog.

Default fields:

Creation Date : The creation date is the date of colorway creation or importation.
Type : Indication if the colorway is digital(photographic) or conventional(multichannel).
Name : The name is used as temporary identification until the colorway moves to production.
Code : Code is used when the colorway moves to production.
Provider Code : This code is the design code of the supplied design.
Request ID (optional) : Shown when colorway is used in request order.
Colorist : It embeds the user who does the colorway creation. Otherwise, it remains empty when imported by
DropBox.
Customer : Customer can be selected as long the customer exists in neoCatalog. Otherwise, it remains
empty.
Exclusivity and Expiration Date : Can be enabled and the date of exclusivity expiration selected. Otherwise,
it remains empty. When a colorway is marked as Exclusive, it is clearly visible in the showrooms.
Modification date (optional) .



Search Information Section

The last section of the dialog information relates to the design categorizations. Refer to the preferences to learn how
to create categorizations.

Default fields:

Verified : This action is reversible, but bear in mind that when it is activated, the other fields in the dialog
become inactive and some users depending on privileges won't see it. The verification of a colorway is done
by clicking under the label, and a tick with the current date will appear.
Collections : Select or add new collections to categorize the design.
Fabric : Unfolds a list of fabric types that can be introduced and changed by an administration's preferences.
Finishing Method : Unfolds a list of production finishing methods that can be changed in preferences by an
administrator.
Color Library : The option unfolds a list of visible color libraries that are in neoCatalog.
Coordinates : Identifies the kept colorway reference.
Color Profile : Unfolds a list of ICC profiles that are added in the neoCatalog Preferences. By default the ICC
is @sRGB.
Overprint Method : Colorway simulation that provides production simulations perform an ink calculation for
production when mixing colors in different cases. It can be Methods, Production, ProductionPigment,
ProductionDarken, or Photoshop.

Related articles:

Custom Fields and Custom Dialogs Management

Setup of categorization options

https://inedit.freshdesk.com/en/support/solutions/articles/14000139742-custom-fields-and-custom-dialogs-management
https://inedit.freshdesk.com/en/support/solutions/articles/14000139303-setup-of-categorization-options


Design and Colorway Verification

The verification option is an additional control over the design and colorway information. You can enable the
verification to block data edition in the Edit Info and Edit Colorway dialogs or align it to the user privileges for users
to be present or not.

The Design Verification option 'Verify Design' / 'Verify Colorway' can be accessed from the button from the 'Edit'

menu bar that appears on all pages. 

Another option is when accessing the Edit Info and Edit Colorway dialogs by clicking on the link next to the title
'Verified'.

Once the design is verified, it shows a green check icon in the design thumbnail, and the fields of design/colorway

information are locked. 

Removing the design verification can be done by clicking on the link next to the title 'Verified'.

Related articles:

Design and Colorway Information

User Privileges Management

https://inedit.freshdesk.com/en/support/solutions/articles/14000139890-design-and-colorway-informations
https://inedit.freshdesk.com/en/support/solutions/articles/14000139300-user-privileges-management
https://inedit.freshdesk.com/en/support/solutions/articles/14000139890-design-and-colorway-informations
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https://inedit.freshdesk.com/en/support/solutions/articles/14000139300-user-privileges-management


Engraves option for channel coverage calculation

Engraves in neoCatalog is a feature in the server version that is calculating the covered area of each channel or
separation of the design and shows the coverage for each channel too. This information can be used in other CAD
systems so that the ink consumption for digital printing can be analyzed.

When selecting a multichannel design, from the footer bar Edit button shows the option 'Engraves...'. You will access
the Engraves dialog with its information for Automatic Engrave, channel names, and the coverage calculation for
each channel.  Coverage is the percentage of non-white pixels (a full channel with 1% gray and a full black channel
have 100% coverage). Mesh can be added optionally.

With 'Edit' you can unlock the dialog and edit information such as codes, status, and the engraving types which by
default are Digital, Cylinder, and Screen. Press on the '+' button to add a new engraving to the design. If you wish to
print the embedded engraves and technical information, click on 'Print' to export a PDF document.



Related articles:

Design and Colorway Information

Exclusivity in neoCatalog with controlled access

The Exclusivity in neoCatalog allows users or administrators to restrict access to certain items—such as designs,
colorways, and galleries—so that only specific users, teams, or customers can view, edit, or use them. It makes sure
that important or private content is only accessible to the right people, controlling who can use it in the app.

TABLE OF CONTENTS

Why Use the Exclusivity Feature?

https://inedit.freshdesk.com/en/support/solutions/articles/14000139890-design-and-colorway-informations


Design and Colorway Exclusivity
1. Design Exclusivity
2. Colorway Exclusivity
How to set a Design or Colorway as exclusive
Managing expiration dates for exclusive Designs

Partial Exclusivity

Why Use the Exclusivity Feature?
1. Controlled Accessimporting : The exclusivity feature lets you define who can access specific content and the
duration of exclusivity. This can be applied at various levels—entire designs, individual colorways, or specific
galleries. For example, a design might be exclusive to Customer A, meaning only they can see or use it.

2. Full or Partial Exclusivity :

Full exclusivity applies to the entire item, meaning the whole design or colorway is restricted.
Partial exclusivity allows you to restrict items only to certain zones while others remain accessible.

3. Flexible Permissions : Administrators or users with the necessary permissions can assign or revoke exclusivity.
This flexibility makes sure that sensitive or proprietary content is protected when necessary and shared when
needed.

4. Visual Indicators : Labels and colors are marking exclusive content. This helps users quickly identify which items
are restricted and whether they have access to them.

Design and Colorway Exclusivity

https://inedit.freshdesk.com/en/support/solutions/articles/14000129696
https://inedit.freshdesk.com/en/support/solutions/articles/14000139727


1. Design Exclusivity

Exclusivity is applied to an entire design. This means that the design is locked or restricted, and only certain users or
customers can view or edit it.

Impact on Users :
Authorized users (those with access rights) can view, edit, export, or manage the design.
Unauthorized users cannot access the design at all—it is hidden or marked as exclusive, meaning it is
not available in their workspace.

Impact on Customers :
Customer-specific exclusivity can be applied, meaning that only a particular customer can use that
design. For example, if a design is made exclusive for Customer A, Customer B will not be able to view,
request, or purchase designs that are reserved for specific clients, preventing competitors or other
clients from accessing exclusive material.

2. Colorway Exclusivity

Exclusivity applied only to a specific colorway (color variation) of a design, allowing for different access controls on
different versions of the same design.

Impact on Users :
Authorized users can work with all colorways or specific ones depending on the permissions granted.
Unauthorized users might only have access to certain colorways or none at all, depending on how the
exclusivity is configured.

Impact on Customers :
A customer can have exclusive access to one or more colorways of a design. For instance, Customer A
may get exclusivity over a blue variation of the design, while Customer B can only access the red version.
If a customer doesn't have access to a particular colorway, that version will be hidden or unavailable in
their view.

How to set a Design or Colorway as exclusive

1. Open neoCatalog and navigate to the design you want to modify.
2. Click Edit > Edit Design Info or Edit Colorway
3. In the Customer field, add the desired customer.
4. Check the Exclusive option.
5. Set an Expiration Date for exclusivity.
6. Click Save.
7. Once saved, the design will display a red exclusivity label next to the customer’s name.

To remove exclusivity:

1. Open Edit Design Info for the selected design.
2. Uncheck the Exclusive option.
3. Click Save.
4. After saving, the Expiration Date field will be disabled, and the exclusivity label will no longer appear, making

the design accessible to all users.

neoCatalog checks for expiring exclusivity and automatically updates their status as their expiration date passes.

Managing expiration dates for exclusive Designs



neoCatalog features an automated reminder that can send daily notifications about designs nearing expiration and
those that have already expired. Users may choose to receive these notifications based on their preferences.

Administrators can adjust exclusivity settings through advanced preferences , including:

Exclusivity Duration – Defines how long a design remains exclusive.
Expiration Reminders – Sets how many days before expiration an alert is sent.
Notification Recipients – Specifies email addresses for exclusivity alerts.
Task Scheduling – Determines how often neoCatalog checks exclusivity statuses.

Partial Exclusivity
Partial Exclusivity is a feature that allows users to restrict or lock access to specific zones or regions within a
design, rather than restricting access to the entire design. With this feature, you can assign specific users or groups
to have exclusive access to certain areas, while keeping other parts of the design open to general use.

1. Users can configure exclusivity at the zone or region level in Categorization Administration , providing control over
who can use specific parts of a design. This allows for partial control of design assets while keeping flexibility over
other areas.

2. The Partial Exclusivity feature works alongside traditional customer exclusivity, enabling both options to coexist
without conflict. To use it follow the steps below.

1. Make sure the "Exclusives List" field is added in the edit and search custom dialogs.
2. Go to the existing designs and click on the +Add button.
3. Enter the information independently in each field and click S a v e .

3. Search for the partial exclusive design via Advanced Search and the fields Exclusive Customer, Zone and/or
Type:

https://inedit.freshdesk.com/en/support/solutions/articles/14000155803
https://inedit.freshdesk.com/en/support/solutions/articles/14000139303


4. The visual indicators are labels and colors whose zones are restricted and provide clear visual feedback. These
labels can either be opaque or transparent, clearly showing the zones under exclusivity restrictions.

Related articles:

User Privileges Management

How to change the offset in the designs preview

If you wish to see a specific part of the design in the colorway preview and thumbnails, here you can use the feature
to customize the offset in the preview. Thumbnail previews will be regenerated using the new offset of the origin.

When opening a colorway you can move it graphically, changing, therefore, the offset.

https://inedit.freshdesk.com/en/support/solutions/articles/14000139300


Such change can be saved from the '...' button and the unfolded option 'Save current offset' below the preview.

You can go anytime back to the original offset or go back to the custom offset with the icons below the preview.

Related articles:

Design and Colorway viewing options

Soft proofing colorways in neoCatalog

Soft proofing is an option that allows you to simulate on your computer monitor what your print will look like when it is
printed on media using a specific ICC profile. When a printer profile is made the color of the paper or fabric media is
one factor that is shaped in the profile, because of the ink and the media combination. Using the 'Soft proofing'
simulation option you can select your custom profile the view the simulation.  Before doing it, make sure your ICC
profile is installed in neoCatalog.

Once you are in the Detail View of one colorway, from the lower options choose 'Soft Proofing', which allows to set
up the proofing and enables the proofing for every single Colorway.

https://inedit.freshdesk.com/en/support/solutions/articles/14000139929-design-and-colorway-viewing-options


Selecting 'Proof Setup' opens a dialog where you can choose one of your installed ICC profiles and select the
supported rendering intents Absolute colorimetric, Relative colorimetric, Saturation, or perceptual with their display
options.

Once the setup is done, select 'Proof Colors' from 'Soft Proofing' to enable the simulation and the proofing will be
applied.





5. Designs and Colorways

How to create new colorways colors

neoCatalog offers different options for color colorways: color libraries and a color picker.

Watch Video: https://player.vimeo.com/video/749518213

Create new colorway
If you wish to make one new colorway, go to the button '+' at the menu bar and select option ' New Colorway from. ..'.
This option is available from designs, colorways, and detail view. The program creates a duplicate of the selected
colorway as a temporary colorway with the name 'T01' and opens the color library to color a new colorway. Now you
can make color changes using the color library or the color picker.

Coloring with Color Library

Select the color library you want to use to color the new colorway. You can customize the view of the library with the
adjustment button next to the library name, where you choose the size of the patches and view the color name, or not.
Those adjustments are based on the logged-in user and will remain for the user only on the coloring colorway and
simulations page.

When the color library is selected you can search for a color by two options:

- Searching by Name: you can enter the name or part of it and it will give you the possible results.

https://player.vimeo.com/video/749518213
https://inedit.freshdesk.com/en/support/solutions/articles/14000139695-new-colorways-in-neocatalog


- Searching by Color: the square black button below the library's name allows you to pick the color you are searching
for. Once you have selected a color from the color picker, click on the color space sphere, and the closest reference
in your library will be shown.

When the color is selected, you can drag&drop it into the color channels. While moving over the channel color, it
shows the border of the channel frame, so that the color can be dropped and applied. Else, if your library color is
selected in the library, with the paint can icon you can apply it in the channel.

The other way to color the channel is to type color libraries' color names in the channel to search and apply color. You
can move from one to the next channel with the tab keyboard.

Coloring with Color Picker

Another coloring option is with the color picker that is based on the web browser you have started your neoCatalog
session. Click on the color circles in the color channel and it opens the color picker. In the color space, you can then



pick the color or enter the RGB, HSB or hex values. 

Superposition methods

The list which unfolds next to the paint can button shows color superposition methods for coloring: Disabled, Add,
Multiply, Pigment, and Corrosion. By default, we select "Multiply" which is set up in advanced preferences.

Save & Publish a new colorway
You can anytime 'Undo' the modification on this page using the corresponding button. But if you decide to keep the
newly created colorway, then you have two options.

'Save' will create the new colorway as a Temporary colorway with a 'T' colorway name that is visible only to the
creator and allows further color modifications accessing from the 'Edit...' menu.
'Publish' will create the final colorway and the result would be the following generated using the next colorway
code in neoCatalog. No further color modifications are possible.

Related articles:

New digital colorway from import

New Colorways in neoCatalog

New Random Colorways creation

https://inedit.freshdesk.com/en/support/solutions/articles/14000140078-new-digital-colorway-from-import
https://inedit.freshdesk.com/en/support/solutions/articles/14000139695-new-colorways-in-neocatalog
https://inedit.freshdesk.com/en/support/solutions/articles/14000140135-new-random-colorways-creation/


How to update digital colorway in neoCatalog

Once one digital colorway with a separator in the file name is created, by default it is restricted to be updated when
importing the same file for the second time. This colorway cannot be published if already exists with the same name.
You must change the file name and publish it again.

But, if you want to skip the restriction, contact your neoCatalog administrator to enable modifications of colorways in
the advanced preferences . This will display the 'Send file' button in the 'Edit Colorway' dialog to upload and replace
the colorway file.

Watch Video: https://player.vimeo.com/video/816852926

Related articles:

Enable Modifications of Colorways (advanced)

New digital colorway from import

How to use colorways groups

When having lots of colorways, there are different ways to organize and search colorways and one of them is the
grouping of colorways. You can select one of the default groups 1-9 for every colorway.

Select one colorway and from the Edit menu > Group you can select/deselect the group.

https://inedit.freshdesk.com/en/support/solutions/articles/14000140134
https://player.vimeo.com/video/816852926
https://inedit.freshdesk.com/en/support/solutions/articles/14000140134
https://inedit.freshdesk.com/en/support/solutions/articles/14000140078


This will apply the group number and color to the colorway.

Working with neoTextil and colorways groups, the colorway will be synchronized between neoCatalog and nT
Colorations.

Watch Video: https://player.vimeo.com/video/902305415

https://player.vimeo.com/video/902305415


Related articles:

Grouping of Colorways in nT Coloration

New Colorways in neoCatalog
neoCatalog offers different options to make colorations: automatic, manual, or by importing data files. When opening
a colorway, we access the colorway view window where we can modify or add such colorways.

Coloring new colorway
If you wish to create new colors for a new colorway, you can do it with the button '+' at the menu bar and select the
option 'New Colorway from...' . This option is available from designs, colorways, and detail view. The program
creates a duplicate of the selected colorway as a temporary colorway with the name 'T01' and opens the color library
to color a new colorway. Now you can make color changes using the color library or the color picker.

https://inedit.freshdesk.com/en/support/solutions/articles/14000148797
https://inedit.freshdesk.com/en/support/solutions/articles/14000140077-how-to-create-new-colorways-colors


Duplicate colorway
You can duplicate any selected colorway with the option same option for new colorways 'New Colorway from...' . from
the '+' button. Once in modification mode and publishing without change, it will generate a new colorway using the
next colorway code and the information that the colorway is duplicated.

https://inedit.freshdesk.com/en/support/solutions/articles/14000140077-how-to-create-new-colorways-colors


Colorway from XCM
From Inèdit's programs neoColorations and neoColorBox, you can export colorations from text files containing color
information, which are saved with the extension XCM. Such files can be imported to neoCatalog from the button with
the 'Import Colorway from XCM File' option and use their information to create new colorways. Follow the simple
steps that are shown on the screen to upload the file. The colors will be applied automatically to the selected design.



Related articles:

How to create new colorways colors

New digital colorway from import

New Random Colorways creation

New Random Colorways creation

neoCatalog offers a very useful tool to generate multiple new colorways with different color combinations, using your
color libraries, and very fast. Those colorways can be created with multichannel and hybrid designs. For digital
designs, one advanced preference must be enabled, contact your administrator.

Unlimited random colorways
1. Select one colorway in the colorways view or open the colorway details view.

2. From the menu bar, choose the option 'Random colorways' option from the '+' button.

3. New colorway combinations will be displayed using the color library. If you want to get different color combinations,
you could generate more with the corresponding button: 

https://inedit.freshdesk.com/en/support/solutions/articles/14000140077-how-to-create-new-colorways-colors
https://inedit.freshdesk.com/en/support/solutions/articles/14000140078-new-digital-colorway-from-import
https://inedit.freshdesk.com/en/support/solutions/articles/14000140135-new-random-colorways-creation
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If you are coloring digital designs (RGB), you will see HSL slides, to adjust the color for the new color variations.



4. Another option to generate random colorways more accurately, is by blocking some channels and generating
further colorways that would have the selected colors. Clicking on the channel you want, the padlock of the channels
that you choose will show locked.



5. Double-clicking on any colorway will be selected and pinned.



6. If you wish to publish a pinned colorway, or discard it, use the buttons on the top left corner of the design.

Interchange colors in channels
Users can mix up the placement of colors within channels, offering greater creative freedom and flexibility in their
designs. The checkbox next to the generation enables the use of interchange channel colors from selected colorways
for new combinations.

Watch Video: https://player.vimeo.com/video/912206174

Related articles:

How to create new colorways colors

https://player.vimeo.com/video/912206174
https://inedit.freshdesk.com/en/support/solutions/articles/14000140077-how-to-create-new-colorways-colors


New digital colorway from import

This option supports image files to import as digital colorways (photographic). The colorways can be created from
the import options when opening the design in neoCatalog, or the use of a colorway separator in the file name to be
indicated automatically as a colorway.

For example, if the digital design has the name "D1234" and the colorway "variant1", create the file name as
"D1234#variant1.tif". The separator hash '#' is used by default. If you wish to change the separator, it can be done in
the advanced preferences (neo_colorway_separator, neo_keep_publishing_name (YES)) by an administrator of
neoCatalog. 

This colorway cannot be updated if already exists with the same name. If you want to skip the 
restriction, contact your neoCatalog administrator to allow the update of digital colorways.

Open one design and select the option 'Import Digital Colorway' from the '+' button. It opens the upload dialog to
choose and upload the new file, as seen in the design importation. Drag&drop a file here or click. Continue with
'Import'.

https://inedit.freshdesk.com/en/support/solutions/articles/14000140134
https://inedit.freshdesk.com/en/support/solutions/articles/14000142261


Once uploaded, it opens the Colorway Info window automatically to enter or modify customer and comment for
colorway information. Continue with 'Save'. 

Colorway information:

File name: The file name or counter for the next design number. Cannot be modified.
Design name: Showing the name of the design where the colorway will be added.
Customer: Type to search or create colorway's customer.
Comments: Optional



If you work with the neoCatalog Server version, you will be able to work with custom fields & 
dialogs and customize the server dialogs with custom fields.

The result would be newly generated colorways using the next colorway name in neoCatalog.

https://inedit.freshdesk.com/en/support/solutions/articles/14000139742-custom-fields-and-custom-dialogs-management


Related articles:

How to create new colorways colors

Custom Fields and Custom Dialogs Management

How to update digital colorway in neoCatalog

Enable Modifications of Colorways (advanced)

Pin item option for temporarily storing colorways

If you find yourself frequently using certain colorways for printing or sending, you can save time by pinning them for
easy access. By pinning a colorway, you can ensure that it appears at the top of your list, making it quick and
convenient to select for your projects.

To pin a colorway, simply select the desired colorway and click on the "Pin item" option located at the bottom of the
screen. Once pinned, the colorway will be prominently displayed at the top-right of your list. In the thumbnails you can
find a pin icon included, making it easy to identify.

If you no longer need a colorway to be pinned, you can easily unpin it by locating the list of pinned items. From there,

https://inedit.freshdesk.com/en/support/solutions/articles/14000140077-how-to-create-new-colorways-colors
https://inedit.freshdesk.com/en/support/solutions/articles/14000139742-custom-fields-and-custom-dialogs-management
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you can remove colorways individually by clicking on the x icon next to each colorway, or you can choose the "Clear
pinned" option to unpin all colorways at once.

r

Working with hybrid designs in neoCatalog

Hybrid coloring is coloring photographic image files with Alpha channel(s) in the format PSD, PSB, or TIFF. In order
to work with the RGB+Alpha designs in neoCatalog and get the best result, it is important to respect the file
construction.

The RGB image has to be in a working ICC profile. The common masked part in the photographic design is
the background. To do this use Photoshop tools, to select your desired area on the design, and where you
want to color later.
Coloring the alpha channel in Photoshop you will create the embedded color.
In RGB channels the area needs to be removed or blank to avoid color addition in the colorway.

The photographic design file is ready to import as Digital Design into neoCatalog. Go to neoCatalog DropBox, and
drop the design in the folder Photos.

After the importation, your design is visible in neoCatalog in a standard way, with an embedded Alpha channel. The
Alpha channel is channel no. 1, as RGB is counted internally, but not visible. The internal neoCatalog background
channel is hidden by default.





6. Simulations in neoCatalog

Associate Simulation Object with Colorways

Users have the capability to associate a Simulation object to a specific colorway by selecting the simulation name
from the Colorway information. This allows them to utilize simulations that are tailored for the ultimate end product.

This becomes possible once the field 'Ambient' is added to the custom dialogs. To make this happen, we'll walk you
through adding a field to your custom dialogs.

Step-by-Step

1. Navigate to the relevant custom dialogs to modify the edit colorway dialog.

2. Include the 'Simulation' field from the unused sections, position the field within the dialog, and then click 'Save'
to implement the changes.

3. Access your colorway and open the Colorway Information from the footer menu under Edit.

4. In the new field, choose the simulation object .

5. After adding it, click 'Save' to close the dialog, applying the simulation to the colorway instantly.

Watch Video: https://player.vimeo.com/video/908673375

Related articles:

Design and Colorway viewing options

Export Simulations

From the Simulations page, you have several options to export or add one simulation.

Print Simulation

https://inedit.freshdesk.com/en/support/solutions/articles/14000139742
https://inedit.freshdesk.com/en/support/solutions/articles/14000139890
https://inedit.freshdesk.com/en/support/solutions/articles/14000139683
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The option is located at the footer bar and is available when a colorway is applied to the object. The option 'Print...' is
an option that allows you to create printouts dynamically using layouts.

https://inedit.freshdesk.com/en/support/solutions/articles/14000139302-how-to-generate-and-send-print-files-from-the-print-option


If you use a simulation combination of different colorways, then the simulation using combination will be used in the
print and create a single page for every colorway.



NOTE : Print exporting is not supported for color simulations.

Download JPG
From the download button on the footer menu, you can download the simulation JPG as you see it on the screen. The
result will be a JPG image file with the simulation only with a resolution of 72 dpi.





Add to Gallery
From the export button on the footer menu bar, you can add the simulation to the gallery.



The result will be the simulation using the colorway and the colorway itself.

Related articles:

How to generate and send print files from the Print option

Galleries and Samples

How to make simulations on one model object

https://inedit.freshdesk.com/en/support/solutions/articles/14000139302-how-to-generate-and-send-print-files-from-the-print-option
https://inedit.freshdesk.com/en/support/solutions/folders/14000129000


You access the Simulations by clicking on the button situated at the top tab bar. On the left you can see all the objects
without simulations you have available or organized in categories , once created in administration , and on the right,
you have the designs, colorways, or colors of the color libraries.

TABLE OF CONTENTS

Simulation Page
Object parts
Design offset
Scale design texture

Apply Colorways and Colors in Simulations
Colorways Simulation
Colors Simulation

Simulation Page
When you enter the page with one design selected before in the designs or colorways view, then the simulation is
automatically created and is presented in the center of the page. From the lower bar, you can zoom in/out or show
the real size of the selected simulation model.

https://inedit.freshdesk.com/en/support/solutions/articles/14000139697-working-with-simulations-group-categories
https://inedit.freshdesk.com/en/support/solutions/articles/14000139683-simulations-objects-management


Object parts

The simulations objects contain parts and are shown in the Simulations Settings list. Objects may have as many
eligible parts as you wish, depending on the job previously created with nT VirtualVision. Each part can be
deactivated so that no design is applied, showing the original photo image.



Design offset

The offset of the design on the model can be adjusted with the mouse when moving over the simulation object image.
It detects the part and highlights it so that with the mouse and drag&drop the offset can be set. Resetting the offset
can be done from the option next to the rotation options. The direction of the design can be rotated with the arrows

next to the angle degree. 

Scale design texture

You can apply the texture in different scale versions by using the scale slider tool. This is one advanced option and
can be enabled by the administrator only in the advanced preferences. Watch Video:
https://player.vimeo.com/video/818678794

https://inedit.freshdesk.com/en/support/solutions/articles/14000142329
https://player.vimeo.com/video/818678794


Apply Colorways and Colors in Simulations
From the search field on the right of the window, you can search for design and colorway names, or choose between

colorways or colors simulations. 

Colorways Simulation

If you wish to make simulations using colorways, select the option Colorways. It will show all colorways which you can
search for when using the search fields. Any colorway selected will be applied to the model/object.

Colors Simulation

The option Colors opens your Color Libraries. Any color selected will be applied to the model/object, and it will be
shown in a square patch on the right. As in other windows of this program, the search field is there for you to find a
particular color by color or by name.

You can customize the view with the adjustment button next to the library name. Choose the size of the patches and
view the color name or not. These adjustments are based on the logged-in user and will remain for the user only on
the coloring colorway and simulations page.

https://inedit.freshdesk.com/en/support/solutions/articles/14000139695-new-colorways-in-neocatalog


Related articles:

Simulations Objects Management

Working with Simulations Group Categories

Scaling of designs on simulation objects (advanced)

How to update simulation object file

In case the object file requires changes in size, profile, or added/removed texture and groups, then the object needs
to be updated in neoCatalog Simulations management.

Step-by-Step
1. To access the ' Simulations ' table, go to the 'Management' in administration and find the listed options in

'Materials'. 

2. Select the object name in the list. 

3. Click on the 'Upload object' button to select the new file. 

4. Follow the simple window that will come up until the object is ready to upload. 

5. Once the upload is done you will see all the embedded simulation groups.

Watch Video: https://player.vimeo.com/video/816851911

Related articles:

Simulations Objects Management

Make simulations of flooring paneling
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As already introduced Simulations, the Paneling Options is an advanced option and exclusive for the flooring decor
printing industry. It stimulates the flooring panels in Simulations. To use this option, the admin needs to enable the
module first and create the panel options .

Watch Video: https://player.vimeo.com/video/775758930

Once the paneling options are created, being in the design's detail view or going to the Simulations page, a new
button appears showing the simulation without the paneling option.

Clicking on the button you will be able to choose the paneling options in the displayed list. Once selected, the
paneling simulation is applied to the object.

https://inedit.freshdesk.com/en/support/solutions/articles/14000139356-application-modules
https://inedit.freshdesk.com/en/support/solutions/articles/14000139699-paneling-simulations-management
https://player.vimeo.com/video/775758930


When exporting the simulation in the print document using layouts or downloading a JPG image file, the simulation is
used in the exported files. 

With layout: Download JPG: 

https://inedit.freshdesk.com/en/support/solutions/articles/14000139700-export-simulations


Related articles:

Paneling Simulations Management

Paneling Simulations Management

To use this option, you need to enable the module first. Once enabled, the option is available in 'Management' listed
in 'Utilities'.

In the first window, it shows a list of the already created panels, if any. By selecting them you can edit or delete them,
and you can add new ones by clicking on the '+' button.

When clicking on the '+' button, a window opens where you can edit the information for the new panel option.

Description: The name of the option
Crop Horizontal & Vertical: The size of one panel
Randomize: It simulates the panels randomly in the full simulation object
Rapport & Direction: Drop info for one panel

Once all information is added, click on Save. Now got to the simulation page and you are ready to apply the option
for the selected simulations object.

https://inedit.freshdesk.com/en/support/solutions/articles/14000139699-paneling-simulations-management
https://inedit.freshdesk.com/en/support/solutions/articles/14000139356-application-modules
https://inedit.freshdesk.com/en/support/solutions/articles/14000139698-make-simulations-of-flooring-paneling




Related articles:

How to simulate flooring paneling

Simulations Objects Management

Simulations Objects Management

Management of Simulation objects is also an exclusive task of the Administrator/s in neoCatalog. With Inedit's
Photoshop Plug-in nT Virtual Vision , you can modify the simulation objects with grids and shadows to get the 2D
effect, or you have them provided by Inedit, ready to upload in neoCatalog.

To access the 'Simulations' table, go to the 'Management' in administration and find the listed options in 'Materials'.
In the first window, it shows a list of the already uploaded models, if any. By selecting them you can edit or delete
them, and you can add new ones by clicking on the button. The button 'Update All', which also shows in each object,
is used if the files have been changed at the origin and uploaded in neoCatalog again.

When clicking on the plus '+' button, a window opens where you can upload and edit the information in the new
object. By default, it will take the file name.

Step-by-Step

https://inedit.freshdesk.com/en/support/solutions/articles/14000139698-make-simulations-of-flooring-paneling
https://inedit.freshdesk.com/en/support/solutions/articles/14000139683-simulations-objects-management
https://inedit.freshdesk.com/en/support/solutions/folders/14000128659


1. Using ' Categories ' you can create group simulations that will allow you to organize the objects by type that are
available in the Simulation Page and Share Samples . 

2. With 'Customer' you can assign a customer and exclusivity for that object. 

3. The button 'Upload Object' allows you to search for the PSD or TIFF object file and working RGB profile ,
that has been modified from neoTextil VirtualVision, in your computer. 

4. Follow the simple window that will come up until the object is ready to upload. 

5. Once the upload is done you will see all the embedded simulation groups. 

6. Press Save after uploading the file. 

7. If the object file changes, then it needs to be uploaded and updated from the same object selection . 

For quick object importation, you can also use neoCatalogs DropBox. Simply drop the simulation 
PSD file in /neoCatalogs/<My_Catalog>/DropBox and the simulation will be created 
automatically.

Watch Video: https://player.vimeo.com/video/816860268

Related articles:

How to make simulations on one model object

How to update the simulation object file

How to generate and send print files from the Print option

Working with Simulations Group Categories

One way to work with simulations is to create group categories. With categories, you can group the simulation into
types, and later you can apply the design to selected categories only.

From Simulations Management in Administration in the selected object create a category name or add it to the
object. When going back to the simulations page the group's categories will be listed. Simply select the groups and
you will see the assigned simulation objects.

Watch Video: https://player.vimeo.com/video/775740658

https://inedit.freshdesk.com/en/support/solutions/articles/14000139696-how-to-make-simulations-on-one-model-object
https://inedit.freshdesk.com/en/support/solutions/articles/14000139696-how-to-make-simulations-on-one-model-object
https://inedit.freshdesk.com/en/support/solutions/articles/14000139301-share-samples-and-items
https://inedit.freshdesk.com/en/support/solutions/articles/14000142259
https://player.vimeo.com/video/816860268
https://inedit.freshdesk.com/en/support/solutions/articles/14000139696-how-to-make-simulations-on-one-model-object
https://inedit.freshdesk.com/en/support/solutions/articles/14000142259
https://inedit.freshdesk.com/en/support/solutions/articles/14000139302-how-to-generate-and-send-print-files-from-print-option
https://inedit.freshdesk.com/en/support/solutions/articles/14000139683-simulations-objects-management
https://player.vimeo.com/video/775740658


Related articles:

Simulations Objects Management

How to make simulations on one model object

8. Download and Exportation

Configuration of Print Server's in Management

This feature is optional and made for needs to generate and send print jobs directly Print Server from the Print dialog
. To add Print Server(s) you need to enable the module first. Afterward, the option is available in 'Management' listed
in 'Utilities'.

Add Print Server

With the 'Add Print Server' button, you can add manually new Print Servers using the IP and port when are active. The
field for the token is used to place the security token generated in Print Server to authenticate the Print Server in
neoCatalog. If you want to have the print start automatically active, enable the option Print straight .

https://inedit.freshdesk.com/a/solutions/articles/14000139683/edit?lang=en
https://inedit.freshdesk.com/en/support/solutions/articles/14000139683-simulations-objects-management
https://inedit.freshdesk.com/en/support/solutions/articles/14000139696-how-to-make-simulations-on-one-model-object
https://inedit.freshdesk.com/en/support/solutions/articles/14000139302-how-to-generate-and-send-print-files-from-the-print-option
https://inedit.freshdesk.com/en/support/solutions/articles/14000139356-application-modules
https://inedit.freshdesk.com/en/support/solutions/folders/14000127397


Explore Print Server

Using Bonjour protocol we will discover the print server automatically when clicking on 'Explore'. It will show the
possible printers and with + you can add them in the list of your Print Server connections. Once added you can see
the Print Server in the list below the search field. With 'Delete' you can remove the added Print Server.



Exclusivity

This option is made to choose one user or group that normally has no permissions to print Servers and download
design, but downloading. JPG/PDF. Simply search for the user or group name and click on 'Save'. Later in the Print
dialog when the user is logged in then the option Send to neoStampa will be available from the Destination list.

Related articles:

How to generate and send print files from the Print option

Print Server

Default neoCatalog layouts description

Default layouts are created to meet a different case in image file organization for the print in sampling or production.
If not already installed them in your neoCatalog, you can download them here from the attachments in this article.

TABLE OF CONTENTS

https://inedit.freshdesk.com/en/support/solutions/articles/14000139302-how-to-generate-and-send-print-files-from-the-print-option
https://inedit.freshdesk.com/en/support/solutions/folders/14000127397


Inedit_RealSize
Inedit_FullRapport
Inedit_RealSizeWithRepeatPreview
Inedit_VirtualVision
Inedit_PrintRapport
Inedit_RapportWithColors

Inedit_RealSize
Usage: Sampling on paper

Page Size: A3 vertical (layout size)

Embedded:

100% dimension
Design and Colorway name
Request Code
User email and ID
Date
Share Sample QR: Link to the sample page
Print info QR: design and colorway name
Logo
Channel color patches
Channel order
Color name in color library

Assign:

1 Customer
1 Simulation

Inedit_FullRapport
Usage: Sampling on paper



Page Size: Layoutsize A3 vertical

Embedded:

Full rapport dimension
Design and Colorway name
Request Code
User ID, Name, and email
Date
Share Sample QR: Link to the sample page
Print info QR: design and colorway name
Logo
Channel color patches
Channel order
Color name in color library
Warning text for not real dimension

Assign:

1 Customer
1 Simulation

Inedit_RealSizeWithRepeatPreview
Usage: Sampling on paper

Page Size: Layoutsize A3 vertical

Embedded:

100% dimension
Preview with 160 cm design with repetition
Design and Colorway name
Request Code
User ID, Name, and email
Date
Share Sample QR: Link to the sample page



Printinfo QR: design and colorway name
Logo
Channel color patches
Channel order
Color name in color library

Assign:

1 Customer
1 Simulation

Inedit_VirtualVision
Usage: Sampling on paper

Page Size: Layoutsize A3 vertical

Embedded:

Design simulation on one model
Design and Colorway name
Request Code
User ID, Name, and email
Date
Share Sample QR: Link to the sample page
Print info QR: design and colorway name
Logo
Channel color patches
Channel order
Color name in color library

Assign:

1 Customer
1 Simulation (required)



Inedit_PrintRapport
Usage: Production in neoStampa / Print Server

Page Size: Single full rapport design image with repeat information.



Inedit_RapportWithColors
Usage: Production

Page Size: Single full rapport design image, single header, and footer 160 cm width print

Embedded:

100% dimension
Design and Colorway name
Request Code
Date
Print info QR: design and colorway name
Logo
Channel color patches in 5 gradients (100, 75, 50, 25, 5)
Channel order
Color name in color library

Assign:

1 Customer



Related articles:

How to generate and send print files from the Print option

Installing QuickPrint layouts

Attachments:

LayoutsDefaultNC_15092023.zip 
Inedit_RealSize_2Elements.xml 

Download File and XCM

https://inedit.freshdesk.com/en/support/solutions/articles/14000139302-how-to-generate-and-send-print-files-from-the-print-option
https://inedit.freshdesk.com/en/support/solutions/articles/14000139681-installing-quickprint-layouts
https://inedit.freshdesk.com/helpdesk/attachments/14128776430
https://inedit.freshdesk.com/helpdesk/attachments/14156780935


Download Design
This is the simplest downloading mode, available from the designs and colorways view from the 'Export' button in
neoCatalog which will download the design HQ file with no special features in your computer.

Separated design: It will download the multichannel file.
Digital Design: If you have digital colorways, then the selected colorway file will be downloaded.

Cloud Download
Cloud download will download the design files via Amazon Cloud. Every user has the option to enable or disable
cloud download under the user icon. Once enabled and when downloading the design file, then it will be sent and
stored on the cloud and kept there for 7 days.

Download XCM
To download one .xcm file of a colorway coloration (which is the color information using text code) on your computer,
you must be in the colorway view and select the 'Export' button.

Related articles:

How to generate and send print files from the Print option

User Privileges Management

Share Galleries

How to avoid neoCatalog blocking when exporting

https://inedit.freshdesk.com/en/support/solutions/articles/14000139302-how-to-generate-and-send-print-files-from-the-print-option
https://inedit.freshdesk.com/en/support/solutions/articles/14000139300-user-privileges-management
https://inedit.freshdesk.com/en/support/solutions/articles/14000139692-share-galleries


Gallery's PDF

Exporting PDFs directly using the "Download PDF" option in neoCatalog can cause the application to become
unresponsive, resulting to the Proxy error. Please follow the steps below to avoid blocking the application:

1. Unblock neoCatalog

If neoCatalog becomes blocked, restart the application or the server to restore functionality.

2. Use the Email Option Instead

Once neoCatalog is restarted and the user logs in:

1. Go to the Gallery .

2. Click on “Print” .

3. Click on “Send per email” .

( Watch this demo video ) 

3. Retrieve the PDF via Email

The user will receive an email with a Download button.

If the email is not received, check the Spam or Junk folder.

https://jam.dev/c/1d9608f2-eda0-47d5-8595-51aa950bc9cd


How to generate and send print files from the Print
option

The option 'Print' is one export option that allows you to create printouts more visually and dynamically. All supported
exportation formats are joined in one place that can be downloaded or sent by email.

Watch Video: https://player.vimeo.com/video/823000017?share=copy

The option is located at the footer bar.  Choose what to print directly from the Print menu: Selected design, Pinned
items or  selected designs' colorways.

The Printing History feature provides a centralized overview of all print jobs generated in neoCatalog across all
navigation areas on the top menu. Once the file generation process is complete, the corresponding download or
send action is automatically initiated. All generated print files are stored in the Printing History section, where they
remain accessible for future reference. Users can review and re-download previously generated files at any time.

https://player.vimeo.com/video/823000017?share=copy
https://inedit.freshdesk.com/en/support/solutions/articles/14000156894
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Items
Destination

Download options
Send to neoStampa
Send by email as PDF
Save to Server

Presets
Layout
Paper Size

Default Size
Custom Size
Layout Size

Simulation
Random Virtuals

Customer
Comments
Page Document Preview and items
Printing Watermarks

Items
You can add colorways directly in the Print dialog, with convenient options to Add All Colorways of a design or
Remove All Items , all without leaving the dialog.

Destination
Download options

The following option is provided as destinations:

JPEG: Generates files according to your page setup in JPG format to be downloaded to your computer.



PSD: Generates files according to your page setup in PSD format to be downloaded to your computer.
TIF: Generates files according to your page setup in TIF format to be downloaded to your computer.
XJB: Generates files according to your page setup in XJB format to be downloaded to your computer.
PDF: Generates files according to your page setup in PDF format to be downloaded to your computer. 

Enbale in-app or email notification to be informed when the download is compeleted.

neoCatalog provides advacned preferences to ask for required data and confirmation before 
generating the print file. Contact your administrator.

Send to neoStampa

Sending print job according to your page setup to the printing queue of Print Server. With 'Send to neoStampa' and
working with neoStampa's Print Server you can have the printing queues using the IP address with port or Bonjour
protocol configured in Administration . The printing queue can be opened and viewed from the same dialog and you
will view Control Center . To send the print document, click on the option in the footer menu.

https://inedit.freshdesk.com/en/support/solutions/articles/14000139388
https://inedit.freshdesk.com/en/support/solutions/articles/14000143192-print-option-with-mandatory-data-advanced-
https://inedit.freshdesk.com/en/support/solutions/folders/14000127397
https://inedit.freshdesk.com/en/support/solutions/articles/14000139679-configuration-of-print-server-s-in-management
https://inedit.freshdesk.com/en/support/solutions/articles/14000138905-getting-started-with-control-center


INFO: To be a neoCatalog user with no export privileges but still have possibilities to print 
in Print Servers need to get exclusivity on the Print Server configuration in Administration.

Send by email as PDF

This option, located in the footer menu, allows you to send an email containing a download link for PDF documents.
Before sending, please select the desired PDF quality. The PDF will be generated in the background.

https://inedit.freshdesk.com/en/support/solutions/articles/14000139679




Save to Server

With this option, you can save the document to a subfolder of the QuickPrint folder.  To do this, the administrator is
required to create a contact with the category 'Printer' in user administration and requires giving an alias name in the
corresponding field. Once the printer name as an alias name is created, the destination option ' Save to Server ' will
appear to select the printer name. When saving the file to the destination, then a subfolder with the alias name inside
the QuickPrint folder will be created having the saved file stored.

Presets
This feature is optional and made for the need to export a series of neoCatalog layouts with specified page
configuration and is valid for any user with export permissions. Using presets to generate new and also files that are
already in the database neoCatalog. Another option to create presets is from Administration . To create a preset,
make your layout selection and page configuration and click on 'Save as new' and a new dialog opens where you
can name and describe the new preset.

The option 'Public' allows sharing your preset with another user. If this option is not activated, the preset is visible to
the creator only. Finally, click on 'Save' to create the preset. Modifications on preset page settings can be done in the
print dialog anytime, too. To save the modification, click on ' Save' from the Presets below. Deleting presets can be
done from Administration only. To work with Presets, select the preset when the dialog is open and select one from
the list. The preview will be updated according to the preset configuration.

Layout
From the drop-down menu, you can select the installed neoCatalog Layouts that will be used to create the page
document. To install your layouts refer to Administration . By default, we provide sample layouts .

https://inedit.freshdesk.com/en/support/solutions/articles/14000139304-users-and-groups-management
https://inedit.freshdesk.com/en/support/solutions/articles/14000139680-quickprint-presets-management
https://inedit.freshdesk.com/en/support/solutions/articles/14000139681-installing-quickprint-layouts
https://inedit.freshdesk.com/en/support/solutions/articles/14000139682-default-neocatalog-layouts-description


Paper Size
Default Size

formats that are given in standard sizes:

PDF: Layout Size, Letter, A4, and A3.
JPEG, PSD, TIF, XJB: Layout Size, Custom, Letter, A4, A3, A2, A1, and A0.

Custom Size

Custom size allows defining the page size in different units (px, pt, mm, cm, m, rep, and yards). Custom sizes are last
remembered for user sessions. If with Rapport layouts (the possibility to add printing meters in print job XJB), then
here you have to define the final printing meters that will work with combination in destinations of XJB or sending to
Print Server queue.

Layout Size

Layout Size will use the programmed page size that is written for the layouts.

If working with Rapport layouts (the possibility to add printing meters in print job XJB), then here it will use the full
rapport image size that will work with combination in destinations of XJB or sending to Print Server queue.



Simulation
From the button, you can select, change, or unselect the installed neoCatalog Virtual simulations that will be applied
in the page document. To install simulations refer to Administration .

https://inedit.freshdesk.com/en/support/solutions/articles/14000139683-simulations-objects-management


Random Virtuals

The checkbox Random Virtuals the Print option, allows users to assign random simulation objects for each print
page when printing the design. (requires advanced preference)

Customer
From the search field, you can select the available customer existing in neoCatalog. If your layout supports the

https://inedit.freshdesk.com/en/support/solutions/articles/14000153511


customer field, the customer name will be applied to the page document.

You can make the customer selection mandatory in advanced settings for print file generation.

To create new customers refer to the user and contact management in administration .

TIP: When adding asterix * before the search item, it will search the part of the name and 
find the possible results.

Comments
The field is a text field to enter your comments for the page document.

https://inedit.freshdesk.com/en/support/solutions/articles/14000143192
https://inedit.freshdesk.com/en/support/solutions/folders/14000128644


Working in XJB format and sending the print to Print Server queue, additionally to the comment in the document also
it is placed in the printing queue.



Page Document Preview and items
The preview will show in live update the customization on your page document. Multiple pages are shown and a
scale option provides an accurate view of the page. The list of the items is on the left with the possibility to remove
the items from the same view.





Printing Watermarks
When using watermarks in your designs, according to the user privileges, the watermarks will be applied to the print
document automatically or can be enabled/disabled for the print document with the option 'Watermark' below the
layout selection.

https://inedit.freshdesk.com/en/support/solutions/articles/14000139684-setup-of-watermarks-in-previews-and-files


Related articles:

Watermarks

Default Layouts

User Notifications - How to receive notifications for activities

QuickPrint presets

Configuration of Print Servers in Management

QuickPrint Errors - Layouts

How to increase max quality in print jobs (advanced)

Print option with mandatory custom selection (advanced)

Integrating trademark logos in print documents

neoCatalog 3.16.16 comes with a feature allowing users to integrate trademark and sub-trademark logos into their

https://inedit.freshdesk.com/en/support/solutions/articles/14000139684-setup-of-watermarks-in-previews-and-files
https://inedit.freshdesk.com/en/support/solutions/articles/14000139682-default-neocatalog-layouts-description
https://inedit.freshdesk.com/en/support/solutions/articles/14000139388
https://inedit.freshdesk.com/en/support/solutions/articles/14000139680-quickprint-presets-management
https://inedit.freshdesk.com/en/support/solutions/articles/14000139679
https://inedit.freshdesk.com/en/support/solutions/articles/14000143034
https://inedit.freshdesk.com/en/support/solutions/articles/14000140640-how-to-increase-max-quality-in-print-jobs-advanced-
https://inedit.freshdesk.com/en/support/solutions/articles/14000143192
https://inedit.freshdesk.com/en/support/solutions/articles/14000139303


designs based on simple rules. This feature offers customization options, ensuring that users can incorporate their
brand identity into their print design.

When a design includes a trademark or sub-trademark, neoCatalog automatically assigns the corresponding logo to
the print document. Users can define a default trademark logo to be utilized when specific trademark or sub-
trademark assignments are absent from a design. To utilize the advanced feature, contact your administrator to
enable the advanced preference "neo_defaultTrademarkName" and "neo_defaultSubTrademarkName".

Example Scenario:

In the given scenario, when examining three designs side by side, Design 1 on the left features the trademark
"INEDIT," Design 2 in the center utilizes the sub-trademark "neoCatalog" without a primary trademark, and Design 3
on the right incorporates both "INEDIT" and "neoCatalog"  Consequently, we ensure the appropriate logo is applied
to each design in accordance with their respective trademark and sub-trademark associations.

https://inedit.freshdesk.com/en/support/solutions/articles/14000139681


Step-by-Step
1. Prepare Your Trademark Logos:

Ensure trademark logos are saved in TIF format, named according to the trademark or sub-trademark (e.g.
trademark "INEDIT" is represented as INEDIT.tif). Maintain high-quality standards for optimal printing results.

2. Upload Trademark Logos:

Upload your trademark logos to the neoCatalog Layouts. You can either directly upload the TIF files from
Management > Layouts or copy them to the designated folder on your system in .\neoCatalog\QuickPrint\Layouts.

3. Prepare Your Layouts:

The layout requires a source for the trademark or sub-trademark, featuring a conditional setup to utilize the
trademark logo when a value is present. In cases where there is no value, the layout defaults to displaying the
standard logo. An example attached is provided for reference.

4. Assign Trademarks to Designs:

1. Select the design requiring trademark assignments.
2. Navigate to Edit > Edit Design Info .
3. Choose the trademarks and sub-trademarks from the available options.
4. Save your changes to apply trademark assignments.

5. Print Layout Selection:

1. Access the Print option when ready to print.
2. Choose the layout with trademark conditions for printing.
3. Automatically trademark logos are assigned into the selected print layout based on design trademark value.

Attachments:

Layouts_Trademark and Sub-Trademarks Logos.zip 
Sample-51_-_Main_Colorway(More).pdf 

QuickPrint Layouts Installation and Management

neoCatalog Layouts are created in XML and TJB format using design and colorway information, adding or not
simulation models, using your logo or a generated QR code. neoCatalog provides default Layouts with the most
common information for designs and colorways. Refer to the layout description to view the specifications.

NOTE: Since version 3.16.18, when accessing the Layouts management feature, it is necessary to 
reload layouts from disk (the button) in order to have them listed for modification.

https://inedit.freshdesk.com/en/support/solutions/articles/14000139890
https://inedit.freshdesk.com/helpdesk/attachments/14136307041
https://inedit.freshdesk.com/helpdesk/attachments/14136307043
https://inedit.freshdesk.com/en/support/solutions/articles/14000139682-default-neocatalog-layouts-description
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Install Layouts
Customize neoCatalog Default Layouts
Layouts based on roles and visibility

Install Layouts
In 'Layouts' you can upload and download your custom layouts as XML, TJB, and other required files such as logos
and fonts. To access the layouts table, go to 'Management' in administration and find the listed options in 'Materials'.
Here you can upload layout files in XML and TJB format and other required files as logos and fonts.

The layouts will be saved in /Library/WebServer/Documents/neoCatalog/QuickPrint/Layouts , in macOS and
Windows. If any layouts are renamed (e.g., from "Layout A" to "New Layout A" or vice versa), these changes are

reflected across the system. 

NOTE: Layouts in subfolders cannot be uploaded directly from the administration panel and must 
be manually copied to the Layouts directory within the neoCatalog folder. After copying, you 
need to reload the layouts from disk by using the appropriate button.

Customize neoCatalog Default Layouts
If you wish to use your logo in the default layouts, you can replace it easily by yourself.

1. Your logo image file shouldn't be higher than 236px x 36px.
2. Use RGB mode.

Save your logo in format TIFF with the name Logo. tif and place it in the Layouts folder. Your TIFF file will replace



Inedit's logo and will be used in the layouts. 

Layouts based on roles and visibility
When a user has access to multiple layouts, including public (visible) layouts and exclusive ones designated for
specific roles (such as designer or customer), the following behavior applies:

Layout Visibility: One layout is always visible in the general view, ensuring that it is accessible to all users.
Role-Based Access: When connecting as a designer or a customer:

Designers will only see layouts that are public and exclusive to the designer's role.
Customers will only see layouts that are public and exclusive to the customer role.
Any layouts not designated as public or exclusive to their respective roles will be hidden from view.

Watch Video: https://player.vimeo.com/video/927173667?share=copy 

Related articles:

How to generate and send print files from the Print option

Default neoCatalog layouts description

QuickPrint Errors - Layouts

QuickPrint Presets Management

QuickPrint presets is the feature to have export settings to make it faster to export print files for use. To access the
QuickPrint presets, go to 'Management' in administration and find the listed option in 'Utilities'. Verify that the
preference in Preferences > Modules is enabled to work with presets.

To send to printing document, click on the option in the footer menu. 

INFO : neoCatalog Server version provides QuickPrint Scenarios with specified hot folders that use with
QuickPrint presets to generate new files and also files that are already in the database neoCatalog.

After you enter, on the left you see the existing presets, if any. With the button '+' you can create a newly preset. A
new dialog opens where you can name and describe the new preset, or use a random preset name, and shows the
creator and date of creation. The option Public allows sharing your preset with another user. If this option is not
activated, the preset is visible to the creator only. Finally, click on Save to create the preset.

To delete a QuickPrint preset, select one preset and click on Delete below. Modifications on the preset can be done
in the Print dialog.

https://player.vimeo.com/video/927173667?share=copy
https://inedit.freshdesk.com/en/support/solutions/articles/14000139302-how-to-generate-and-send-print-files-from-the-print-option
https://inedit.freshdesk.com/en/support/solutions/articles/14000139682-default-neocatalog-layouts-description
https://inedit.freshdesk.com/en/support/solutions/articles/14000143034
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Related articles:
How to generate and send print files from the Print option

https://inedit.freshdesk.com/en/support/solutions/articles/14000139302-how-to-generate-and-send-print-files-from-the-print-option


QuickPrint Scenarios Management

In the neoCatalog Server, Scenarios are sets of QuickPrint presets that can be linked to a Hot folder where the files
are dropped and processed according to the specific output configured in the presets.

To access the QuickPrint scenarios, go to 'Management' in administration and find the listed option in 'Utilities'.
Verify that the preference in Preferences > Modules is enabled to work with presets.

After you enter, on the left you see the existing scenarios, if any. With the '+' button you can create new scenarios. A
new dialog opens split into two parts: S c e n a r i o a n d Hot Folder .

Scenario setup
In Scenario, you can name the new scenario or use a random name, and add the presets for the scenario when you
click on the 'Choose to add' tab. Select the presets from the list and click on the 'Add' button to have them in the
scenario. With the 'X' button you can remove the preset from the scenario. Also, it shows the creator and date of
creation. Finally, click on 'Save' to create the scenario.

https://inedit.freshdesk.com/en/support/solutions/articles/14000139680-quickprint-presets-management


Hot folder setup
The Hot folder part manages paths and permissions of the scenario Hotfolder:

Default Hot folder and Output folder paths.
You can enable and disable the hot folder with the check for 'Enabled'.
The check for 'Delete files after' allows deleting of the original files that have been proceeded in the Hot folder.
The 'Output overwrite' check will overwrite generated layout files. 

NOTE : When you want to change the name of the scenario hot folder, then you are required to change also the
name in Hotfolder Path.

After the creation of Scenarios, you are required to create the folder Hot folders and the Scenarios folders manually.
In case of the default path, go to the root: 
/Library/WebServer/Documents/neoCatalog/QuickPrint/



Back in Scenarios management, when the hot folder path is recognized, then the icon next to the path fields changes
from red to green.

On the System Info page , next to other Background Task information at the bottom, you can check the Hot folder
Task port, interval, status, and next execution.

Related articles:

QuickPrint Presets Management

System Info of neoCatalog

neoCatalog layouts using custom fields variables

Working with custom fields and custom dialogs to enter extra data in the design and colorway information, and also
to have this data in the layouts is possible.

Custom fields format supported for variables
Use formats without space like "AsesorComercial" or "Asesor-Comercial".
When using space, use a dash "-" but do not use underline or else.
Uppercase and lowercase letters.

https://inedit.freshdesk.com/en/support/solutions/articles/14000139740-system-info-of-neocatalog
https://inedit.freshdesk.com/en/support/solutions/articles/14000139680-quickprint-presets-management
https://inedit.freshdesk.com/en/support/solutions/articles/14000139740-system-info-of-neocatalog
https://inedit.freshdesk.com/en/support/solutions/articles/14000139742-custom-fields-and-custom-dialogs-management


Variables in layout
Custom field name Variable in layout
Asesor-Comercial ${Asesor-comercial@0}
AnchoEspecial ${Anchoespecial@0}
Tintas-Neón ${Tintas-Neón@0}
Lineas-de-corte ${Lineas-de-corte@0}

<!-- Ancho especial --> <!--requires custom field and dialog--> 
      <Conditional condition="${Anchoespecial@0}" equals="" negate="N">
          <Object Id="25" Left="3.35 cm" Top="23.1 cm" MaintainAspectRatio="true">
            <Transformations>
              <Text alignment="left" fontid="2" fontsize="7" maxwidth="4.5 cm" value="X"
              backgroundRGBAColor="0,0,0,256" textRGBAColor="0,0,0"  />
            </Transformations>
          </Object>
        </Conditional>
      <Conditional condition="${Anchoespecial@0}" equals="" negate="Y">
          <Object Id="24" Left="5.0 cm" Top="23.1 cm" MaintainAspectRatio="true" >
            <Transformations>
              <Text alignment="left" fontid="2" fontsize="7" maxwidth="4.5 cm" value="X"
              backgroundRGBAColor="0,0,0,256" textRGBAColor="0,0,0"  />
            </Transformations>
          </Object>
        </Conditional>

Conditions
The most important change is to add the variables in the Job Settings, else when there is no value for any variable,
then we show the variable name.

<JobSettings>
            <Variables>
                <Set id="0">
                    <Variable name = "Asesor-Comercial" value = ""/>
                    <Variable name = "Designer" value = ""/>
                    <Variable name = "CustomerDescription" value = ""/>
                    <Variable name = "Localizado" value = ""/>
                    <Variable name = "Lineas-de-corte" value = ""/>
                    <Variable name = "Ancho-Especial" value = ""/>
                    <Variable name = "Ancho-Especial-Descripcion" value = ""/>
                    <Variable name = "Tintas-Neon" value = ""/>
                    <Variable name = "Dupla" value = ""/>
                    <Variable name = "Dupla-Descripcion" value = ""/>
                </Set>
            </Variables>
    </JobSettings>

See the attached layout as an example for the layouts.



Related articles:

Custom Fields and Custom Dialog management

Attachments:

Layouts.zip 

9. Requests Orders

Exportation Options for Requests

Share Samples from the request order
Download request item files
Export Excel of state

Share Samples from the request order
When opening one order, export options are at the bottom of the page. You can Share Samples , which are also
available in other parts of the application.

With ' Share Samples ' you can share the order on a sample page with design information and simulations with
people without access to neoCatalog. It will share a public link that can be accessed without a login.

https://inedit.freshdesk.com/en/support/solutions/articles/14000139742-custom-fields-and-custom-dialogs-management
https://inedit.freshdesk.com/helpdesk/attachments/14097312983
https://inedit.freshdesk.com/en/support/solutions/articles/14000139301-share-samples-and-items
https://inedit.freshdesk.com/en/support/solutions/articles/14000139301


Download request item files
This option under 'Export' menu downloads request items in one folder with the request code. Inside will be the
design file and a subfolder with XCM for every design type.



Export Excel of state
In the request, kanban selects the state column, and then within the three dots options, you can choose to export the

Excel file (xlsx). 

Excel header format:

requestCodename creationDateneoDesign neoColorwayquantitysizecommentsneoFabric

1246
QuickPrint
Design1_-
_Colorway1

14/12/2021 IMG_1111 test Embedded 1 Color ecru

1246
QuickPrint
Design2_-
_Colorway1

14/12/2021 81495-6X Embedded 1 Cotton

1246
QuickPrint
Design3_-
_Colorway1

14/12/2021 8986 Original 1

1247
PDF
Design3_-
_Colorway1

14/12/2021 BirdsWatercolor_1-
4_V_embedded Embedded 1

Related articles:

How to create Requests Orders

How to create print job for request order

How to automate print file generation in Request
Orders

https://inedit.freshdesk.com/en/support/solutions/articles/14000140214-how-to-create-requests-orders
https://inedit.freshdesk.com/en/support/solutions/articles/14000145234


The state action in the request workflow provides the option "Print with preset" to take automatically when a request
has reached one state. This action is available only if there are Print presets based on the destinations "Send to
neoStampa" and "Save to Server".

Step-by-Step

1. Go to Administration Management > Workflows. 

2. Select the workflow and the state that triggers the action and select "Print with preset" as Action.

3. Save the changes on the state and select the print preset with Print Server connection.

4. When moving jobs to the state that has the print action, then the print file generation starts automatically, indicating
the pending items to be executed on the state header.

https://inedit.freshdesk.com/en/support/solutions/articles/14000139879
https://inedit.freshdesk.com/en/support/solutions/articles/14000139302


Related articles:

How to create Requests Orders

User Notifications - How to receive notifications for activities

How to create Requests Orders

Using the neoCatalog login name and password you can access and view the requests in every web browser from
the Requests tab. This page is optional and an Administrator of your neoCatalog must activate it.

Watch Video: https://player.vimeo.com/video/749524619

TABLE OF CONTENTS

Request Orders Page
Event History Log
Request Codes for Output

Who can create and view Orders
Create Requests

Add Items
Attachments
Split orders
Duplicate Order to Another Workflow

Request Orders Page
The Requests page has the default workflow selected when opening the Requests tab, which shows you the request
order cards in different state columns. You can switch between workflows if exist. At the bottom of every column, you
can see the number of requests and scroll up/down and left/right. Using the request code you can search for orders in
the search fields. Also, you can sort using the given sorting types (same as for design sorting) and show/hide the
archived requests.

https://inedit.freshdesk.com/en/support/solutions/articles/14000140214-how-to-create-requests-orders
https://inedit.freshdesk.com/en/support/solutions/articles/14000139388
https://player.vimeo.com/video/749524619
https://inedit.freshdesk.com/en/support/solutions/articles/14000139879-request-order-management
https://inedit.freshdesk.com/en/support/solutions/articles/14000141776
https://inedit.freshdesk.com/en/support/solutions/articles/14000139879-request-order-management




The request card in the column shows the following information:

Priority (low, medium, high)
Request Name
Request ID - Request Type
Date of creation
Due date
Customer
Item fabric type
Associated Duplicate
See/Hide the preview and name of the request item
Comments



When clicking on the request ID, then you will open the request form. Here you can view requested data and items,
also share and export options.

The customer name can be hidden and only the customer ID will be used for users with no user privilege to
view Sales information.
Share and export options are based on user privileges to Share and Export.

Event History Log

From option View > Event history you can view the full life cycle of one order being in processing states with data
of date, user, and action.

https://inedit.freshdesk.com/en/support/solutions/articles/14000139300-user-privileges-management
https://inedit.freshdesk.com/en/support/solutions/articles/14000139300-user-privileges-management


Request Codes for Output

neoCatalog uses the Requests feature to track the output files, exported from the Print option or that were sent by
mail. The outputs will be referred to request codes automatically created with the request order titles  "QuickPrint
DesignName - ColorwayName" and " PDF DesignName - ColorwayName".

Who can create and view Orders
When it comes to managing request orders, users and customers are key players that shape how people interact
with the system. As people use the platform to track and handle requests, it's crucial to understand the differences
between users and customers. In the context of request orders, the terms "user" and "customer" typically refer to
different roles or categories of individuals interacting with a system. Below, we explain what users and customers
can do, highlighting their specific actions and roles in the context of managing request orders.

A "user" is a generic term that can refer to anyone with access to the system, including both customers and
internal staff (like designers, administrators, or support personnel). Users, depending on their roles and
permissions, may have various capabilities related to request orders. Common user actions might include:

Viewing Requests : Users can typically view a list of requests, see their status, and access details for
each request.
Editing Requests : Users may have the ability to edit certain aspects of a request, such as updating

https://inedit.freshdesk.com/en/support/solutions/articles/14000139302-how-to-generate-and-send-print-files-from-the-print-option


information, changing statuses, or adding comments.
Adding or Editing Items : Users might be able to add new items to a request or modify existing items,
specifying details like design, colorway, quantity, etc.
Workflow Navigation : Users could navigate through different workflow stages or tabs to manage
requests in various states (e.g., "To Do," "In Progress," "Completed").

In the context of request orders, a "customer" typically refers to an external entity or individual who has placed a
request for a product or service. Customers often have more limited access and permissions compared to
internal users. Customer actions might include:

Placing Requests : Customers can initiate new requests, specifying details such as the type of order,
quantity, design preferences, etc.
Viewing Their Requests : Customers can typically see the status and details of their own requests.
Limited Editing : Depending on the system, customers may be able to edit certain aspects of their own
requests, such as adding comments or updating specific fields.
Monitoring Progress : Customers might be able to track the progress of their requests through different
workflow stages.

It's important to note that the specific actions available to users and customers can vary depending on the design
and configuration of the system. Access levels, permissions, and feature availability are typically managed through
permissions settings in the application to ensure security and appropriate data control.

Create Requests
With the ' Export ' button, you can create Requests from neoCatalog Designs and Colorways View. Select your
design or designs with multiple selections and select the Request Type. Remember to have Workflows and Request
Types in Administration created before starting.

You will access the Request Order form. On the top bar, you will see the state where the order is placed. Request
type, creator, request code, and date are embedded automatically. You can enter and/or edit:

Request data: name, customer, type, creator, state, priority, comments
Request items: remove/add/download design and colorway, select fabric and finishing methods add quantity
or size, comments
Next to every item you have the option to download the design file or delete the item in the order.

After any modification, press Save.

https://inedit.freshdesk.com/en/support/solutions/articles/14000139879-request-order-management


Otherwise, you can create one empty order from the Request Page with the button '+ Request' and then select the
request type. This will open the request order window where you can add data and items.

Add Items

Continue with the items section. Now you can add more items or modify the already selected ones. You are able to
have more items in the same order. Press on Add Item to add the required contents for more sample orders.

Click on the fields and you can add the design code/name. It will take the default colorway automatically.
Enter the quantity/size of the order and select, if it exists, the fabric type and finishing method.
In the comments, you can add optional notes that may be useful for your request.

After any modification, press Save.



Attachments

From the 'Attachments' option via the 'View' button at the bottom menu, you can add optional files and documents
that are useful for your request. Click on 'Add Attachment...'. Select your file and upload it. Once uploaded, from the
same menu you can add more, download, or delete attachments.

Split orders

Having created request orders with multiple items, you can split the order into two individual orders. Simply select the
items you want to split into one new order and click on the button "Split". This will create a second order with new
requests code, but using the same title noted with "split".

Watch Video: https://player.vimeo.com/video/812377108

Duplicate Order to Another Workflow

You can duplicate an existing order from one workflow to another while maintaining the link to the original order.

https://player.vimeo.com/video/812377108


The association between the original and duplicated orders will be reflected in the card information and items list
(including attachments).

Related articles:

Request Order Management

How to manage Request Orders

Exportation Options for Requests

Shopping Cart

User Privileges Management

How to generate and send print files from the Print option

How to automate print file generation in Request Orders

Show the number of request sizes in the State column (advanced)

https://inedit.freshdesk.com/a/solutions/articles/14000139879?lang=en
https://inedit.freshdesk.com/en/support/solutions/articles/14000141776-how-to-manage-request-orders
https://inedit.freshdesk.com/en/support/solutions/articles/14000140220-exportation-options-for-requests
https://inedit.freshdesk.com/en/support/solutions/articles/14000140219-how-to-use-shopping-cart
https://inedit.freshdesk.com/en/support/solutions/articles/14000139300-user-privileges-management
https://inedit.freshdesk.com/en/support/solutions/articles/14000139302-how-to-generate-and-send-print-files-from-the-print-option
https://inedit.freshdesk.com/en/support/solutions/articles/14000136107-how-to-automated-print-file-generation-in-request-orders
https://inedit.freshdesk.com/en/support/solutions/articles/14000145239


How to create print job for request order

When opening one order, down at the footer menu you will find the ' Print ' option, which is also available in other
parts of the application.

It allows users to configure and initiate print jobs and provides various settings and options to customize the printing
process according to the user's preferences. You can generate PDFs, send emails, generate printing jobs of the
order or send directly print jobs to the Print Server

https://inedit.freshdesk.com/en/support/solutions/articles/14000139302


The request codes are applied in the layouts, as in default neoCatalog layouts.

Related articles:

Exportation Options for Requests

How to enable Request Orders and Shopping cart
features

These features are optional and an Administrator of your neoCatalog must activate it:

Requests
Enable Requests from application modules options .

https://inedit.freshdesk.com/en/support/solutions/articles/14000140220
https://inedit.freshdesk.com/en/support/solutions/articles/14000139356-application-modules


Shopping cart
This feature works in combination with Requests. Once the request option is enabled, you need to enable the
Shopping cart from administration preferences.

Related articles:

Request Orders Management

Application Modules

Shopping Cart items exclusivity (advanced)

How to manage Request Orders

For created request orders there is no need to publish them, as they will be used from the first beginning of the order
creation to the final request code. After the order is present, it will appear on the request page.

Loading request orders in batches of 100, with the ability to expand the next 100 using the 'Show More' button, when
dealing with thousands of request orders.

Once the order is created it will be placed in the default state defined in the Workflow. From this state, you can edit or
move the order in different ways. If you wish to delete the order, open the request by ID name or click on the Edit sub-
option via '...' and use the button located at the bottom of the opened order page.

There is no possibility for multiple selections.

TABLE OF CONTENTS

View orders
Tracking orders
Sorting orders
Next State
Order options
Change the state of all orders

https://inedit.freshdesk.com/en/support/solutions/articles/14000139879-request-order-management
https://inedit.freshdesk.com/en/support/solutions/articles/14000139356-application-modules
https://inedit.freshdesk.com/en/support/solutions/articles/14000129843-shopping-cart-items-exclusivity-advanced-


Notifications
Archived orders
Hide State

View orders

Orders can be accessed from the request order page, which offers two distinct viewing modes:

Cards View : A visual layout that displays orders as individual cards, providing a more graphical overview.

List View : A detailed, table-like format that lists all orders for easier tracking and management.

Tracking orders

When a design is selected, you can track orders directly from the Export menu based on different references:

Show My Requests : Users can view all their requests in a single location, listed by last selected request and
sort type, by accessing the Export menu and selecting Request Type.

Show Item Requests : Displays all requests made for the selected design, listed by last selected request and



sort type, when accessing the Export menu and selecting Request Type.

Click the (eye) View button next to the order in the list to open the order details. In this view, you can review the order
details and send messages by chat. Using the View menu at the bottom, you can add attachments, specify a
delivery address, or view the order’s activity history.

Sorting orders

The sorting feature in Requests allows you to efficiently organize your requests, making it easier to prioritize and
manage your workload. By default, the sort type is 'Sorted by Code' and the last type selected is remembered for the
logged-in user.



Next state

You can drag and drop the card in the next state. Or, click on the check icon √  on the top-right of the card and it will
move the order automatically to the next state column. Going to the previous state is not possible with this option. 

Order options

Click on the dots icon '...' on the top-right of the card. It unfolds several options.

Edit : Opens the order to edit or delete.
Move to Workflow : Moves the order to another Workflow created in neoCatalog.
Change the State: Moves the order to a different state in the current Workflow
Print : Generates print document or job with Print option . When working with print presets, it can be selected
in the sublist .
Restart : Moves the order to the default state of the current Workflow.
Download all files : Can download the original design file as a compressed ZIP that is used in the order.
Archive : Move the order to the archive column.

https://inedit.freshdesk.com/en/support/solutions/articles/14000139302-how-to-generate-and-send-print-files-from-the-print-option
https://inedit.freshdesk.com/en/support/solutions/articles/14000136107-how-to-automate-print-file-generation-in-request-orders


Change the state of all orders

Click on the dots icon '...' on the state column to change the state of all orders in the state.

Notifications

Click on the dots icon '...' on the top-right of the card. It unfolds several options.

Notify customer : If the order contains a customer, then you can notify the customer with the option that send
one email.
Notify team : If the order is present in one workflow that uses owner exclusivity, then you can notify the owner
with the option that send one email.

Working with Workflow States that have action rules applied, once this state is reached, then the rules are applied
automatically.

https://inedit.freshdesk.com/en/support/solutions/articles/14000139879


One email example for team and customer:

Order Chat

The chat feature within the request order interface facilitates communication between team members. It logs
messages, state changes, customer assignments, and priority updates, improving collaboration throughout the order
process. All interactions and updates are automatically recorded and can be viewed in the Event Log.



When users and customers need updates on their request orders and are using the chat feature, the advanced
preference enabled sends email notifications for every comment added. Both the creator of the order and the
assigned customer will receive these chat notifications via email, ensuring they stay informed about all updates.

Archived orders

Archived orders are hidden by default but can be shown when enabling the option on the top. Once the order is
archived, it can be restarted and managed the same as one non-archived order.

Hide state

This feature allows users to customize their experience in the request order kanban by providing an option to hide
and show states. Users can personalize their views by choosing to hide specific states. Additionally, the system
remembers this selection based on user sessions.

https://inedit.freshdesk.com/en/support/solutions/articles/14000153576


The option "Show Hidden" will show the states in the kanban.

Watch Video: https://player.vimeo.com/video/927452512

Related articles:

How to create Requests Orders

How to automate print file generation in Request Orders

How to use the Shopping Cart

Shopping Cart is the order request feature in neoCatalog Server. With this feature, you can select your colorways
and add them as items in the Shopping Cart to create an order request. When checking out the order, the acceptor
is going to receive an email with all requested information, and the option to accept the order from the email. The
order request process is managed from the request page. When the option is enabled, after the log in a new cart
icon next to the logout appears one cart icon.

This page is optional and an Administrator of your neoCatalog must activate it in administrations preferences .

Add items
Select designs or colorways and add them to the Shopping Cart with the button 'Add to Cart' from the bottom menu
bar. The items will be added to the cart so that the item quantity is shown in the cart icon on the top.

Click on the Cart and you will access a new page where all your items are listed. Exclusive designs are blocked for
the order, as long you don't have administrator privileges. The Checkout is blocked as long the exclusive design

https://player.vimeo.com/video/927452512
https://inedit.freshdesk.com/en/support/solutions/articles/14000140214-how-to-create-requests-orders
https://inedit.freshdesk.com/en/support/solutions/articles/14000136107
https://inedit.freshdesk.com/en/support/solutions/articles/14000140891-how-to-enable-request-orders-and-shopping-cart-features


remains in the shopping cart.

Having administration rights, you can replace the exclusivity owner with your account with the checkbox below the
comments field. Even without replacing the exclusivity, you can check out the order.



Removing the exclusive items the checkout order is available, regardless of which user privileges.



Edit items
To increase or erase the quantity of the item, enter the value in the field Quantity or use the up/down buttons.
To remove items, click on the 'Remove' button.
Fabric and Finishing methods can be added for each item.
Individual comments for the order request can be written in the given field. Finally, you will have an order
request ready for checkout.

Checkout Order
Click on the Checkout button and it will confirm the message with OK, or else on 'Cancel' if you want to edit your
order. When the checkout was successful, in the cart you will see the order number #.

Accept Order
As soon as the order is sent, you will receive a confirmation email with the order details. The designs will become
exclusive for the days specified in the preference, by default are 7 days.

In the meantime, the order receiver is going to receive an order email with order details and the link to accept the
order.



When the order is accepted, the order sender will be promptly informed by another email. The designs will become
exclusive for the months specified in the preference, by default are 6 months.

From the request order page in neoCatalog in the default workflow , the order can be seen and started to be
prepared. As soon as the order is started to be prepared, also the order sender will be informed by email.

https://inedit.freshdesk.com/en/support/solutions/articles/14000140214
https://inedit.freshdesk.com/en/support/solutions/articles/14000139879


Previous version
(until 3.16.5)

The feature is optional and an Administrator of your neoCatalog must activate it in advanced preferences .

Related articles:

How to enable Request Orders and Shopping cart features

Application Modules

How to create Requests Orders

Request Order Management

"_Internal error" message at Shopping Cart Checkout

Shopping Cart items exclusivity (advanced)

Layout for neoCatalog Request Order and Items
data

The attached layout example "Inedit_RequestOrderForm.x" will add the requested order and request item
information in the layout. The variables are inside the file "LogoNameColorsCT_Requests.tjb".

Result:

<Variable id="999" name = "RequestCode" type="CustomField" value = "002063"/>
<Variable id="1000" name = "RequestName" type="CustomField" value = "R. Layout"/>
<Variable id="1001" name = "RequestComments" type="CustomField" value = "Make this order 

https://inedit.freshdesk.com/a/solutions/articles/14000129843/edit?lang=en
https://inedit.freshdesk.com/en/support/solutions/articles/14000140891-how-to-enable-request-orders-and-shopping-cart-features
https://inedit.freshdesk.com/en/support/solutions/articles/14000139356-application-modules
https://inedit.freshdesk.com/en/support/solutions/articles/14000140214-how-to-create-requests-orders
https://inedit.freshdesk.com/en/support/solutions/articles/14000139879-request-order-management
https://inedit.freshdesk.com/en/support/solutions/articles/14000134031--internal-error-message-at-shopping-cart-checkout
https://inedit.freshdesk.com/en/support/solutions/articles/14000129843-shopping-cart-items-exclusivity-advanced-
https://inedit.freshdesk.com/en/support/solutions/articles/14000140214


tommorow."/>
<Variable id="1002" name = "RequestCustomer" type="CustomField" value = "TestCustomer5"/>
<Variable id="1003" name = "RequestCreationDate" type="CustomField" value = "2023-05-29 14:23:00 
Etc/GMT"/>
<Variable id="1004" name = "RequestCreationBy" type="CustomField" value = "testUser2"/>
<Variable id="1005" name = "RequestPriority" type="CustomField" value = "3"/>
<Variable id="1006" name = "RequestItem_Fabric" type="CustomField" value = "345"/>
<Variable id="1007" name = "RequestItem_FinishingMethod" type="CustomField" value = "Transfer"/>
<Variable id="1008" name = "RequestItem_Comments" type="CustomField" value = "item has comment"/>
<Variable id="1009" name = "RequestItem_Quantity" value = "10.0"/>
<Variable id="1010" name = "RequestItem_Size" value = "30cm"/>

Attachments:

Layouts.zip 
Inedit_RequestOrderForm.xml 
LogoNameColorsCT_Requests.tjb 

https://inedit.freshdesk.com/helpdesk/attachments/14123103287
https://inedit.freshdesk.com/helpdesk/attachments/14123103354
https://inedit.freshdesk.com/helpdesk/attachments/14123103355


Request Order Management

This section describes the setup before starting to work with Requests Orders. You need to enable the module first.
Afterward, the options 'Request Type' and 'Workflows' are available in 'Management' to make the required setup.

TABLE OF CONTENTS

Workflow Management
States & Actions

Request Type Management

Workflow Management
A workflow defines the states of how request orders should be processed with rules. You can have more than one
workflow.  By default, neoCatalog creates one embedded Workflow with predefined states:

To Do > Accepted > Finished > Started > Verified.

https://inedit.freshdesk.com/en/support/solutions/articles/14000139356-application-modules


To create your own Workflow, click the '+' button on the left. It creates one new untitled workflow with default states.

You can modify the new workflow:

Title: The Workflows are sorted by name.
Description: Add a descriptive explanation or text to the workflow.
Default state: The default state is used when creating the requests that will set the request in the selected state
(e.g.: State changed to Accepted will have the new request starting at that state).
Exclusivity: The workflow can become exclusive for selected users or groups. Later in notifications called
"team".

States & Actions

Every state can be modified in the title, description, state color, and action. State position can be changed by drag
and drop in the list.

Add new state: Adding a new form will extend the workflow rules. You can add a new title, description, state
color, and action.



State Type : Requests will progress through the following stages: UNSTARTED > ACCEPTED > STARTED >
DONE > VERIFIED. The workflow follows a strict sequence from UNSTARTED to VERIFIED; Once a request
reaches the STARTED state, it becomes locked for modifications.
Action : Rule applied when a request arrives or is moved to the state. You can set:

None
Notify customer
Notify team (user or group with customer or user category)
Notify other emails
Archive
Print with preset
Change design status
Action using 'Print with preset' requires a print preset with one active 'Send to neoStampa' or 'Save to
Server' destination.

Archive : The option to archive or unarchive states, including orders, with the ability to display archived states.
After any modification, press Save to embed the workflow and state to neoCatalog.

Request Type Management
Request Type is used when working with neoCatalog Server Requests. It is required to create types to create
request orders, where several meters may be the thing to print. The types can be different in meaning.

Go to 'Management' and select Request Types listed in 'Utilities'. In the next window, on the left of the page, you can
search, select, edit, or add a new request with the '+' button. If you open or create a new Request, at the center of the
page you will see the table with Title, Description, and Workflow fields that need to be filled in. With the 'Set as
default' button, the selected request type will be used as the default type for order requests.

https://inedit.freshdesk.com/en/support/solutions/articles/14000136107
https://inedit.freshdesk.com/en/support/solutions/articles/14000139302-how-to-generate-and-send-print-files-from-the-print-option


Related articles:

How to enable the Request Orders and Shopping Cart feature

REQUESTS - Enable Email Notifications for Order Creator on State Changes (advanced)

Application Modules

How to generate and send print files from the Print option

QuickPrint Preset Management

https://inedit.freshdesk.com/en/support/solutions/articles/14000140891-how-to-enable-request-orders-and-shopping-cart-features/
https://inedit.freshdesk.com/en/support/solutions/articles/14000154125
https://inedit.freshdesk.com/en/support/solutions/articles/14000139356-application-modules
https://inedit.freshdesk.com/en/support/solutions/articles/14000139302-how-to-generate-and-send-print-files-from-the-print-option
https://inedit.freshdesk.com/en/support/solutions/articles/14000139680-quickprint-presets-management


Secure Printing with End-to-End Encryption in
neoCatalog

Data security is more critical than ever. Protecting sensitive information during the printing process is essential for
maintaining overall data security. NeoCatalog’s secure printing feature, using end-to-end encryption, offers a robust
solution to protect your data from the moment a print job is sent until it is printed. By following this guide, you can
make certain that your sensitive print jobs are securely encrypted and protected from unauthorized access.

What is Secure Printing with End-to-End Encryption
Secure printing with end-to-end encryption means that your print jobs are encrypted at the source and remain
encrypted until they reach the printer. This prevents unauthorized individuals from intercepting or accessing sensitive
information during transmission or while waiting to be printed. Encrypting the print data safeguards confidential files,
making sure that only authorized personnel can access them.

Setting Up Secure Printing in neoCatalog
Before utilizing secure printing, it’s essential to verify that your non-file-based printer is properly configured in
neoStampa and that the Print Server queue is started.

Configuring neoCatalog

1. Access neoCatalog using the IP or Host Name (not localhost) and log in with an administrator account.
2. In the advanced preferences section, create the following settings:

Set neo_print_quality to Best.
Set neo_enable_quickprint_notifications to Yes.
Set neo_custom_server_url to the same URL ( http://IP:Port ) as your current session.

3. Navigate to Administration > Management > Utilities > Print Servers Management in neoCatalog. Here, you
can create and add the Print Server connection.

4. Verify the connection by clicking 'Check the connection' and save the configuration by clicking 'Save'.
5. Confirm that the 'Secure Printing' checkbox is automatically enabled, allowing encrypted print jobs.

https://inedit.freshdesk.com/en/support/solutions/articles/14000139679


Using Secure Printing
With the setup complete, you can now proceed to create and print secure print jobs.

1. In neoCatalog, navigate to the Design or Colorways view and select a multichannel PSD file (note that PDF
and Illustrator files are not supported).

2. Click on the 'Print...' button and choose 'Send to neoStampa' as the destination, selecting your printer's Print
Server. Verify the 'Secure Printing' checkbox is enabled before sending the job.

3. After selecting your printer scheme, click 'Send to neoStampa'. You should see a 'Processing in background
QuickPrint' message, followed by 'Added to the printer queue'.

4. 

To manage your print queue, click on the 'View queue' button next to the printer name in the Print dialog. This
action will open a new web browser tab displaying the 'Printing History' page.

5. Add the Print Server to the queue by clicking on 'Print Server Queues' on the left and using the '+' button.
Confirm that the Print Server shows an 'Idle' status.

6. In the printing queue card, verify that your job appears on the 'Print Server Queue Detail' page with a secure
shield icon next to the job name, indicating its encrypted status.

7. When ready to print, check the job to initiate printing and observe the 'Printing...' message along with the

https://inedit.freshdesk.com/en/support/solutions/articles/14000139302


progress bar. This is when the print job is decrypted. Remember, attempting to reprint the job will result in a
"Sorry, cannot be printed again" message, as encrypted jobs cannot be reprinted.

"_Internal error" message at Shopping Cart



checkout

As of version 3.14.0, neoCatalog could return an "_Internal error" message at Shopping Cart checkout.

The reason is that the "Cart" request type , which is automatically created when using the shopping cart for the first
time, had been deleted by the Administrator and this has been logged in neoCatalog ever since, the time during
which the checkout was performed.

To solve it, the Administrator has to log out and back in so that the "Cart" request type is available again.

Related articles:

Shopping Cart

10. Administration Management

Application Modules

Modules provide application components with different coordinated tasks that can be introduced and adapted to
your workflow. In addition to the basic application modules, the server version provides extra features.

The neoCatalog desktop app version has limited modules:

Galleries
Print Server
Rating
QuickPrint presets
Tags

https://inedit.freshdesk.com/en/support/solutions/articles/14000139879-request-order-management
https://inedit.freshdesk.com/en/support/solutions/articles/14000140219-shopping-cart


Paneling Options
Design Attachments

If you work with the neoCatalog Server version has additional modules:

Requests
Engraving
Boards
Sections

Galleries



One of neoCatalog's options is to classify your colorways into galleries, which you will be able to keep private or
public. Galleries are enabled by default. Refer to the user manual for more usage information.

Print Server

Enable the preference to work with Print Server connected with neoCatalog, which will search for the Print Servers
printers automatically. Refer to the user manual for more usage information.

Rating

Enables or disables the rating with likes, dislikes, and comments in the footer menu on every page.

QuickPrint presets

Enables or disables the option to create and edit presets on the Print dialog. Refer to the user manual for more
usage information.

Tags

Enables or disables manual or automated options that will index your designs and detect if similar designs in your
neoCatalog exist.

Paneling Options

Enables paneling options for flooring simulations.

Design Attachments

Enables adding custom attachments to designs.

Requests

Enables or disables the availability of the requested order. After login into neoCatalog, the tab REQUESTS on the
top bar is available to access from every web browser.

Engraving

Enables or disables the feature to calculate the covered area of each channel of multichannel designs. When
selecting a multichannel design, from the footer bar 'Edit' button shows the action 'Engraves...'.

Boards

Enables or disables the feature to have a shared place to keep visibility in your shared gallery and items
organization with your colleagues and customers. After login into neoCatalog, the tab BOARDS on the top bar is
available to access from every web browser.

Sections

Another view section to define and manage files like 'Originals', 'Structures', 'Artworks', etc. Once enabled, in



Categorizations, you can configure the name of the new section. Save and restart the application before usage.

Related articles:

Galleries

Another File Section in neoCatalog

Setup of categorization options

Custom Fields and Custom Dialogs Management

When working with custom fields, then with custom dialogs you can define which fields should be shown in which
dialogs.  To access the Custom Fields and Custom Dialogs management, go to 'Management' in administration and
find the listed in 'Advanced'.

TABLE OF CONTENTS

Custom Fields Management
Custom Dialogs Management

Dialog: Upload new design with default fields.
Dialog: Upload new colorway with default fields.
Dialog: Edit design with default fields.
Dialog: Edit colorway with default fields.
Dialog: Advanced Search with default fields.
Dialog: Information with default fields.
Dialog: Engraves with default values.
Dialog: Edit Request with default values.

Watch Video: https://player.vimeo.com/video/783304065

Custom Fields Management
The option Custom Fields in neoCatalog Server is used to meet the needs of additional data fields to specify values
for the selected design.

In the next window, you can search, select, edit, or add a new custom field with the '+' button.

If you open or create a new field, at the center of the page you will see the table, with Name, Label, and
Description fields, Entity Attribute ( Design, Colorway, neoColor, Fabric Code ), and Type selection. The name
is used to create further variables in neoCatalog Layouts.
The available types are Checkbox, Radibuttons, Checkboxmatrix, Popup, Text or User/Contact.
You can define the default value and if the field is required or not.
In the Preview section, you can view the final result that will be shown in the dialogs of neoCatalog.
Press Save after creation or any modification, or else to remove custom fields press 'Delete'.

https://inedit.freshdesk.com/en/support/solutions/folders/14000129000
https://inedit.freshdesk.com/en/support/solutions/articles/14000139357-another-file-section-in-neocatalog
https://inedit.freshdesk.com/en/support/solutions/articles/14000139303-setup-of-categorization-options
https://player.vimeo.com/video/783304065


After the dialogs management, the fields will be present and selectable in the supported dialogs.

Custom Dialogs Management
The available dialogs are for editing, importing design and colorway, as search criteria in the advanced search, and
for general design and request information. The dialogs can be customized with fields that are set by default or add
unused data (others and custom fields).

In the next window, you can search, select, edit, or add a new custom dialog with the '+' button.

If you open or create a new dialog, at the top of the page you will see the options to choose the user type
(Category) and the Exclusivity (User/Groups).
The default fields are added automatically in the dialog. Those with a Read-only flag will be shown as text only.
The custom fields and other data are listed below under "Unused fields".
Clicking on the icon-eye-off will remove the field from the dialog and will be listed below under "Unused fields".
Clicking on the icon-eye-on will move it back to the dialog.
You can define the position of the fields in the dialog by drag&drop the fields in the higher or lower position.
Press Save after creation or any modification, or else to remove custom fields press 'Delete'.

Dialog: Upload new design with default fields.



Dialog: Upload new colorway with default fields.



Dialog: Edit design with default fields.



Dialog: Edit colorway with default fields.





Dialog: Advanced Search with default fields.





Dialog: Information with default fields.



Dialog: Engraves with default values.

Dialog: Edit Request with default values.

Later in the defined dialogs of every type (import, edit, search, information), you will see the selected default and
custom fields with the rule and position.

Edit design and advanced search dialog:



Upload design and colorway dialog:

Information dialog:

Related articles:

neoCatalog layouts using custom fields variables

https://inedit.freshdesk.com/en/support/solutions/articles/14000129901-nc-layouts-using-custom-fields-variables


Design search and navigation

Fabric Type Management

In Fabric, you can create types of fabrics, and fabric categories with descriptions of their characteristics that can be
used in request orders. To access the fabric table, go to 'Management' in administration and find the listed options in
'Materials'.

In the next window, on the left of the page, you can search, select, or add new fabrics with '+'. In the filter list, the fabric
name will be shown in reference and name.

To edit, selecting one fabric you will see the information on the right:

Reference*
Name*
Category
Composition
Fabric Width in cm
Weight gr/m2
Performance
Construction Type
Price by meter €
Keyword Restriction
Exclusive
Customer
Description
Profile Path
Preview file

If you no longer need to use a fabric, you can easily enable or disable it by clicking the button located at the bottom of
the page.

Don't forget to press Save after any new information about the Fabric or a new creation.

https://inedit.freshdesk.com/en/support/solutions/articles/14000139928-design-searching-and-navigation


Related articles:

How to manage Request Orders

https://inedit.freshdesk.com/en/support/solutions/articles/14000141776


How to create color libraries in neoCatalog

neoCatalog allows the creation and edit Color Libraries and works with various Color Libraries. If you work with nT
Colorations and neoColorBox, those color libraries will be synchronized simultaneously.

To access the color libraries table, go to 'Management' in administration and find the listed options in 'Materials'.

In the next window, on the left of the page, you can search, select or add new color libraries with "+".
At the center of the page, you can:

see the name, edit the name, and see the file path on the server
mark the color library as visible (if not checked, then is hidden for users)
add the owner add owner or owner group so that only group members can work with the color library.
define columns and rows in the library
import the original color library file (Note: it will add colors to the existing library or download the color
library)

On the right, you can view and search for colors in the color library by typing the color name in the search field.
Below the colors, you can see the number of colors in the color library.

TABLE OF CONTENTS

Format specifications of the CSV
Format for 100% color values
Format for gradient color values

Customer color libraries
Format specifications of the CSV for neoCatalog
Format for 100% color values
Format for gradient color values

Importing Color Libraries
Rename Colors



Download Color Libraries
Download and Edit Color Library in CSV format

Format specifications of the CSV
In order to import a color library, you need to create and prepare the CSV text file. The headers in the CSV are
specified and must be followed. Supported color values are LAB and RGB.

The CODE header is supported, but not used in sorting. To sort colors differently than names, use the ORDER
header.
NAME content with space will be ignored.
NAME is limited to 32 characters.

ORDER

(required content)

L

required
content

A

(required
content)

B (required
content)

NAME (required
content)

COMMENT (optional
content)

column 1 ORDER
number Columns 2-4 are used for the LAB values column 5 for the

color name
column 6 for comments
as page

Format for 100% color values

Using the 100% color value of a color name. Example:

ORDERL A B NAME COMMENT

1 941 7 11-0103 C 01-01-01

2 950 3 11-0602 C 01-01-02

Format for gradient color values

Using the 100% color value of a color name. Gradient color will be used in the database only. Example:

ORDERL A B NAME COMMENT

1 78-2 76 Color 1%10001-01-01

88-1250 Color 1%40 01-01-02

85-1066 Color 1%70 01-01-03

2 82-8 75.26Color 2%10001-02-01

88-1243 Color 2%40 01-02-02

88-1362 Color 2%70 01-02-03

Customer color libraries
Many times customers provide color libraries in different extensions and data format, that has been used in different



coloring systems and now should be used by Inedit products.  It is required to modify those color libraries in format
and structure to be compatible with Inèdit applications.

Example:

NUMPAGES=120NUMROWS=16NUMCOLS=16
CODE L a b
A1.1.1 40.58 61.97 -11.33
A1.2.1 39.05 59.08 -11.15
A1.3.1 37.43 55.91 -10.97
A1.4.1 35.71 52.43 -10.79

Format specifications of the CSV for neoCatalog

In order to import a color library, you have to create and prepare the CSV file format.
NOT supported .vdb, .excel, .aco, .acb
Supported color values are LAB and RGB.
The CODE header is supported, but won't be used in sorting. If you want to sort colors else than names, use
ORDER in the header.
Dot decimal separator in CSV.
No limit on color number (having low memory can fail importation).

When converting the customer library to a compatible neoCatalog library, please follow the exact column description:

ORDER
(required
content)

L
(required
content)

a
(required
content)

b
(required
content)

NAME
(required content)

COMMENT
(optional content)

column 1 ORDER
number Columns 2-4 are used for the LAB values column 5 for the

color name
column 6 for comments
as page

Format for 100% color values

Using the 100% color value of a color name.

Example using customer library:

ORDER L a b NAME COMMENT
1 40.58 61.97 -11.33 A1.1.1
2 39.05 59.08 -11.15 A1.2.1
3 37.43 55.91 -10.97 A1.3.1
4 35.71 52.43 -10.79 A1.4.1

Format for gradient color values

Using the 100% color value of a color name. Gradient color will be used in the database only.

Example using customer library:
ORDERL a b NAME COMMENT
1 40.5861.97 -11.33A1.1.1%100

39.0559.08 -11.15A1.1.1%70
37.4355.91 -10.97A1.1.1%40

2 35.71 52.43 -10.79 A1.2.1%100



*Sample CSV attached.

Importing Color Libraries
Press + button to create a new Color Library. The new libraries need to be imported by clicking on the Import Library
from the file button. Bear in mind, though, that those files have to be .CSV.

Follow the instructions on the screen to upload the file. Once uploaded, see the information with the name of the
library. After saving the importation with Save, the library is in the list on the left and the colors of the library are
positioned on the right of the page.

The 'Visible' option is by default enabled to work with the color library, but if the color library should not be used for
coloring in coloring modes, then this option should be unchecked.

Rename Colors
Search the color that you want to rename in name or comment in the selected color library by color name using the
search field or by color using the color picker.

 

Once f ound your color, click on 'Edit' next to the color search result. 

A new dialog opens with fields for name, values, comment, and gradients. Colors with gradients are shown after @.
In this dialog only the name and comment are editable. LAB values can be changed in the .csv file, which was used
to import and create the color library. When leaving the dialog with 'Save', the color will be shown with a modified
name or comment.



Download Color Libraries
To Download local Color Libraries, access the window we have seen before. The following formats can be
downloaded:

.csv (excel file)

.aco (for Photoshop color library)

.acb (for Photoshop swatches)

Download and Edit Color Library in CSV format

At the center of the page, mouse right-clicks on 'Download .csv' and the color library will be downloaded locally in the
Downloads folder on your computer. Open the CSV file in Excel, and watch out for column order or text changes in
the file.

Change the necessary LAB values, or if required add new colors. When adding colors, make sure to follow the
ordination in column ORDER.

For safety reasons, duplicate the current color library before deleting the current one.

After the modification in the CSV, create a new color library with '+' and import the new CSV file with the Import
library from the file button. Press Save after uploading the file.

TIP : Working with neoMatch ? Take the customer library in neoMatch and import it in neoCatalog after
exporting CSV for neoCatalog (File > Export) or publish the color library in neoCatalog from neoMatch that has
required connection to the neoCatalog.

Related articles:

Import customized color libraries in neoMatch

Import custom color libraries in nT Colorations

neoMatch connected with neoCatalog

How to create new colorways colors

Sorting Types for colors in a color library (advanced)

Attachments:

nC_ColorLibraryFormat.csv 

Stats Dashboard

Stats offers a calculation of the number of designs and colorways, galleries, users, and sessions from the beginning.

https://inedit.freshdesk.com/en/support/solutions/folders/14000128489
https://inedit.freshdesk.com/a/solutions/articles/14000132789
https://inedit.freshdesk.com/en/support/solutions/articles/14000132801-import-custom-color-libraries-in-nt-colorations
https://inedit.freshdesk.com/en/support/solutions/folders/14000128489
https://inedit.freshdesk.com/en/support/solutions/articles/14000140077
https://inedit.freshdesk.com/en/support/solutions/articles/14000143032
https://inedit.freshdesk.com/helpdesk/attachments/14112261966


It indicates the number of designs and colorways in types (digital or separated) that have been created. The Stats
dashboard can be accessed by administrators only.

Sliding over the graphic you can see the amount of digital or traditional designs and colorways.
Comparing Day/Week/Month with the same Day/Week/Month of a previous year, you can see the evolution of
Designs, Colorways, and Requests.
Export the statistics in Excel (attached example).

Watch Video: https://player.vimeo.com/video/776227293

Related articles:

User Access and Sessions Control

Attachments:

exportDesigns_Sample.xlsx 

System Info of neoCatalog

In System Info you will find information of:

External neoCatalog URL
neoCatalog UUID
neoCatalog version
neoRipEngine version
System processor and memory info
DropBox importation background tasks status and port
Other backgrounds tasks and ports
Download logs (logs of services that are completed)

https://player.vimeo.com/video/776227293
https://inedit.freshdesk.com/en/support/solutions/articles/14000139734-user-access-and-sessions-control
https://inedit.freshdesk.com/helpdesk/attachments/14113438978


Uploading ICC Color Profiles in neoCatalog

Working with custom ICC profiles for coloration in coloring systems requires having the same ICC profile installed in
the computer where neoCatalog is installed. The profile will be used to generate the previews to get the same color



view as in the coloring systems and to be able to use soft proofing. Here you can upload the profile.

To access the color profiles table, go to 'Management' in administration and find the listed options in 'Materials'.
 Here you can upload the profile in neoCatalog.

The profile will be stored in /neoCatalog/Profiles/ .





User Access and Sessions Control

On the Administration page, click on 'Access Control'. There are two options to view the access logs and another to
overview the activity dashboard that you can filter by search. This page can be accessed by administrators only.

Watch Video: https://player.vimeo.com/video/776222373

Access history
A record of Access Logs shows all the accesses to the neoCatalog, providing information on the Access Date, User,
User Category, connecting time-lapse and IP Address.  The access in blue color is indicated as the active sessions.

Overview
A dashboard showing neoCatalog users' interactions and time of connections.

https://player.vimeo.com/video/776222373


Related articles:

Stats dashboard

https://inedit.freshdesk.com/en/support/solutions/articles/14000139739-stats-dashboard


User Notifications - How to receive notifications for
activities

Notifications in neoCatalog are a helpful system service that keeps users informed about various important events
and activities through in-app messages and email notifications, regardless of whether they are actively using the
application or not.  By effectively utilizing the Notifications feature, you can ensure that users stay updated and
informed about important events and activities within neoCatalog.

To access the Notifications management, simply go to Administration in Management then Notifications, which you
can find under the 'Accounts' section. Once you are on the Notifications page, you can easily search, select, or edit
different types of notifications.





When you select a specific notification type, you'll be able to see its details and contents displayed in the center of
the page. Each notification type has the following elements:

Title: This is a fixed field and cannot be changed.
Level of the issue type: You can classify the severity level of the notification as Message, Warning, Error, or
Critical Error.
Description: Here, you can provide additional information or context related to the notification. You have the
flexibility to define your own description.
Suggestion: This field allows you to give suggestions or recommendations related to the notification.
Mail (Notification): By checking this option, you can enable email notifications to be sent along with in-app
messages.
Allow duplicates: When enabled, this feature allows multiple instances of the same issue to be registered and
notified each time it occurs. If disabled, the issue will be registered and notified only once.
Notify the user: You can select specific users to be included in the notification order. By pressing the '+' icon,
you can add users to receive the notification.

Notification to enable email sending

From the unfolded tab user list, select the user that you want to notify and press to include the user in the notice order.
Finally, in the notifications list, check the box to enable sending the email to the selected user. As soon as the
notification is enabled and a new issue is created, email notifications will be sent to that user.



NOTE: Print notifications are managed by the WebAPI and must be in enabled in advanced 
preferences by the administrator.

Related articles:

E-mail Server Settings

11. Administration Preferences

Customize Login Page and logos

In neoCatalog, you can customize the background of the login page from Preferences > Login Page. You can use a
solid color or add an image and use your company logo, and enable the help widget.

TABLE OF CONTENTS

Background Login
Company Login Logo

Custom company Logo on the header

https://inedit.freshdesk.com/en/support/solutions/articles/14000151233
https://inedit.freshdesk.com/en/support/solutions/articles/14000139389


Background Login
To customize the background color of the login page, use the color picker, random gradient colors, or type RGB hex

values like '#FFFFFF' or CSS names like 'white'. 



Manually, you can embed your own background image in the Login window. Your file must be approx. 2000 x 900 px
and in format JPG. The name must be bgImage.jpg or bgImage.gif (for animation). Store your file independently in
neoCatalog. Refreshing the web browser neoCatalog login page will display the embedded background image.

Company Login Logo

This is the logo that is placed above the long fields. Your file must be approx. 200x90px and in format JPG or PNG.
The name must be logo_neocatalog.png o r logo_neocatalog.jpg . Store your file independently in the
neoCatalog folder. After refreshing the web browser neoCatalog login page the logo will be displayed. On the
preferences, you will see view only the logo in use.

Custom company Logo on the header

This is the logo that is placed on the top-left after the login on every page. 

Your file must be approx. 90x30px and in format JPG or PNG. The name must be logo_neocatalog_mini.jpg or
logo_neocatalog_mini.png . Store your file independently in the neoCatalog folder. After refreshing the web
browser neoCatalog login page the logo will be displayed. The same logo will be used in emails of the shared
samples , or else the logo in user management .

https://inedit.freshdesk.com/en/support/solutions/articles/14000139301-share-samples-and-items
https://inedit.freshdesk.com/en/support/solutions/articles/14000139304-users-and-groups-management


Related articles:

neoCatalog Help widget connected to the knowledge base

Share Samples and Items

Users and Groups Management

Customize Preview Style

You can customize the preview style for designs and colorways to suit your needs. Tailor the appearance of previews
and their containers using a variety of design and colorway details, labels, colors, and titles.

Preview Style Options

Colors Available: None, Red, Yellow, Blue, Green, Purple

Design Information: Design Type, Code, Name, Collection, Creation Date, Status, Designer,
Exclusive, Expiration Date, Keywords, Number of Channels, Customer, Price, Rapport, Rapport
Direction, Resolution (DPI), Trademark, Sub-trademark, Verification Date, Verifier, Alias, Modification
Date, Size, Custom Fields, Gallery Names, Has Colorways, and more.

Colorway Information: Colorway Code, Name, Type, Colorist, Creation Date, Galleries, ICC Profile,
Status, Customer, Verifier, Finishing Method, Fabric Code, and more.

Both design and colorway details can be displayed within their respective previews.

Customization Features:

Change the preview size in pixels.

https://inedit.freshdesk.com/en/support/solutions/articles/14000141782-neocatalog-help-widget-connected-to-knowledge-base
https://inedit.freshdesk.com/en/support/solutions/articles/14000139301-share-samples-and-items
https://inedit.freshdesk.com/en/support/solutions/articles/14000139304-users-and-groups-management


Adjust the internal preview size using units like centimeters, pixels, or repeats.

NOTE: Changes to preview styles will only affect newly generated thumbnails. To apply changes 
to existing thumbnails, use the "Remake All" button to regenerate them.



Related articles:

Start a new login session in neoCatalog

Customize Translations

If you wish to have the interface, keywords, tags, simulation, collection, or treatments available in more than one
language or translated into codes, the table 'Translation' in Preferences offers the possibility to do so in neoCatalog.

After you enter Translations, in the list you see the existing translations, that come with the default keywords.

https://inedit.freshdesk.com/en/support/solutions/articles/14000139277-start-a-new-login-session-in-neocatalog


With 'Add translation' you can create new a translation.

1. Create translations by writing the word you want to translate in 'Original word'



2. Select type
3. Selecting the language you want to translate from
4. And finally the new word.
5. Click 'Save' to keep the changes.
6. Changes are applied immediately after refreshing the pages.

Translations on the interface have a different source original word, to avoid translation of one original word, instead
of "Code", we need to use "Design Code", then the translations will be applied to e.g. Name, Code, etc., in dialogs
(search, edit, import, information).

Related articles:

Custom Fields and Custom Dialogs Management

Display Options Settings

These Display options allow you to change default behaviors. 

https://inedit.freshdesk.com/en/support/solutions/articles/14000139742


Default Sorting of design
Allows selecting in what order you want to see the designs sorted by default. This is applied to the Design view only
and can be changed manually on the page that lasts during the open session.

Designs as Owners
Design and colorway ownership is a term that may lead to confusion initially. Sometimes the designers need
ownership of designs. The designer users can have the privileges to own and manage designs over the customer.
See how it works .

Related articles:

How to get Designers (Users) to own designs

User Privileges Management

https://inedit.freshdesk.com/en/support/solutions/articles/14000129696-how-to-get-designers-user-to-own-designs
https://inedit.freshdesk.com/en/support/solutions/articles/14000129696-how-to-get-designers-users-to-own-designs
https://inedit.freshdesk.com/en/support/solutions/articles/14000139300-user-privileges-management


E-mail Server Settings

neoCatalog uses its own email server settings, but in case you want to specify yours, here is the place to configure it.

Use the 'Test' button to check if your email configuration is working. With the 'Reset Settings' you can always come
back to the default configurations.

Related articles:

neoCatalog: Emails do not arrive

Emails received from neoCatalog have missing buttons and logos

How to setup the search for similar images

Search for a similar image would return results that visually relate to the selected design. If you work with the image
tags indexing function with Clarifai AI , you can search for visually similar images.

https://inedit.freshdesk.com/en/support/solutions/articles/14000129530-neocatalog-emails-do-not-arrive
https://inedit.freshdesk.com/en/support/solutions/articles/14000129842-emails-received-from-neocatalog-have-missing-buttons-and-logos
https://inedit.freshdesk.com/en/support/solutions/articles/14000141948
https://www.clarifai.com/products/spacetime-ai-search-engine


How does it work?

Clarifai identifies similar images using Clarifai AI models trained on large datasets.
It analyzes images by extracting visual details like colors, shapes, textures, and patterns.
Each image is processed into a numerical form called a feature vector, representing its unique visual characteristics.
To find similar images, Clarifai compares these vectors using methods like cosine similarity or Euclidean distance. Images with
closer vectors are considered more similar. For instance, if you select a design with squares, borders, and brown color, then it is
going to search for "similar" designs that contain those characteristics.
Results are ranked by similarity, and on neoCatalog advanced settings, we can adjust the value of how sensitive the matching
process is. This value can be adjusted in the advanced preferences .

Once you have made the setup with Clarifai, the search for similar images is done by a button in the header bar on
the home design page:

Step-by-Step
1. Go to your free Clarifai account and create a new application following the setup with Clarifai . 

2. Go neoCatalog Categorization, configure the part of Tags with required configuration data, and save. 

3. Once the administration part for tags is configured, you have to update image tags for the image search of all
designs. This can take some minutes. In Clarifai App Explorer you can view tagged designs.

4. Restart the neoCatalog service (required). 

5. Start searching similar images with the button next to the quick-search field.

https://inedit.freshdesk.com/en/support/solutions/articles/14000141955
https://portal.clarifai.com/login
https://inedit.freshdesk.com/en/support/solutions/articles/14000141948


6. You will get the highest precision in the first result and then be ordered by the least precision. If you look for higher
precision, the administrator can create advanced preferences and define the precision value.

Example:

Related articles:

How to tag designs with Clarifai AI™

https://inedit.freshdesk.com/en/support/solutions/articles/14000141955
https://inedit.freshdesk.com/en/support/solutions/articles/14000141948


How to tag designs with Clarifai AI™

Tags are label words that you can add to the design making them easier to group and find. For example, you could
add the blue tag to all designs related to blueish colorways. That would allow you to easily see, display, and search
for related designs. Enable tags in modules to start working with tags.

The automated tagging option using Clarifai AI™ will index your designs and detect if similar designs in your
neoCatalog exist. It allows you to search images with two options:

Automatically generated tags so that the search of designs is easier using design character parameters.
Search images that are visually similar to any designated query image.

TABLE OF CONTENTS

Setup Clarifai account
Setup tag preference for Clarifai API
Tag Designs
Tagging During Design Import
Previous version

Setup Clarifai account
The first step to start using automated 'Tags' is to configure the API to receive the tags. As a neoCatalog admin user,
you need to configure the option of using Clarifai API.

1. Make your own registration on https://clarifai.com/signup to create a new application.

https://inedit.freshdesk.com/en/support/solutions/articles/14000139356-application-modules
https://www.clarifai.com/search
https://clarifai.com/signup


2. For the connection with neoCatalog required data are the App name, User ID, Language, and Base
Workflow (General):

3. The second part is the generation of the PAT (Personal Access Token) key. Form your Avatar and go to Security.
In the lower part of the page, you will find the fields for PAT key generation. Click on the link “Create Personal Access
Token”.



4. Create your personal token name description and select all scopes. Continue with Confirm.

5. Once the token is created, you need the PAT key for the next settings in neoCatalog.



Setup tag preference for Clarifai API
The second step is to go to neoCatalog Preferences > Modules , enable the 'Tags' module, click 'Save' and continue
with the Configure (blue) button. Enter the required Clarifai credentials:

1. Clarifai PAT (Personal Access Token)
2. Clarifai USER ID Key
3. Clarifai APP ID Key
4. Set the default tag detection language .
5. Define the Minimum prediction value to set a minimum percentage for the precision level of detected tags.

(recommended 90.
6. Once all configurations are set, click Save .

Tag Designs
1. Now you need to tag your designs. If you configure the first time, you must tag all designs. Else, you should tag only
the untagged. The tagging can take some minutes.

2. Once tagged, you will see the auto-created tags in the field available, and your designs are tagged.

https://inedit.freshdesk.com/en/support/solutions/articles/14000139356-application-modules


Change Tag is an option that allows users to replace a tag in multiple designs at once. By selecting a tag from the
list, users can select it, and the new version will automatically replace the old one across all designs that use it.

Tagging During Design Import
Another method for tagging designs is during the import process. The integration with Clarifai enables users to tag
images directly within the import dialog, ensuring proper organization from the outset. Once the image is uploaded
and ready for import, click the loading icon next to the Tags field to automatically assign relevant tags.

NOTE: Be sure that the "Tags" custom field is included in the Upload dialog.

https://inedit.freshdesk.com/en/support/solutions/articles/14000139742


Previous version

neoCatalog version 3.16.7 or before:

1. Create a new application and use the API key with the required data: App name, Language, and Base Workflow
has to be Gen eral: 

2. The second step is to go to neoCatalog Preferences > Modules , enable the 'Tags' module, and click 'Save'. Back
in neoCatalog Categorization, configure the part of Tags with required configuration API key data, save and restart
the application. When is restarted you will be able to use and search with tags.

https://inedit.freshdesk.com/en/support/solutions/articles/14000139356-application-modules


Related articles:

How to setup the search for similar images

Setup of categorization options

Design search and navigation

Setup of Watermarks in Previews and Files

Applies your company logo as a watermark in the design view and output according to the user privileges . The
preview in preview modes will use the watermark.

https://inedit.freshdesk.com/en/support/solutions/articles/14000141954
https://inedit.freshdesk.com/en/support/solutions/articles/14000139303
https://inedit.freshdesk.com/en/support/solutions/articles/14000139928-design-searching-and-navigation
https://inedit.freshdesk.com/en/support/solutions/articles/14000139300-user-privileges-management


Create your watermark logo file. Make sure to provide supported file format image JPEG, JPG, TIFF, TIF, or PSD in
color mode RGB.

SCREEN mode: Working with one layer image and keeping the white part in 50% gray or dark, and the

background in 100% black. 



MULTIPLY mode: Multiply mode is used for files with white backgrounds. Working with one layer image and
making one inverted version where the white part is 50% gray or dark , and the background is 100% white.

Once your watermark image is created, simply enable the option 'Enable Watermarks' and load the image logo that
will be applied as a watermark. Make sure to provide a supported file format image. Once an image is selected,
load it to your neoCatalog with 'Send' and save the addition with the 'Save' button.

You can manage who can use and see the watermarks using the user privileges. The privilege manages how the
user will view and export print documents with watermarks as 'Watermarks' in Export and View Options which can
be chosen as 'Not Allowed' or 'Allowed'.

Not Allowed: The user with this privilege will always see and print documents using the watermarks.
Allowed: The user will not view designs with watermarks, but will have an option in the 'Print' dialog to export
the print document with or without watermark.

In both cases, the watermark application in print documents requires print layout modifications to support
watermarks.

https://inedit.freshdesk.com/en/support/solutions/articles/14000139302-how-to-generate-and-send-print-files-from-the-print-option


Related articles:

How to generate and send print files from the Print option

Attachments:

watermark.jpg 
watermark-inverted.jpg 

https://inedit.freshdesk.com/en/support/solutions/articles/14000139302-how-to-generate-and-send-print-files-from-the-print-option
https://inedit.freshdesk.com/helpdesk/attachments/14113276151
https://inedit.freshdesk.com/helpdesk/attachments/14113276152


Setup of categorization options

Use the categorization to organize and find your designs. The categories specified will be available in the design
edition and search dialogs. 

If you work with the neoCatalog Server version, you will be able to work with server advanced 
options. The server version offers more categorization options to label and organizes designs 
and colorways.

TABLE OF CONTENTS

Categorization Fields
Keywords
Collections
Status
Section Name
Trademarks & Sub-trademarks
Finishing Method
Tags

Categorization Fields
In 'Edit Design Info' the data can be added from the list in the corresponding field.

Using the multiple selections in the Edit menu you can label multiple designs with Keywords, Collections,  Auto-Tags
and Statuses.



In Advanced Search, you can search design items using the categories in the corresponding field.

Keywords and Statuses may initially look allowed to be entered with spaces. This is deceiving 
because when neoCatalog is restarted the part of the keyword that was typed after the space 
and the space itself are removed. In the attached picture, "test test" would be shown as 
"test" after restarting neoCatalog. 

Additionally, if a keyword with a space is added this prevents neoCatalog from adding right 
afterward a new keyword made up of the first word of the keyword with the space. In the 
attached picture, "test" would not be added right after entering "test test". If a compound 
keyword is required, the recommended character is underscored (_).

Keywords
Use keywords to label designs to have an easier organization and search. The available default keywords are:

Floral, Ethnic, Abstract, Stripes, Tropical, Camouflage, Nature, Border, Geometric, Animals, Birds, Checks,
Paisleys, Texture, Animal Skins, Tribal, Folkloric .

To create a new one, simply type the name of a keyword and press enter to save it. Use commas as separators to
add multiple keywords. To delete keywords, click on 'x' in the keyword name.



Change Keyword is an option that allows users to update or replace a keyword in multiple designs at once. By
selecting a keyword from the list, users can select it, and the new version will automatically replace the old one
across all designs that use it.

Keyword Groups

The use of keyword groups is to optimize your categorization and search capabilities. The keyword groups can be
created and managed using the Categorization management or Advanced preference settings to create keyword
groups, for example, $FLOWER|Rose|Daisies|Orchids .

Usage:

UI Import : Add keyword groups during the UI import process.
Panel Import : Incorporate keyword groups in your panel import.
Edit Design : Utilize keyword groups while editing your design projects.
Advanced Search : Enhance your search precision with keyword groups in advanced search.
Gallery Keyword Search : Simplify gallery searches using keyword groups.

Collections
Use keywords to organize designs by collection to have an easier organization and search. To create a new one,
simply type a new name for a collection and press enter to save it. Use commas as separators to add multiple
collections. To delete the collection, click on 'x' in the name.



Status
Use status to define the different states of designs. To create a new one, simply type a new name and press enter to
save it. Use a comma as a separator to add multiple, to delete click on 'x' in the name.  You can create and apply a
status color from the same page. You can use the color picker, random gradient colors, or type RGB hex values like
'#FFFFFF' or CSS names like 'blue'.

Change Status is an option that allows users to update or replace a status in multiple designs at once. By selecting
a status from the list, users can select it, and the new version will automatically replace the old one across all designs
that use it.

Once the status is categorized in designs, then the thumbnail's circle with the corresponding status colors is shown.
The status name is shown in a tooltip when moving over the circle.

Section Name
Extra module feature to work with another design section area, that must be enabled in the application modules . To
create a new one, simply type a new name and press enter to save it.  Deleting sections can be done from the
"Remove Section" below the Section name field. When deleting sections that contain designs, then the designs will
be moved back to the designs view.

https://inedit.freshdesk.com/en/support/solutions/articles/14000139357-another-file-section-in-neocatalog
https://inedit.freshdesk.com/en/support/solutions/articles/14000139356-application-modules


Previous version

In version 3.16.8 and lower, deleting sections is restricted, and can be done from admin in advanced preferences as
long as the sections contain designs. First, remove the designs from the section you want to delete or move the
designs to another available section. Deleting all sections is restricted and requires one section to exist.

Trademarks & Sub-trademarks
Use marks to define brands and sub-brands for designs. To create a new one, simply type a new name and press
enter to save it. Use a comma as a separator to add multiple, to delete click on 'x' in the name.

Finishing Method
Different methods of superposition methods for coloring that alter can be applied to the design information. To
create a new one, simply type a new name and press enter to save it. Use a comma as a separator to add multiple,
to delete click on 'x' in the name.

Tags



Tags are label words that you can add to the design making them easier to group and find. For example, you could
add the blue tag to all designs related to blueish colorways. That would allow you to easily see, display, and search
for related designs. Enable tags in modules to start working with tags in Clarifai Management.

There are two ways to work with tags:

The manual option will label your designs with tags that allow you to search and identify the design. To create
a new one, simply type a new name and press enter to save it. Use a comma as a separator to add multiple, to
delete click on 'x' in the name.

The automated tagging option using Clarifai AI will index your designs and detect if similar designs in your
neoCatalog exist. It allows you to search images with two options: How to tag designs with Clarifai AI

Related articles:

How to tag designs with Clarifai AI

Another File Section in neoCatalog

Design search and navigation

12. Admin Guide for Server Version

Access neoCatalog from external network (Internet
Access)

ISP and DNS
1 - Hire a static IP address with your ISP
Your external IP address is not something you can change, it is given to you automatically by your Internet provider. In
order to configure our server to have access to the Internet we will need to have a static external IP address, so the
first step that we will need to do before starting the router configuration is to contact your ISP (Internet Server
Provider) and hire a static IP address, this is usually monthly paid service.

2 - Get a domain name
The second step is optional but recommended. With a static external IP address, you will be able to access your site
from the internet, but you will need to write a sequence of numbers in a web browser. If you want to access using a
name instead an IP you will need to get a domain name using one of the numerous domain name registers that you
can find online, such as GoDaddy , 1&1 Internet , Dotster.com ...

Domain names serve to identify Internet resources, such as computers, networks, and services, with a text-based
label that is easier to memorize than the numerical addresses used in Internet protocols.

Router
1 - DHCP (Dynamic Host Configuration Protocol)

https://inedit.freshdesk.com/en/support/solutions/articles/14000139356-application-modules
https://inedit.freshdesk.com/en/support/solutions/articles/14000141948
https://inedit.freshdesk.com/en/support/solutions/articles/14000141948
https://www.clarifai.com/search
https://inedit.freshdesk.com/en/support/solutions/articles/14000141948
https://inedit.freshdesk.com/en/support/solutions/articles/14000141948
https://inedit.freshdesk.com/en/support/solutions/articles/14000139357-another-file-section-in-neocatalog
https://inedit.freshdesk.com/en/support/solutions/articles/14000139928-design-searching-and-navigation
http://www.anrdoezrs.net/4q65lnwtnvAGEBFKEACBEJJEGJ
http://www.tkqlhce.com/tg97vpyvpxCIGDHMGCEDLMJLKFCEHKGJLMGHMDDD
http://www.jdoqocy.com/rm72shqnhp4A859E84A69CEB


Reserve an IP address for your server in the DHCP service. What this will do is ensure that your server is always at
the same IP address on your internal network, even after a restart of the server or router.

Step-by-Step

1. Go to your router configuration by typing your router's IP in your web browser navigation bar. This IP is usually
192.168.0.1 but you can check yours by typing ipconfig in the command prompt or in Mac by typing netstat -nr | grep
default in Terminal or going to System Preferences > Network.

2. Find the DHCP setting. It can be named "DCHP Reservation", or "Address Reservation"...

3. Find the MAC address of the computer which you want to add to the reservation list. You can find the MAC
address by using ipconfig in the Windows command prompt or going to Preferences > Network on macOS and
going to Advanced. Remember that the Mac address will be different between WiFi and Ethernet adaptors and they
cannot have the same IP reserved so you will need to choose a preferred one.



4. Write the adaptor MAC address into the DHCP address reservation and write the IP that you want to be fixed.
Apply the changes.

2 - Setup port forwarding
The second step is setup the port forwarding to the previously reserved server IP address. This will allow us to
redirect a communication request from one address and port number combination (external) to another (internal)
through a network gateway such as a router or firewall.

To setup a port forwarding:

1. Again you need to access the router configuration, as earlier described you need to find your router IP and type
it in your browser.

2. Each router interface is different, finding the "port forwarding" section should not be difficult, but you can check
your router manual to find this section.

3. Once in the port forwarding section, you will need to add a new custom entry, again each router will have
different fields to fill, but the required information is very similar between models:

Name →  Informative field to describe the service.
Type → TCP, UDP, or Both.
Inbound or Start→ First port number.
Private or End → Second port number (to open a single port type the same port as in the previous field,
but if you want to open a range type the last port in the range).

4. Finally, you will need to introduce your server IP address that we already made static in the DHCP step and
save the changes.

The common ports that we would need are 80 for HTTP and 443 for HTTPS connections.

Related articles:

Enable HTTPS for neoCatalog Server

Configuration Wizard for neoCatalog setup

neoCatalog gives you the possibility to create your own neoCatalog with facilities to use your own files and data. The

https://inedit.freshdesk.com/en/support/solutions/articles/14000139884-enable-https-for-neocatalog-server


Configuration Wizard is a part of the installation for your neoCatalog that requires the Wizard for configuration
purposes. Furthermore, you can also use Configuration Wizard to activate the program and create the first
administration user.

Once the application is installed, type http://localhost/cgi-bin/WebObjects/neoCatalogWeb.woa/wa/configWizard and
run the page. It should start the welcome page of Configuration Wizard. Complete the wizard until the end.

Welcome

The first step of the configuration Wizard is the Welcome window. Click on Next to start the configuration.



License Agreement

The second step of the Wizard is to read and agree with the end user license agreement. Check the box to agree
with the license and click on Next to continue.

Database

NOTE : This section is enabled for neoCatalog Server installations only.

This page manages and allows connecting the already existing neoCatalog Database as a part of server migration.
Select the option " Connect to an existing database " and keep the pre-defined data in the fields.



Data Location

NOTE : This section is enabled for neoCatalog Server installations only.

This page manages and allows connecting the already existing neoCatalog folders as a part of server migration.
Keep the pre-defined folder path if not differently defined.



Administration User

This page manages the first neoCatalog user, which is the Administrator of the application. Fill out the required field
for the administration. Click on Next to continue. If you wish to allow receiving neoCatalog system notifications, bear
in mind to enter the email.



Summary

You have reached the last step of the configuration. If you want to download and use sample designs in your
neoCatalog provided by Inèdit, check the given option 'Add sample designs'.

Finalize

Click on 'Apply Changes and Continue' to start the application on the default host and port, and to complete the
configuration.

For the Desktop version:

The new neoCatalog database and files repository will be created and installed in:

macOS: /Users/<USER>/Documents/neoCatalogs/<YOURCATALOG>/
Windows: C:\Users\<USER>\Documents\neoCatalogs\<YOURCATALOG>\

For the Server version :

The new neoCatalog files repository will be created and installed in:

macOS: Volumes/Library/WebServer/Documents/neoCatalog
Windows: C:\Library\WebServer\Documents\neoCatalog



neoCatalog will start the launch process of the newly created neoCatalog. This can take one minute. After
neoCatalog restarts, it is ready to log in with the administrator username and password in the login window of the
application. Proceed to activate neoCatalog.

TIP : In case you won't reach the login page, please restart the instance manually .

Related articles:

Start neoCatalog Server application instances from JavaMonitor

Start a new login session in neoCatalog

Request a trial license and get registered

Download application logs in neoCatalog Server

When working in neoCatalog Server that is installed in server environments, we have the possibility to download the
logs from Administration in System Info with the button Download logs at the bottom. It will download a ZIP file
containing the all logs before the last started application run. 

https://inedit.freshdesk.com/en/support/solutions/articles/14000101460-request-a-trial-license-and-get-registered
https://inedit.freshdesk.com/en/support/solutions/articles/14000139295-start-neocatalog-server-application-instances-from-javamonitor
https://inedit.freshdesk.com/en/support/solutions/articles/14000139295-start-neocatalog-server-application-instances-from-javamonitor
https://inedit.freshdesk.com/en/support/solutions/articles/14000139277-start-new-login-session-in-neocatalog
https://inedit.freshdesk.com/en/support/solutions/articles/14000101460-request-a-trial-license-and-get-registered


NOTE : Be aware that the ZIP file can have high file size (more than 1GB) that can cause a temporary out of
memory error in neoCatalog for the logged-in user while downloading the logs. In this case it is required to
connect to the server to take the logs.

Related articles:

Where I can find the console logs of desktop neoCatalog

System Info of neoCatalog

Enable HTTPS for neoCatalog Server

This document is a step-by-step guide for configuring SSL (Secure Sockets Layer) on an Apache web server,
enabling the server to securely serve websites over HTTPS.

TABLE OF CONTENT

1 - Load mod_ssl
2 - Include httpd-ssl.conf File
3 - Add VirtualHost to httpd-ssl.conf

https://inedit.freshdesk.com/en/support/solutions/articles/14000140925-where-i-can-find-the-console-logs-of-desktop-neocatalog
https://inedit.freshdesk.com/en/support/solutions/articles/14000139740-system-info-of-neocatalog


Declare VirtualHost
General Virtual Host Settings
Enable SSL
Convert .pfx to .crt and .key
Specify certificate and private key

4 - Test Configuration and restart Apache
SSL Configuration for Windows Server Deployment

1 - Load mod_ssl
First, simply uncomment the following line in the httpd.conf file. To modify the httpd.conf file we will use the Nano text
editor.

httpd.conf file is usually located at: /etc/apache2/httpd.conf. It's recommended to make a copy of httpd.conf file just
in case we brake something.

mod_ssl

$ cd /etc/apache2/
$ sudo cp httpd.conf httpd.conf.old
$ sudo nano httpd.conf

Find the following line and uncomment it. Just in case you are not sure, comments have a leading pound/hash symbol
( # ) – just remove it.

2 - Include httpd-ssl.conf File
While we still have the httpd.conf file open, we also need to uncomment the line that includes the httpd-ssl.conf file.



3 - Add VirtualHost to httpd-ssl.conf
The last step is to configure a new virtual host that is bound to port 443 (HTTPS). There is already a sample
<VirtualHost> record in the httpd-ssl.conf file. I suggest you first remove it or comment it all out so that you can just
paste in the necessary code at the bottom of the file.

httpd-ssl.conf file is usually located at: /etc/apache2/conf/httpd-ssl.conf

You will need to open the file using Nano (you can create a copy first for security reasons):

Add VirtualHost

$ cd /etc/apache2/extra
$ sudo cp httpd-ssl.conf httpd-ssl.conf.old
$ sudo nano httpd-ssl.conf

Declare VirtualHost

The first step is to declare a new virtual host using the <VirtualHost> directive .

VirtualHost

<VirtualHost *:443>

General Virtual Host Settings

Next, within the <VirtualHost> directive, we will declare some basic host settings:

DocumentRoot : absolute path to the webroot for the site
ServerName : the fully qualified domain name (FQDN)
ErrorLog : location of the error log
CustomLog : location of the access log

Enable SSL

To enable the SSL engine in Apache we simply add set the setting to “on”.

Enable SSL

http://httpd.apache.org/docs/2.2/mod/core.html#virtualhost


#SSL Engine Switch
SSLEngine on

Convert .pfx to .crt and .key

A .pfx (Personal Information Exchange Format) is a file that enables the transfer of certificates and their private keys,
it contains the public key file (SSL certificate file) .crt and the associated private key file .key.

In order to configure our Virtual Host, if we have a pfx file we will need to treat the private key and the certificate.

To extract the certificate:

.crt

$ openssl pkcs12 -in [yourfile.pfx] -clcerts -nokeys -out [certificate.crt] -legacy

To extract the key:

.key

$ openssl pkcs12 -in [yourfile.pfx] -nocerts -out [keyfile-encrypted.key] -legacy

Sometimes it's needed to have an unencrypted .key file to import on some devices.  I probably don’t need to mention
that you should be careful. If you store your unencrypted keypair somewhere in an unsafe location anyone can have a
go with it and impersonate for instance a website or a person in your company. So always be extra careful when it
comes to private keys!

.key

openssl rsa -in [keyfile-encrypted.key] -out [keyfile-decrypted.key] -legacy

Related information:
https://www.ibm.com/docs/en/arl/9.7?topic=certification-extracting-certificate-keys-from-pfx-
file

Specify certificate and private key

Using the paths as I described at the beginning, we will tell the SSL engine the location of the certificate request file
(CSR) and the private host key (.key).

#Server Certificate:
SSLCertificateFile "/private/etc/apache2/ssl/certificate.crt"
#Server Private Key:
SSLCertificateKeyFile "/private/etc/apache2/ssl/keyfile-decrypted.key

4 - Test Configuration and restart Apache
$ sudo apachectl -t
$ sudo apachectl restart

https://www.ibm.com/docs/en/arl/9.7?topic=certification-extracting-certificate-keys-from-pfx-file


All done. You are now serving your website over HTTPS using Apache.

Related information: 
https://blackdiezone.net/2019/09/como-convertir-un-pfx-a-un-archivo-separado-key-crt/

SSL Configuration for Windows Server Deployment
If your Windows server requires an SSL certificate but you don’t have the necessary tools installed, macOS can be
used to generate and process SSL certificates since it comes with OpenSSL preinstalled.

Related articles:

How to install/update SSL certificate on the server where neoCatalog is hosted

Access neoCatalog from an external network (Internet Access)

Generating a CSR and Updating the SSL Certificate
on neoCatalog Windows

1. CSR and Private Key Generation
The generation of the .key file (private key) must be performed on your server, specifically the neoCatalog server.
This process creates both the Certificate Signing Request (CSR) and the private key, which is required by GoDaddy
to issue the SSL certificate.

Step-by-Step Instructions

1. Connect to the neoCatalog server via terminal.

2. Run the following OpenSSL command to generate the CSR and private key:

openssl req -newkey rsa:2048 -keyout PRIVATEKEY.key -out MYCSR.csr

3. Enter the required organization information when prompted:

Country Name (2 letter code)

State or Province Name

Locality Name (City)

Organization Name

Organizational Unit Name

Common Name: Use neocatalogo.lastamperiasa.co

Email Address

4. After execution, you will have two files:

file:///C:/www/qa_waitress_server/static/apps/freshdesk_solutions_exports/freshdesk_solutions/freshdesk_articles_category_manual_en_html/ttps%253A//blackdiezone.net/2019/09/como-convertir-un-pfx-a-un-archivo-separado-key-crt/
https://blackdiezone.net/2019/09/como-convertir-un-pfx-a-un-archivo-separado-key-crt/
https://blackdiezone.net/2019/09/como-convertir-un-pfx-a-un-archivo-separado-key-crt/
https://inedit.freshdesk.com/en/support/solutions/articles/14000148792
https://inedit.freshdesk.com/en/support/solutions/articles/14000139887-access-neocatalog-from-external-network-internet-access-


PRIVATEKEY.key : Your private key file

MYCSR.csr : The certificate signing request

5. Send the MYCSR.csr file to GoDaddy to generate your SSL certificate.

For reference, you can follow this guide:

https://www.ssl.com/how-to/manually-generate-a-certificate-signing-request-csr-using-openssl/

2. SSL Certificate Installation
Once you receive the new certificate files from GoDaddy:

Step-by-Step Installation (Apache Example)

1. Go to the Apache SSL configuration directory (usually under Apache24/conf/ssl or similar).

2. Check for currently used certificate files, such as:

wc.inedit.es.pem

wc.inedit.es .key

3. Backup the existing files by renaming them with the past year (e.g., wc.inedit.es_2024.pem ).

4. Copy and paste the new certificate files (the .crt and updated .key files) into the directory.

5. Update Apache configuration, if necessary, to point to the new certificate file names.

6. Restart the Apache service to apply the changes: httpd -k restart

Graceful Scheduling in JavaMonitor: ON or OFF

Graceful Scheduling involves managing tasks or processes in a manner that permits the application to finish its
ongoing work before termination or interruption. In Java, for instance, employing mechanisms such as shutdown
hooks or other graceful shutdown techniques enables the application to conclude its current tasks before shutting
down.

However, it's important to note a potential drawback:

Graceful scheduling may impact the restart of the application service because of ongoing tasks, leading to a
significant delay in memory release until the application triggers one error (e.g., Proxy error). To avoid this issue, we
strongly recommend disabling this option (OFF).

https://www.ssl.com/how-to/manually-generate-a-certificate-signing-request-csr-using-openssl/


Related articles:

Start neoCatalog Server application instances from JavaMonitor

https://inedit.freshdesk.com/en/support/solutions/articles/14000139295


How to Clean Up Folders on neoCatalog Server

Cleaning up neoCatalog folders and files on the neoCatalog server can help free up space and improve
performance. By sorting files by size and deleting unnecessary files, you can quickly reclaim valuable space on your
hard drive.

TABLE OF CONTENTS
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How to Clean Up Folders on Windows

Type of Files

Here are listed the files that can be removed.

Application files:

\Library\WebObjects\Logs\
\Library\WebServer\Documents\neoCatalog\Logs\Archive\

Document files:

\Library\WebServer\Documents\neoCatalog\Static\
\Library\WebServer\Documents\neoCatalog\Error\
\Library\WebServer\Documents\neoCatalog\QuickPrint\ 

Do not remove the folder "Layouts" inside the "QuickPrint" folder! Handle with care!

Whether you are using a Mac or Windows operating system, these steps can help you clean up your folders and gain
space.

How to Clean Up Folders on macOS

1. Open Finder by clicking on the Finder icon in the Dock or by pressing Command + Space and typing "Finder"
in Spotlight.

2. Navigate to the folder you want to clean up.
3. Click on the "View" menu and select "Show View Options." In the View Options window, select "Sort By" and

choose "Size" to sort files by size. This will make it easier to identify large files that you no longer need.
4. Identify any large files that you no longer need and delete them by dragging them to the Trash.
5. Once you have deleted the files you no longer need, empty the Trash by right-clicking on the Trash icon in the

Dock and selecting "Empty Trash."



How to Clean Up Folders on Windows

1. Open File Explorer by clicking on the File Explorer icon in the Taskbar or by pressing the Windows key + E.
2. Navigate to the folder you want to clean up.
3. Click on the "View" tab in the File Explorer window and select "Details." Then, click on the "Size" column to

sort files by size. This will make it easier to identify large files that you no longer need.
4. Identify any large files that you no longer need and delete them by selecting them and pressing the Delete key

or by right-clicking and selecting "Delete."
5. Once you have deleted the files you no longer need, empty the Recycle Bin by right-clicking on the Recycle Bin

icon on the Desktop and selecting "Empty Recycle Bin."

Related articles:

How to schedule Database backup in Administration

How to extend the session login time

The default session timeout for a WebObjects application is 3600 seconds (1 hour) . You can extend this
timeout to a maximum of 28800 seconds (8 hours) using the -WOSessionTimeOut argument in JavaMonitor.

How to Set -WOSessionTimeOut in JavaMonitor

1. Open JavaMonitor in your browser (typically: http://localhost:56789 ).

2. Navigate to your Application .

3. Click Configure on the desired instance or application settings.

4. Locate the field labeled Additional Arguments .

5. Add or update the argument:

-WOSessionTimeOut=10800

(This sets the session timeout to 3 hours. Adjust as needed, up to a maximum of 28800 seconds.)

6. Save the changes and restart the application instance for the new timeout to take effect.

Example:

If you want to maintain the default timeout:

-WOSessionTimeOut=3600

To extend it to 8 hours:

-WOSessionTimeOut=28800

https://inedit.freshdesk.com/en/support/solutions/articles/14000142327


How to install/update SSL certificate on the server
where neoCatalog is hosted

Please ensure the SSL certification is requested in the formats .crt and .key/.pfx (two separate files) or .pem (a
single file) from providers such as https://www.godaddy.com/es or a similar service. The files that were obtained
need to be sent to Inedit for the installation of the SSL certificate on the Apache host.

For additional details and instructions on enabling HTTPS for the neoCatalog Server, please refer to the following
link: https://inedit.freshdesk.com/en/support/solutions/articles/14000139884-enable-https-for-neocatalog-server

How to perform a manual Apache update on
Windows

Updating Apache on Windows manually involves downloading the latest version, stopping the current Apache
service, replacing the old files with new ones, and restarting the service. Follow the steps below to complete the
process.

Please note: During the Apache update, neoCatalog will be temporarily unavailable.

https://www.godaddy.com/es
https://inedit.freshdesk.com/en/support/solutions/articles/14000139884-enable-https-for-neocatalog-server


Step-by-Step
1. Backup Your Current Apache Configuration

1. Locate the Apache Installation Directory: Apache is typically installed in C:\Apache24 .
2. Rename the Apache Folder: Rename the Apache24 folder to something like Apache24.old or

Apache24_2.4.42 .
3. Backup the Folder: Ensure the renamed folder is securely backed up.

2. Download the Latest Version of Apache

Visit Apache Lounge: Go to the Apache Lounge website and download the latest version of Apache for
Windows.
Select the Correct Version: Make sure to download the version that matches your system architecture (32-bit
or 64-bit).

3. Stop the Apache Service

1. Press Win + R , type services.msc , and press Enter.
2. In the Services window, locate the Apache service, typically named "Apache HTTP Server" with a description

that includes the Apache version.
3. Right-click on the service and select Stop .

4. Replace Old Apache Files

1. Unzip the Downloaded Package: Extract the contents of the downloaded Apache package (e.g., httpd-
2.4.62-240718-win64-VS17 ) to a temporary location.

2. Copy the Apache24 Folder: Copy the Apache24 folder from the extracted files.
3. Paste to the Installation Directory: Navigate to the Apache installation directory (e.g., C:\Apache24 ) and paste

the folder there.

https://www.apachelounge.com/download/


5. Merge Configuration Files

1. Access the Renamed Folder: Go to the previously renamed Apache24.old folder.
2. Move Configuration and htdocs Folders: Select the conf and htdocs folders and move them into the newly

copied Apache24 folder. Do not overwrite the folder links for and inside
htdocs ; these must remain intact.

6. Start the Apache Service

1. Return to Services Panel: Go back to services.msc .
2. Start the Apache Service: Right-click on the Apache service and select Start . Once started, the service

description should reflect the new version of Apache.



7. Verify the Update

1. Check Apache is Running: Open a web browser and navigate to https://yourneocatalogurl/cgi-
bin/WebObjects/neoCatalogWeb.woa/ to confirm that Apache is running properly.

2. Verify in neoCatalog: Log in to neoCatalog and ensure that thumbnails and other functionalities are working
correctly.

8. Clean Up

Delete Backup Directories: If everything is functioning correctly, you can safely delete the backup directories
created during the process.

How to schedule Database backup in Administration

It is important to make regular backups of your data in case of accidental data loss or corruption. neoCatalog
administration offers the option to back up the application database. The backup is the process of creating a copy
(backing up) of the active database with the option to schedule the backup execution. In this article, we will provide
step-by-step instructions on how to make a backup in neoCatalog.
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Step 1: Navigate to the Backup Option

To start, log in to neoCatalog and enter Administration > Management. From there, select “Backup” to access the
backup options.

Step 2: Activate the backup process

This option is enabled automatically after installation.

Step 3: Choose the Backup Destination

The backup path by default is /Library/WebServer/Documents/neoCatalog/DatabaseBackups, but you can choose a
custom path. This can be an external hard drive, a network drive, or any other location that you can easily access.
Make sure you select a location that is secure and has enough space to store your backup file.

Step 4: Schedule Regular Backups

To ensure that your data is always protected, it is recommended to schedule regular backups. You can use the built-



in backup scheduler in neoCatalog to schedule backups at specific times or intervals. This will help ensure that your
data is always protected and up-to-date.

Step 5: Verify Backup

After the backup process is complete, it is important to verify that the backup was successful. Navigate to the backup
location and open the backup file to ensure that it contains all the necessary data.

Step 6: Start the Backup Process

Once you have selected the backup options, click on the “Make Backup now” button to begin the backup process.
The software will start creating a backup file of your NeoCatalog data and save it to the location you specified.

Within every modification of settings, press the Save button to apply changes.

Conclusion

Making regular backups of your neoCatalog database is essential for protecting against accidental data loss or
corruption. By following these simple steps, you can create a backup of your data in just a few minutes. Do not forget
to schedule regular backups to ensure that your data is always protected.



Restore backup

The backup in the format SQL is compressed to a ZIP file. To restore the database, you need to import the backup
file in SQL format in the database management application according to their steps (Sequel Pro, HeidiSQL).



Start neoCatalog Server application instances from
JavaMonitor

During the setup process, restarting the neoCatalog service is necessary multiple times to ensure the setup and
configuration changes take effect. There are two available methods for restarting the neoCatalog service:

(A) Automated Restart via JavaMonitor: This can be performed remotely through a web browser. Utilize
JavaMonitor to initiate the automated restart.

(B) Manual Restart from the Terminal on the Server: Access the server's terminal to manually restart the
neoCatalog service.

If the neoCatalog service stops, you will observe a "Service Unavailable" message in your web browser. In such
cases, it's essential to follow one of the restarting options to restore service functionality.
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(A) Restart neoCatalog Service from JavaMonitor
In order to (re)start neoCatalog, please follow the steps:

1. Go to the web browser and enter http://localhost:56789 . This path will open the WOMonitor in JavaMonitor, where
you can see the installed instances. Click on 'View Details' on the instance that you want to (re)start. 

http://localhost:56789/


2. Next you will see the detailed instance of neoCatalog. 



3. To quit the instance, in case of restarting neoCatalog, press 'Configure' and push 'Force Quit This Instance' (down
the page). 

 
4. Now the application is stopped. To go back to the application details and see the running status, you will need to
push Details View (up the page):

 

5. If the quitting instance was successful, the status will be OFF. To start the instance, push the green button in the
column Start-Stop, which will restart the instance. The page automatically updates every 60 seconds. To speed up



the Status push Refresh Now. If quitting the instance failed here, please restart neoCatalog via terminal, option B.

6. When the instance is restarted the status will be ON and green. Go to http://localhost/ . neoCatalog is ready to use.

(B) Manual restart from Terminal
If the instance does not restart from JavaMonitor, please follow the steps.

1. Open the terminal command on the neoCatalog server, type cd /Library/LaunchDaemons/ and confirm by
pressing enter.

2. After you enter LaunchDaemons, start typing the commands to quit and restart the neoCatalog Service. These
commands must run with and confirm by pressing enter. You are required to enter the system user
password:

sudo launchctl unload org.projectwonder.womonitor.plist 
sudo launchctl unload org.projectwonder.wotaskd.plist 
sudo launchctl load org.projectwonder.womonitor.plist 
sudo launchctl load org.projectwonder.wotaskd.plist 
sudo apachectl restart

3. You can go to http://localhost/ and refresh the browser. After a few seconds, the application will start and
neoCatalog is ready to use.

Troubleshooting: Cannot Stop/Start neoCatalog Service

(A) Restart JavaMOnitor

If the neoCatalog service does not stop or start following the initial troubleshooting steps (Option A and B), follow
these additional steps:

http://localhost/
http://localhost/


1. Attempt to access the instance service http://localhost:2002 (the port of the distance can differ).

2a. For macOS :

If no service is running, open the Activity Monitor.
Search for 'Java' and force quit all instances.

2b. For Windows :

Open the Task Manager.
Restart the JavaMonitor service from the Services tab.

http://localhost:2002


3. Return to http://localhost:56789 and attempt to start the instance.

4. If the issue persists:

1. Check the last log.
For Windows: Navigate to C:\Library\WebObjects\Logs.
For macOS: Navigate to /Library/WebObjects/Logs.

2. Look for the following error: ` er.extensions.migration.ERXMigrationFailedException: Migration failed. `

(B) Restart Apache Service

Special cases may arise where instances don't start despite being in the ON state due to ongoing usage. Follow
these steps to restart the applications as needed:

1. Open the Services and stop the Apache service.
2. Navigate to Task Manager > Details and terminate all java.exe processes, excluding those consuming low

memory (less than 200KB).
3. Return to Services and start the Apache service.
4. Proceed to start the launcher.

Please note that simply restarting the server will not resolve this issue since users might be attempting to access the
application before it fully starts, causing a blockage. Hence, stopping and restarting the Apache service is necessary
in this scenario.

Related articles:

Configuration Wizard for neoCatalog setup

Graceful Scheduling in JavaMonitor: ON or OFF

neoCatalog Server version installation in Windows
Server

http://localhost:56789
https://inedit.freshdesk.com/en/support/solutions/articles/14000139297-configuration-wizard-for-neocatalog-setup
https://inedit.freshdesk.com/en/support/solutions/articles/14000147963


Requirements
Before starting the installation, make sure that the Windows Server does not contain a previously installed
neoCatalog Server version. You can verify in Task Manager if specific services are present in Task Manager:

ApacheHTTPServer
JavaMonitor
MySQL

WOTaskd 

NOTE: neoCatalog Standalone installation will not affect server version installation, because 
the app, database and directory is completely different than the server version.
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Start Installation
The installation of the application has to be done with the .exe installer for the server version. Currently, the installer is
not available on the web or for public access. Ask the development team to provide you with the .exe file.

Step-by-Step



1. Double-click on the .exe installer to start installation: 

2. Continue with "Install": 

3. Wait until the installation is completed:



 

Verify Installation
1. Once the installation is finished, open "Task Manager" and verify that all required services are running:

ApacheHTTPServer
JavaMonitor
MySQL
WOTaskd





2. Open the web browser and type http://localhost:56789 . It will open JavaMonitor. You should see one application
instance neoCatalogWeb running.

http://localhost:56789


Create admin user
1. In the web browser type http://localhost .  You should see the login page of neoCatalog. By default, there is no user
and password created. Now you need to create the admin user. Type http://localhost/cgi-
bin/WebObjects/neoCatalogWeb.woa/wa/configWizard and run the page. It should start the welcome page of
Configuration Wizard . Complete the wizard until the end.

http://localhost
http://localhost/cgi-bin/WebObjects/neoCatalogWeb.woa/wa/configWizard
https://inedit.freshdesk.com/en/support/solutions/articles/14000139297-configuration-wizard-for-neocatalog-setup


2. Go to http://localhost:56789 and restart the application instance . 

http://localhost:56789
https://inedit.freshdesk.com/en/support/solutions/articles/14000139295


3. If your admin user creation is successful, then you will be able to log in with the newly created user and password
after the activation is active. If you have trouble reaching the login, check this troubleshooting .

https://inedit.freshdesk.com/en/support/solutions/articles/14000101460-request-a-trial-license-and-get-registered
https://inedit.freshdesk.com/en/support/solutions/articles/14000140938-neocatalog-does-not-start-after-installation-in-windows


Related articles:

neoCatalog does not start after installation in Windows

Request a trial license and get registered

How to apply for XDAT (offline) application license activation

Configuration Wizard for neoCatalog setup

https://inedit.freshdesk.com/en/support/solutions/articles/14000140938-neocatalog-does-not-start-after-installation-in-windows
https://inedit.freshdesk.com/en/support/solutions/articles/14000101460-request-a-trial-license-and-get-registered
https://inedit.freshdesk.com/en/support/solutions/articles/14000130554-how-to-apply-xdat-offline-application-license-activation
https://inedit.freshdesk.com/en/support/solutions/articles/14000139297-configuration-wizard-for-neocatalog-setup


neoCatalog does not start after installation in
Windows

Problem
After the neoCatalog Server windows installation and completing the completed the Configuration Wizard setup with
the URL http://localhost/cgi-bin/WebObjects/neoCatalogWeb.woa/wa/configWizard , then opening http://localhost/ I
see one Proxy error instead the login page.

Solution
Most probably the properties file is not fully created and became corrupted. Follow the steps below:

1. Go to C:\Library\WebObjects\Applications and rename the file neoCatalogWeb.properties to a different file name
or remove it from the folder.

2. Restart all services:

ApacheHTTPServer
JavaMonitor
MySQL
WOTaskd

3. Open one web browser and call http://localhost/ . You should be on the login page to log in with the user you have
created in the Configuration Wizard.

Related articles:

neoCatalog Server version installation in Windows Server

Configuration Wizard for neoCatalog Setup

Start a new login session in neoCatalog

http://localhost/cgi-bin/WebObjects/neoCatalogWeb.woa/wa/configWizard
http://localhost/,
http://localhost/
https://inedit.freshdesk.com/en/support/solutions/articles/14000133430-neocatalog-server-version-installation-in-windows-server
https://inedit.freshdesk.com/en/support/solutions/articles/14000139297-configuration-wizard-for-neocatalog-setup
https://inedit.freshdesk.com/en/support/solutions/articles/14000139277-start-new-login-session-in-neocatalog


neoCatalog in external storage connection

This guide provides detailed instructions for connecting an external storage device to your system, setting up the
network drive, configuring the neoCatalog folder to use the volume for both MacOS and Windows and setting up
folder locations.
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Installation and Configuration
1) Hardware Installation
You may check the NAS manufacturer user guide to install the device. This process may include the following steps:

Install the Hard Drives.
Connecting to Network/Power.
Operating System/Firmware Configuration.

2) Connecting the Network Drive and automatic mounting
MacOS

1. In OSX Finder/Navigator on the top Menu click on "Go" → "Connect to Server..." or use the key combination
"⌘+K". 

2. Connect to the server using the correct protocol (smb, afp...).

3. Choose Guest or for a specific user check the box next to “Remember this password in my keychain” – you
must select to remember the password otherwise the automatic login event can not happen without logging into
the network drive. 



4. Go to System Preferences → Users & Groups. 

5. Select your user name from the list and then click the “Login Items” tab. 

6. Drag & drop a mounted network drive into the login items list. 

7. Optional: check the “Hide” box to keep the drive window from opening on each login and boot.

Windows

We have used Windows 10 as an example.

1. Go to "Computer" –> "Map Network Drive". 
2. Specify the drive letter and the network location of the Drive. 

3. Select "Reconnect at sign-in" to connect the drive each time the system starts. Click Finish.

4. Enter the credentials to connect to the drive. Check "Remember my credentials".

5. Once you have set that up, click “Finish” and the network drive will be mapped on your device.



 

6. In the Folder box, type the path of the folder or computer, or select Browse to find the folder or computer.

Set folder location
To change the folder location we need to create a link in the original folder pointing to the new destination:

1) Create a folder in the destination drive
This is the folder where neoCatalog files will be stored after the location change.

2) Locate the original neoCatalog folder
M a c O S : The original folder in MacOS is located in
/Users/<userName>/Documents/neoCatalogs/<neoCatalogName>
Windows : The original folder in Windows is located in C:\Users\<userName>\Documents\neoCatalogs\
<neoCatalogName>

3) File transfer
MacOS

If the neoCatalog folder we are moving is not new and already contains files, we might want to copy these original
files to the new destination. The command rsync -avP in a terminal initiates a file synchronization or file transfer
process using rsync with specific options enabled. The basic command to synchronize two folders that can be on the
same disk, on different disks, or even on two connected computers is:

rsync -avP /Path-to-source-folder/ /Path-to-destination-folder

Note that the source folder ends with a / but the destination folder does not.

Step-by-Step

1. Create new folders on the destination (e.g., Photos, Design)



2. Start sync simulation: Run the command to simulate the transfer:

The command rsync -avP --dry-run is used in a terminal to perform a "dry run" of the rsync command. This means
it will simulate the file transfer process without actually copying any files, allowing you to see what changes would be
made without making any actual changes.

3. Start Sync: Run the following command to begin synchronization:

rsync -avP /Path-to-source-folder/ /Path-to-destination-folder/

You can abort the sync at any time by pressing Control + C. To resume the sync, simply rerun the command until completed.



4. Create a Link Between the Two Folders:

Navigate to the neoCatalog folder: 



Create the symbolic link: 

Windows

Copy the files from the old folder to the new destination

The optional process to get the files to the destination is copy-paste. To do this, copy all directories from the original
neoCatalog folder and place them inside the folder created in the first step.

4) Create a Link Between the Two Folders
MacOS

Open the Terminal application and type the following:

Navigate to the neoCatalog folder: 
Create the symbolic link: 



Windows

Open the Command Prompt as Administrator (right click → Run as Administrator) and type:

mklink /D <networkDriveName>/<newCreatedFolder>  <newCreatedFolder>

For example:

mklink /D neoCatalog  E:\neoCatalog

Symlink folders in Windows

neoCatalog folder to the network folder.

For example:

New-Item -ItemType SymbolicLink -Path “Link” -Target “Target”

Watch Video: https://player.vimeo.com/video/893361442?share=copy

5) Switch to new destination
1. Before renaming the folders, run rsync again to ensure all files are up to date.
2. Rename Folders:

1. Rename the local storage folder to . o ld : 

2. Rename the link folder to the original folder name: 

3. Verify neoCatalog: Log in to neoCatalog and verify that you can view, import, and download files.

https://player.vimeo.com/video/893361442?share=copy


Related articles:

Access neoCatalog from an external network (Internet Access)

13. Troubleshooting for Server Version

Error in Print dialog

Problem
When sending one print job to the Print Server from the Print dialog , then it shows error 401, and the print job is not
sent to the printing queue.

Solution
Print Server Security token mismatch with neoCatalog Print Server management. The connected Print Server uses
one different security token that is not configured in neoCatalog Print server settings.

Go to the Print Server management in neoCatalog administration and paste the copied security token from the Print
Server configuration .

Related articles:

Print Server Configurations and Settings

Configuration of Print Servers in Management

Download attachment with exotic name does not
use the original file name

When files in Attachments have names like 테스트 인쇄 파일 일본어.tif and we try to download one of them, then it
might not be downloaded with its original name. In the following screenshot, a file name in Korean is being changed
by a number.

There is a limitation on browsers at downloading files with exotic characters. It is not 
possible to fix since it is not caused by neoCatalog.

https://inedit.freshdesk.com/en/support/solutions/articles/14000139887
https://inedit.freshdesk.com/en/support/solutions/articles/14000139302
https://inedit.freshdesk.com/en/support/solutions/articles/14000139679
https://inedit.freshdesk.com/en/support/solutions/articles/14000138804
https://inedit.freshdesk.com/en/support/solutions/articles/14000138804
https://inedit.freshdesk.com/en/support/solutions/articles/14000139679
https://inedit.freshdesk.com/en/support/solutions/articles/14000139932


Related articles:

Design Attachments

Download the File and XCM

How to troubleshoot and resolve a "JWT expired at
time" error during login

Problem
The "Remember me" feature in the login process is failing, resulting in a "JWT expired at time" error message. The
expired data cannot be automatically removed from the user's browser, necessitating manual intervention to clear
local storage browser data.

Solution
Follow these steps to clear the expired data and resolve the issue: 

1. Right-click on the login page and select "Inspect" from the context menu.

https://inedit.freshdesk.com/en/support/solutions/articles/14000139932
https://inedit.freshdesk.com/en/support/solutions/articles/14000139691


2. In the developer tools panel that appears, navigate to the "Application" tab. 

3. Under the "Application" tab, look for "Local Storage" in the left sidebar and expand it. 

4. Locate the URL associated with the login or catalog page where the issue is occurring. 

5. Right-click on the URL and select "Clear" to remove the expired data.

By following these steps, you will effectively remove the expired "Remember me" data from local storage, allowing
the user to log in without encountering the "JWT expired at time" error.

Related articles:

Start a new login session in neoCatalog

Missing profile sRGB IEC61966-2.1.icm

https://inedit.freshdesk.com/en/support/solutions/articles/14000139277


Problem
After importing the multichannel file in neoCatalog, when you load the detail view then the preview is not there:

Reason
The problem here is that this colorway's ICC is using a dot in the file name and this gives the engine trouble. It thinks
that the extension is .1  and this returns an error to make a colorway.

Solution
Upload this icm profile to the neoCatalog or copy-paste it to the neoCatalog folder /neoCatalog/Profiles/. After
refreshing or importing a colorway with this profile, then the preview will be correct.



QuickPrint Errors - Layouts

Cases
When the print preset uses a layout that is not installed anymore:

QuickPrint Exception!
Error: java.lang.IllegalArgumentException: Cannot create ancom.webobjects.foundation.NSRange 
with negative length.

When the print preset uses a layout that is reinstalled:

QuickPrint 1299_280220231523
Sorry, we cannot print your file 1347_280220231526 by inedit@inedit.com at QuickPrint because: 
Error: Cannot send the file to the Print Server because one Exception:java.net.SocketException: 
Network is unreachable (connect failed)|Error: Cannot send the file to the Print Server because 
one Exception:java.net.SocketException: Network is unreachable (connect failed)

Related articles:

How to generate and send print files from the Print option

Installing QuickPrint Layouts

Shares does not arrive - Amazon S3 region for older
neoCatalog installation

Problem
Sharing samples, galleries, and sending Layout PDFs are using Amazon cloud service (AWS) with eu-west-3 in
older neoCatalog installations (version unknown). The service has different regions. Using eu-west-3 has a limit on
the Amazon service region that can cause a sending problem and sent items won't arrive. This is visible in the log:

Solution
Without neoCatalog advanced preference "aws_region" we use eu-west-3 by default, but we should use region eu-
w e s t - 1 . Change the preference, save restart after the preference has been changed.

https://inedit.freshdesk.com/en/support/solutions/articles/14000139302
https://inedit.freshdesk.com/en/support/solutions/articles/14000139681


Related articles:

Cannot share Sample Page

The "log4shell(CVE-2021-44228)" vulnerability
problem

The Simple Logging Facade for Java (SLF4J or log4j) is a tool used by neoControl and neoCatalog to generate
their logs.

We were asked by a customer for advice on a possible vulnerability in log4j, CVE-2021-44228 , that affects several
versions 2.x.

Since neoControl and neoCatalog use log4j version 1.2.17, these are not vulnerable to the exploit.

Troubles Downloading Files from neoCatalog in
Google Chrome

Problem
If you're unable to download files from neoCatalog while using Google Chrome, it's likely due to Chrome's security
policy blocking mixed content — secure (HTTPS) pages attempting to download insecure (HTTP) files.

Starting with Chrome 81, downloads over HTTP are blocked if initiated from HTTPS pages, as explained by Google
https://blog.chromium.org/2020/02/protecting-users-from-insecure.html

Solution: Allow Insecure Content for neoCatalog

https://inedit.freshdesk.com/en/support/solutions/articles/14000131885
https://www.slf4j.org/index.html
https://www.slf4j.org/log4shell.html
https://blog.chromium.org/2020/02/protecting-users-from-insecure.html


You can temporarily adjust browser settings to enable the download:

1. Open neoCatalog in Chrome.
2. In the URL bar, enter chrome://flags/#treat-unsafe-downloads-as-active-content .
3. Scroll to “Available”.
4. Set it to “Enabled”.
5. Refresh the page.

Alternative: Use a Different Browser
If the issue persists or you prefer not to modify Chrome settings, try using:

Firefox

Microsoft Edge

"Download Design" goes to login screen instead of
downloading

Problem
When clicking on "Download Design", it goes to the login screen instead of the downloading one:

http://flags/#treat-unsafe-downloads-as-active-content.%20


Solution
Change the permissions of the Design or Photos Folder in the neoCatalog server by using the following command
in a Terminal window:

neoCatalog: Emails do not arrive

Problem
It is possible to send e-mails successfully from my neoCatalog but in fact, the e-mails do not arrive.

There are times that the error is returned by the e-mail server after a few seconds (10-20 approx.) so neoCatalog
has already shown the message that everything has gone well before the error actually arrives.



Solution
To solve this problem it is necessary to activate the SMTPS. Go to Administration > Preferences > E-mail Server
Settings and tick the "User SMTPS" option. 

NOTE: It is required to restart neoCatalog after every email setting modification. 



Related articles:

E-mail Server Settings

14. Release Notes

Release Notes Dx 1.0

nC Dropbox 1.0.1
March 2024

nC Dropbox is a powerful file-sharing application that allows you to easily manage and transfer files between
different devices and locations. Unlike the Multiple file import function , nC Dropbox doesn't need administrative
configurations and permits all users to upload files using their API key tokens. Learn how to work with nC Dropbox.

https://inedit.freshdesk.com/en/support/solutions/articles/14000139389-e-mail-server-settings
https://inedit.freshdesk.com/en/support/solutions/articles/14000130803
https://inedit.freshdesk.com/en/support/solutions/articles/14000146939


nC

Release Notes Dx v25

nC Dropbox v25.5
May 2025

What’s New

not included.

Enhancements

Extended file preview ranges during upload.
Improved display of connection messages to show extended details.
Added validation for missing folders in the selected path before uploading.
Clarified error messages to be more user-friendly.



Bug Fixes

Dropbox app import issue fixed.
Fixed File count mismatch.
Progress bar during upload will no longer decrease unexpectedly.
Upload folder now empties correctly after upload is completed.
neoCatalog QR code visibility issue resolved for both macOS and Windows.
Corrected missing space or line break in some messages.

Release Notes nC v1

neoCatalog 1.6 to 1.8
Year 2016

Version 1.8
Linked to Inedit Apps.

Version 1.7
QuickPrint presets and scenarios
Auto update function in administration.
Copy-paste QR-code.

Version 1.6.5
Device Deployment with nC iOS and nC Web  License Management.
New activation windows.
Beta labels.
Restyled user privileges.
Password confirmation in administration.
REST API for third-party application connections.

Version 1.6.4
FreshDesk Support.
License Agreement before exporting the file.

Version 1.6.3
Background image in the login window.



Galleries preview.
Download or save export files QuickPrint dialog.
PDF quality for PDF documents in QuickPrint dialog.
Session Expiration Info.
Import XCM colorways with DropBox.
Gradient color info in Color Library.
Function in Check Integrity to automatically remove duplicated colorways.
Request progress bar Default request type.
Deliver addresses for users.
Mail notifications for issues.
User notifications for import & update designs.

Version 1.6.1
Random Colorways.

Release Notes nC v2

neoCatalog 2.2
Year 2018

HTTPS
“Remember me” & “Password recovery”
Encrypted passwords and preferences
Notifications inbox
Boards
Accordion and Gridster views
Shared Items
Galleries inside galleries

neoCatalog 2.1
Year 2017

Improved overall performance and fixed minor bugs.
Reduced page weight for faster loading on slow networks. Now,
pages load at least twice faster than before.

Release Notes nC v24

neoCatalog v24.12
December 2024



What’s New

Request Order Improvements:

Added the ability to show child requests linked to request orders.

Allowed duplicating requests along with their attachments.
Updated user session preferences to retain the last selected sorting filter in the Requests page.
Added due date and priority information to the request order card.

Introduced the option to notify the order creator with an advanced preference .
Added an "Attachment" option to the Show My Request dialog under the View menu.

More:

https://inedit.freshdesk.com/a/solutions/articles/14000154125?lang=en


Updated Preview Style to allow colorway previews to use design information such as size and rotation.
Added user privilege to control who can delete Attachments.

Bug fixes

Solved an issue where the fabric ID and object ID caused an empty print job page in Print options for
colorways.
Fixed the issue where multichannel colors preview in the Import dialog did not match the original design colors.

neoCatalog v24.10.1
October 2024

What’s New

Introduced the option to set an expiration date for the Share Sample page before sending it via email, allowing users
to specify when the page should no longer be accessible.

Bug fixes

The issue preventing files from being sent to Amazon has been fixed.
The problem with sharing samples due to an incorrect expiration date has been fixed.
A crash that occurred when searching for replaced tags has been fixed.

neoCatalog v24.10
October 2024

What’s New

Partial Exclusivity is a new feature that allows users to restrict or lock access to specific zones or regions within a
design, rather than restricting access to the entire design. With this feature, you can assign specific users or groups
to have exclusive access to certain areas, while keeping other parts of the design open to general use.

Zone-Based Access Control : Users can configure exclusivity at the zone or region level, providing granular

https://inedit.freshdesk.com/en/support/solutions/articles/14000153517


control over who can use specific parts of a design. This allows for partial control of design assets while
keeping flexibility over other areas.
Seamless Integration with Customer Exclusivity : The Partial Exclusivity feature works alongside
traditional customer exclusivity, enabling both options to coexist without conflict.

Visual Indicators for Exclusivity : Labels indicate which zones are restricted and provide clear visual
feedback. These labels can either be opaque or transparent, clearly showing the zones under exclusivity
restrictions.

Enhancements

We’ve improved the process of generating and sending PDFs via email by moving PDF generation to the
background . This change is for users who have neoCatalog closed and can't use Share Samples or Share
Gallery options. PDFs are now created in the background when sending via email, so the interface remains
responsive. This speeds up the process, eliminating long wait times in the UI while PDFs are being generated.

We have updated the Add to Gallery dialogs with a new create and search feature, allowing users to quickly
find or create galleries by typing the gallery name, instead of scrolling through long lists. The application now
remembers the last selected gallery for future use, improving performance and reducing load times by no
longer displaying all galleries at once.

https://inedit.freshdesk.com/en/support/solutions/articles/14000139302
https://inedit.freshdesk.com/en/support/solutions/articles/14000130319


We have made improvements to the Engraving Dialog to enhance usability and provide a more intuitive
experience.

We have implemented an email list in the request workflow state actions that let add email recipients by
entering addresses separated by commas, and sending automatic email notifications when transitioning
states, without impacting existing users or workflow management.

Added ability to create duplicated request orders to another workflow, with support for viewing information on
child requests.

https://inedit.freshdesk.com/en/support/solutions/articles/14000139879


We have added a Random Virtuals checkbox in the Print option, allowing users to assign random simulation
objects for each print page when printing the design. (requires advanced preference)

You can now bulk replace unused or outdated tags for all designs in the Clarifai Tags Administration .

Bug fixes

Resolved a crash issue that occurred while editing a temporary HSL colorway.
Fixed issue when changing the status color in administration.
Resolved a crash in the Print dialog that occurred when all layouts were marked as exclusive to certain users or
groups, and the logged-in users were not part of the exclusivity.
Improved the Verify Design functionality, where selecting Edit > Verify Design verifies the design, and
selecting Export > Verify Design allows you to unverify it without accessing the Edit Design Information.

neoCatalog v24.9
September 2024

What’s New

Request Orders

New List View for Requests : A new option has been added to switch the request list to a detailed list view,
displaying all orders for better tracking and management.

https://inedit.freshdesk.com/en/support/solutions/articles/14000153511
https://inedit.freshdesk.com/en/support/solutions/articles/14000141948


Show My Requests from selected design : Users can now view all their requests in a single location when
accessing the Export menu, for an enhanced tracking process.

Show Item Requests from selected design : Displays all requests made for the selected design when
accessing the Export menu, making it easier to monitor item-specific requests.

Chat in Request Orders : A new chat feature in the request order interface allows for communication,



improving collaboration during the order process.

Workflow State Types for Orders : We have introduced new workflow state types to enhance the request
management process. Requests will now progress through the following stages: UNSTARTED > ACCEPTED
> STARTED > DONE > VERIFIED . The workflow follows a strict sequence from UNSTARTED to
VERIFIED; Once a request reaches the STARTED state, it becomes locked for modifications, providing
control in the workflow.

Design Management

Support for Importing Digital Colorways into Separated Designs : Users can now import digital
colorways into separated designs directly from Dropbox.
Rotate Designs During Editing and Uploading : Users can now rotate designs during both the editing and
uploading processes. ( advanced )
Rotate Images in Print Dialog : A new feature allows users to rotate images directly in the print dialog. (
advanced )
Time Stamps for Attachments : Attachments now include time in their date stamps, providing more precise
tracking.
Advanced Search for Collection Behaviors : Enhanced search options for collection behaviors allow for
more efficient and precise searches.
Ruler on Detail View : Added the ability to modify the ruler in either centimeters or inches.
Layout Variables : Added the ability to include colorway iData within neoCatalog variables, improving layout
data.
Removed 'Created using Dropbox' Comment : The automatic comment "Created using Dropbox" has
been disabled, minimizing unnecessary metadata clutter.

User Management

User and Contact Organization Relationship : Users and contacts now have an organizational relationship,
allowing for better structure and connection between company and user.
Convert Contact to User by Email : A new feature allows users to easily convert a contact into a full user by
adding their email address.

Integration Tools

Image Tagging During Import : Integration with Clarifai allows users to tag images directly in the import
dialog, ensuring better organization from the start.
Unified Clarifai Preference Management : All Clarifai Administration preference is now managed through a
unified interface, simplifying the configuration of AI tagging features.

Administration & System

https://inedit.freshdesk.com/a/solutions/articles/14000153028?lang=en
https://inedit.freshdesk.com/a/solutions/articles/14000153027?lang=en
https://inedit.freshdesk.com/en/support/solutions/articles/14000139932-design-attachments
https://inedit.freshdesk.com/en/support/solutions/articles/14000139928-design-searching-and-navigation
https://inedit.freshdesk.com/en/support/solutions/articles/14000139929-design-and-colorway-viewing-options
https://inedit.freshdesk.com/en/support/solutions/articles/14000139682-default-neocatalog-layouts-description
https://inedit.freshdesk.com/a/solutions/articles/14000153034?lang=en
https://inedit.freshdesk.com/a/solutions/articles/14000141948?lang=en


Custom Fields with Multiple Radio Buttons and Checkboxes : Custom fields now support multiple radio
buttons and checkboxes, providing more flexibility in data input customization.
Support for Custom Stylesheets : Support for style implementation of custom stylesheets within the
application, ensuring consistent branding and enhanced design flexibility.
Apache 2.4.62 in Installer v24.8 : The latest version of Apache (2.4.62) is now included in the installer,
offering improved security and compatibility.

Bug fixes

Solved a problem where the profile name containing dots was not detected when importing.

Addressed an issue where digital designs were not being correctly converted to a separated design.

Fixed unexpected behavior when using search filters set to match ALL or ANY conditions.

Solved a problem where searching multiple collections and keywords returned incorrect results.

Addressed an issue where the system failed to detect the email server settings.

Fixed an issue where downloading files from request orders resulted in errors.

Addressed an issue where preview generation for small designs failed due to size limits.

Fixed a problem where designs containing the "Ñ" character could not be printed.

Resolved a bug where custom fields were missing when creating new colorways.

neoCatalog v24.7
July 2024

In line with the changes for neoStampa Delta, neoCatalog will also adopt the new Calendar 
Numbering system. Users will see the transition from neoCatalog 3.16.18 to neoCatalog 24.7.

What’s New

Secure Printing with End-to-End Encryption: Integrated encryption feature for secure printing of jobs in
neoCatalog for data security and protection of sensitive information.

Users can now choose to encrypt jobs in the Print dialog using supported file formats like PSD and PSB
before sending them to the Print Server. Enabling job encryption is based in the Print Server Management in
neoCatalog.
Unsupported file formats cannot be encrypted, and a warning message is displayed if a user attempts to
encrypt an unsupported job. In such cases, the job is added to the Print Server queue without encryption and
printed normally without any special formatting.
Encrypted jobs are indicated by an italic font in the Print Server queue. The required decryption code to print
the encrypted jobs is communicated between the neoCatalog and Print Server.
When an encrypted job is printed, a new print order is created in Requests with the date of printing. The Event
History Log in the order records various actions related to the encrypted jobs, including printing, workflow
changes, and job details.
The encrypted job cannot be reprinted.

https://inedit.freshdesk.com/en/support/solutions/articles/14000139742


More

Added the utilization of colorway colors in Photoshop channels when downloading design with embedded
remote colorway.

Introduced an option to replace users, allowing a seamless transition from one user to another (e.g., name 1 to
name 2) for better user management.

Added notification to the Request Order log for an order that was sent and printed in the Print Server.

Implemented overwriting Amazon files when a design is updated and reshared with the Share Samples utility
via emails, ensuring the latest version of the design file is always available.



We have reintroduced support for keyword groups to enhance your categorization and search capabilities. The
new keyword groups can be created and managed using the Categorization management or Advanced
preference settings to create keyword groups, for example: $FLOWER|Rose|Daisies|Orchids . Usage:

UI Import : Add keyword groups during the UI import process.
Panel Import : Incorporate keyword groups in your panel import.
Edit Design : Utilize keyword groups while editing your design projects.
Advanced Search : Enhance your search precision with keyword groups in advanced search.
Gallery Keyword Search : Simplify gallery searches using keyword groups.

Enhanced workflow with profile validation when importing designs and colorways with required profiles

Support for layouts subfolders in layouts management to create print jobs.

https://inedit.freshdesk.com/en/support/solutions/articles/14000139303


Established a backup system for the neoCatalog MySQL Database on the Cloud for better data integrity.
Enhanced the mobile view for consistency and user experience.
Improved the Gallery process to skip colorways without low-quality files to generate a gallery cover efficiently.
Included the ability to return the design status for the neoCatalog panel.

Bug fixes

Addressed migration issues for new neoCatalogs installations.
Solved issues when downloading shared sample files from AWS.
Enhanced the position of the status tooltip and multiple statuses in the design preview.
Solved handling of large database backup.
Fixed the issue that notifications of database backup have been sent to all admin users.
Solved issue sending a print to Print Server queue when there is only one Print Server configured in the
Management.
Addressed issue where the Layouts were not alphabetically sorted.

Release Notes nC v25

neoCatalog v25.12
December 2025

What’s New

not included.

Enhancements

Added the possibility to isolate the missing files design to a dedicated section in the advanced administration.
Added support to create a connection link with the neoQRReader app.
Added custom dialog for Request Orders.

Bug Fixes

https://inedit.freshdesk.com/en/support/solutions/articles/14000149187
https://inedit.freshdesk.com/en/support/solutions/articles/14000139742


Resolved an issue that prevented logging in to the nC neoCatalog Panel.

neoCatalog v25.11.2
November 2025

What’s New

not included.

Enhancements

not included.

Bug Fixes

Addressed an issue preventing the selection of simulation masks when objects used a custom ICC profile
instead of sRGB.
Corrected a problem where print layouts were not preserved in presets.
Resolved an issue where custom fields remained visible even after all were marked as unused.

neoCatalog v25.11.1
November 2025

What’s New

not included.

Enhancements

Improved the Print dialog to remember the last selected print layout.

Bug Fixes

Resolved an issue where XJB files were unable to generate due to long file names.

neoCatalog v25.11
November 2025

What’s New

not included.

Enhancements



Improved the handling of temporary print files to prevent unnecessary storage usage.
Optimized the workflow for managing and updating colorway files.

Bug Fixes

Addressed a problem where colorways stored in cache could not be downloaded correctly.
Fixed a potential null-pointer exception when accessing the cache during colorway deletion.

neoCatalog v25.10.2
October 2025

What’s New

not included.

Enhancements

not included.

Bug Fixes

Solved a crash when deleting designs from Designs Navigator.

neoCatalog v25.10.1
October 2025

What’s New

not included.

Enhancements

Improved the Printing dialog when selecting printer-related schemes.
Optimized the background print job execution process when starting simultaneous generations

Bug Fixes

Resolved a problem where the system could not process multiple print jobs sent to the queue at once.

neoCatalog v25.10
October 2025



What’s New

Printing History

We’ve improved the downloading and sending process for printing jobs in neoCatalog, making it faster and more
reliable.   A new Printing History feature has been introduced, and all file generation in the Print dialog now takes
place in the background.

You no longer need to keep the Print dialog open or wait for the process to finish, and once your job is generated, the
download or send action will start automatically. All generated files are now available anytime from the Printing
History section, where you can easily re-download them whenever needed.

Enhancements

Improved consumption data exchange to neoControl for smoother performance.
Optimized processing to handle large preview batches to reduce loading time.

Bug Fixes

Resolved an issue where the IP filter in User Management did not work correctly when using the asterisk (*)
symbol in the list.
Fixed an issue where updates to colorways were not properly placing or renaming the files.

neoCatalog v25.9.1
September 2025

What’s New

not included.

Enhancements

Improved the performance of preview generation in navigation mode.

Bug Fixes

Resolved an issue that prevented secure print jobs from being decrypted properly.



neoCatalog v25.9
September 2025

What’s New

not included.

Enhancements

More control when managing beta updates.
Updated to the latest engine version.

Bug Fixes

not included.

neoCatalog v25.6.1
June 2025

What’s New

not included.

Enhancements

User privileges have been added to manage request orders.
The request order states are now selectable in the open request order.
The translation glossary now has a search bar for searching the original or translation strings.

Bug Fixes

Solved issue where Tags and Collections mandatory fields in the Design Upload dialog were not detected.

neoCatalog v25.5
May 2025

What’s New



not included.

Enhancements

Choose what to print directly from the Print menu: select between the current design, pinned items, or design
colorways.

Added a confirmation prompt when deleting an entire gallery to prevent accidental removals ( advanced
preference) .
Improved log control when generating prints in the background for better stability and reporting.
Added support to track the time spent in each Workflow State.

Bug Fixes

Corrected an issue where rotated QuickPrints were not exported with the correct rotation applied.
Removed unnecessary filtering of all designs when managing custom fields to improve performance.

neoCatalog v25.4
April 2025

What’s New

not included.

Enhancements

not included.

Bug Fixes

Pinned items are now stored per session and are no longer shared across all users.
Resolved an issue with hybrid colorways where colors were incorrectly previewed when certain channels were
not in use.
Fixed a potential error when removing old log files.
Addresses a potential null pointer issue in Request Workflow.
Improved clean-up database table tasks task to avoid removing processes without dates.

neoCatalog v25.2.3
March 2025

https://inedit.freshdesk.com/en/support/solutions/articles/14000156894
https://inedit.freshdesk.com/a/solutions/articles/14000139892?lang=en


What’s New

not included.

Enhancements

not included.

Bug Fixes

Fixed an issue where Shopping Cart users were unable to access the Administration section.

neoCatalog v25.2.1
March 2025

What’s New

Pin Item Option for Temporarily Storing Colorways

Added a new Pin Item feature, allowing users to temporarily store colorways for easy management and custom
selections.

Enhancements

Significantly reduced loading times when generating print job previews per page instead of all pages.
Now you can add colorways directly in the Print dialog, with convenient options to Add All Colorways of a
design or Remove All Items , all without leaving the dialog.

https://inedit.freshdesk.com/a/solutions/articles/14000156894?lang=en


The 'Show Request' feature now displays only the Request order items associated with the selected items and
total meters requested specifically for the selected item, excluding unrelated items.

Advanced Preferences :

Introduced an advanced preference to skip the global creation of the 'Separated' design type. ( advanced
preference )
Implemented an advanced preference to disable the size input field in request items for quantity-based
workflows. ( advanced preference )
Added an advanced preference option to include fabric type in both the print dialog and print layout export. (
advanced preference )
Improved import speed by bypassing coverage calculations for multichannel designs. ( advanced preference )

Bug Fixes

Fixed behavior on how the attachment files larger than 2GB are handled in the download process.
Solved an issue when converting one contact to a user.

neoCatalog v25.2
February 2025

What’s New

not included.

Enhancements

https://inedit.freshdesk.com/a/solutions/articles/14000156888?lang=en
https://inedit.freshdesk.com/a/solutions/articles/14000156889?lang=en
https://inedit.freshdesk.com/a/solutions/articles/14000156890?lang=en
https://inedit.freshdesk.com/a/solutions/articles/14000156887?lang=en


Introduced restriction for keyword creation in dialogs, allowing control over user-generated wrong keywords.
(advanced preference)

Bug Fixes

Addressed a problem where colorway separators were manipulating colorway names. ( advanced preference )
Fixed an issue where the mandatory fields in Upload dialogs were not recognized.
Resolved an issue where exclusivity-related email notifications were not being received. Now, notifications are
correctly logged and sent.
Optimized filtering in print dialogs to skip unnecessary processing when handling thousands of requests,
resulting in faster load times.
Fixed an issue where shared samples were not maintaining the required layer structure. ( advanced preference
)

neoCatalog v25.1
January 2025

What’s New

not included.

Enhancements

Added advanced option to import designs as new when design update is detected, providing flexibility when
managing existing designs.
neoCatalog now features an automated reminder system that sends daily notifications for designs nearing
exclusivity expiration and those already expired. Users can customize their notification preferences to receive
alerts as needed.
Improved detection of CMYK files as digital during Multiple Importation.

Bug Fixes

Resolved the issue where coverage information blocks were preventing design importation.
Addressed a crash caused by enabling partial exclusivity due to a migration issue.

Release Notes nC v26

neoCatalog v26.2
February 2025

What’s New
is not included.

https://inedit.freshdesk.com/en/support/solutions/articles/14000156891
https://inedit.freshdesk.com/en/support/solutions/articles/14000156892
https://inedit.freshdesk.com/a/solutions/articles/14000139889?lang=en#Import-as-New
https://inedit.freshdesk.com/a/solutions/articles/14000153517?lang=en#Managing-expiration-dates-for-exclusive-Designs


Enhancements
not included.

Bug Fixes
Fixed an issue where published color names and local color libraries were not properly synchronized.
Addressed an issue where removing a single keyword caused all keywords to be removed.
Resolved performance issues when generating massive gallery previews.

neoCatalog v26.1.2
January 2025

What’s New
not included.

Enhancements
not included.

Bug Fixes
Solved the issue where the print alignment was not applied in the print job.
Addressed the behavior where unnecessary order state type filtering has been applied.

neoCatalog v26.1.1
January 2025

What’s New
not included.

Enhancements
not included.

Bug Fixes
Solved issue where multichannel designs were downloaded with the colorway name.
Fixed that the print straight job action is sent successfully.



neoCatalog v26.1
January 2025

What’s New
not included.

Enhancements
Now exporting multiple design jobs, it exports as a single job rather than multiple jobs.
Multiple trademarks can be assigned across multiple design editions at once.
Introduced page margin in job layout attributes.

(example: <Page Id = "0" width = "145.5 cm" height = "51 cm" marginLeft="2.5mm"
marginRight="2.5mm" marginBottom="6 cm">)

Added new variables: printer name +id, printer scheme and the layout name.
Now the print dialog shows the size of the print rapport page instead of the first page.

Bug Fixes
Resolved an issue that prevented logging in to the nC neoCatalog Panel.

Release Notes nC v3.0

neoCatalog 3.0
September 2018

What’s New

New desktop app for macOS & Windows. Download neoCatalog on your desktop!

https://inedit.freshdesk.com/en/support/solutions/articles/14000139296


 New installation assistant to ease the task.

Drag&Drop import system. Upload your designs from your computer.
Sending emails without having to configure the server.
Automatic backups .
Automatic application updates .

https://inedit.freshdesk.com/en/support/solutions/articles/14000139297
https://inedit.freshdesk.com/en/support/solutions/articles/14000139889
https://inedit.freshdesk.com/en/support/solutions/articles/14000139389
https://inedit.freshdesk.com/en/support/solutions/articles/14000139299
https://inedit.freshdesk.com/en/support/solutions/articles/14000106359


More :

New notification inbox.
Improvement of management and preference sections.
New dialogs of information about designs and colorways.
Invite new users to your catalog by e-mail.
Upload your colorways from neoTextil.

Bug Fixes

Fixed missing previews for greyscale digital designs.
Fixed wrong items selection when using “Add to Gallery” for the second time.
Fixed use neoPrintServers with Bonjour.

Release Notes nC v3.1

neoCatalog 3.1
January 2019

What’s New

New Advanced Search option embedded on the designs view.

New option to search by keywords using the main search field.

https://inedit.freshdesk.com/en/support/solutions/articles/14000139928


Connected with neoTextil's nC Panel .

Bug Fixes

Fixed minor bugs.

Release Notes nC v3.10

https://inedit.freshdesk.com/en/support/solutions/articles/14000141438


neoCatalog 3.10
March 2021

What’s New

Simulations Page Optimized

The simulation parts are accessible when selecting the object and have dynamic usage in applying texture, setting
offset, and scrolling in the simulation object.

neoCatalog API key token

New tab in user's management to create API tokens. neoCatalog's API token can be used to interact with other
applications.

https://inedit.freshdesk.com/en/support/solutions/articles/14000139696
https://inedit.freshdesk.com/en/support/solutions/articles/14000139304


Dynamic custom fields (server mode)

The option Custom Fields in neoCatalog Server is used for the needs of additional data fields to specify values for
the selected design. It supports five fields. To access the custom fields tables , go to 'Management' in administration

and find the listed option in 'Advanced'. 

Bug Fixes

Fixed crash when selecting a design that does not exist.
Crash when a logged-in customer enters Shopping Cart while an item is modified in the cart.

Release Notes nC v3.11

neoCatalog 3.11
May 2021

What’s New

Improved connectivity with Print Server

https://inedit.freshdesk.com/en/support/solutions/articles/14000139742


Saving printer schemes on presets when being connected with Print Server.
Now the Print Server management is improved in adding connections and even exploring Print Servers using
security tokens to authenticate the Print Server in neoCatalog.

To be a neoCatalog user with no export privileges but still have possibilities to print in Print Servers need to get
exclusivity on the Print Server configuration in Administration.

Change one keyword with another

Available in administration to replace or rename keywords in neoCatalog.

Rapport information in different units

This feature is made to support different rapport units in the Edit Design dialog . Can be modified with supported
units "point", "points", "pt", "millimeter", "mm", "centimeter", "cm", "meter", "m", "inch", "in", "pica", "pc", "repeat",
"rep", "r", "rp", "%", or "pix".

https://inedit.freshdesk.com/en/support/solutions/articles/14000139679
https://inedit.freshdesk.com/en/support/solutions/articles/14000139303
https://inedit.freshdesk.com/en/support/solutions/articles/14000139890


Emails received from neoCatalog in Outlook

We have added the URL link in the email to receive and redirect the shared neoCatalog files.

Attachments Previews

New option to view all attachments that are attracted to one design.

Custom dialogs

When working with custom fields , then with custom dialogs you can define which fields should be shown in which
dialogs.

Shopping Cart - Get exclusivity on items

This workflow is applied to neoCatalog users that are buying colorways using the shopping cart, regardless if
colorways are linked in galleries or out of galleries ( advanced ).

Accept terms and conditions when importing files

New option to display terms and conditions agreements ( advanced ) in text form that must be accepted before
design and digital colorways are published/updated from UI and nC neoCatalog Panel.

https://inedit.freshdesk.com/en/support/solutions/articles/14000139932
https://inedit.freshdesk.com/en/support/solutions/articles/14000139742-custom-fields-and-custom-dialogs-management
https://inedit.freshdesk.com/en/support/solutions/articles/14000129843-shopping-cart-get-exclusivity-on-items
https://inedit.freshdesk.com/en/support/solutions/articles/14000129841-how-to-have-terms-conditions-agreement-when-importing-files


Bug Fixes

Color Libraries with names larger than 32 characters in the importation.
PDF not sent by email from the Print page.
Users with the Manager category cannot see colorway text custom fields.

Release Notes nC v3.12

neoCatalog 3.12
July 2021

What’s New

Advanced Access Control

Now Access Control has a new dashboard showing neoCatalog users' interactions and time of connections.

https://inedit.freshdesk.com/en/support/solutions/articles/14000139734


Allow the Designer to manage his designs

Now the designer users can have the privileges to own and manage designs. A new preference in Administration >
Preferences > Viewing Option s is available to enable this behavior.

Coverage Number Patch Style

We improved the font and display for the coverage number.

Advanced Search - Use AND/OR

Search in neoCatalog search criteria that match ALL or ANY search items.

https://inedit.freshdesk.com/en/support/solutions/articles/14000139728
https://inedit.freshdesk.com/en/support/solutions/articles/14000139728
https://inedit.freshdesk.com/en/support/solutions/articles/14000139728
https://inedit.freshdesk.com/en/support/solutions/articles/14000139728
https://inedit.freshdesk.com/en/support/solutions/articles/14000139928


Option to add all designs in one gallery

New option to add all colorways of one design to a gallery. Is also applied to multiple designs selection.

Bug Fixes

Memory handling of JPG format with big files.
Exploring connections with Print Servers loses the management UI.

Release Notes nC v3.13

neoCatalog 3.13
August 2021

What’s New

Share samples have a new option

If your gallery has an expiration date , you can select the same expiration date for the sample page shared link.

https://inedit.freshdesk.com/en/support/solutions/articles/14000130319-how-to-add-colorways-into-gallery-from-one-gallery
https://inedit.freshdesk.com/en/support/solutions/articles/14000139301


Scroll attachments list

Having many attachments to one design is easier to find with a scroll.

Bug Fixes

Crash at accessing expired samples from the link on the email.
Crash when sharing a gallery.
Formatting for fabric names.

Release Notes nC v3.14

https://inedit.freshdesk.com/en/support/solutions/articles/14000139932


neoCatalog 3.14.5
January 2022

What’s New

not included.

Bug fixes

Creating new catalogs will not give errors.
Scroll for attachments back again.
Invite users will not crash.
Variables for customer and designer are added to the output.
Removed double extension.
XJB job names do not use underscore.

neoCatalog 3.14.2
January 2022

What’s New

Requests Order : Now request orders are working with workflows and state columns. You can have multiple
workflows with states using automated rules.

Watch Video: https://player.vimeo.com/video/814249233 

Extended Custom Fields & Dialogs Management: When working with default and custom fields, now with
custom dialogs you can define which fields should be shown in which dialogs.

https://inedit.freshdesk.com/en/support/solutions/articles/14000140214
https://player.vimeo.com/video/814249233
https://inedit.freshdesk.com/en/support/solutions/articles/14000139742


Customer selection in the Print dialog can be mandatory when enabled in advanced preferences.

Bug Fixes

Fixed Simulations Object mask detection.
Fixed download simulation object with texture.
Fixed Status remembering when importing designs.

Release Notes nC v3.15

neoCatalog 3.15.9
September 2022

What's new

not included.

Bug Fixes

The wrong path of digital files when adding digital designs.

neoCatalog 3.15.8
July 2022

What's new

not included.

Bug Fixes

Exporting QuickPrint documents with a custom field uses the wrong value.

neoCatalog 3.15.7
July 2022

What's new

Added engine version nRE 2.27.0.

https://app.shortcut.com/inedit/story/17356/add-engine-nre-2-27-0-or-higher-release-in-next-nc-release
https://app.shortcut.com/inedit/story/17356/add-engine-nre-2-27-0-or-higher-release-in-next-nc-release
https://app.shortcut.com/inedit/story/17356/add-engine-nre-2-27-0-or-higher-release-in-next-nc-release
https://app.shortcut.com/inedit/story/17356/add-engine-nre-2-27-0-or-higher-release-in-next-nc-release
https://app.shortcut.com/inedit/story/17745/export-of-single-quickprint-with-custom-field-uses-wrong-value-sutex-3-15-7
https://app.shortcut.com/inedit/story/17356/add-engine-nre-2-27-0-or-higher-release-in-next-nc-release
https://app.shortcut.com/inedit/story/17356/add-engine-nre-2-27-0-or-higher-release-in-next-nc-release


Bug Fixes

not included.

neoCatalog 3.15.6
June 2022

What's new

Export RGB color values support ACB and CSV color libraries.

Bug Fixes

Publish a design from the neoCatalog Panel when the section is selected.

neoCatalog 3.15.4
June 2022

What's new

not included.

Bug Fixes

Import progress for new design shows the last imported design file name.
Custom page size remembered inverted after using presets in the Print option.

neoCatalog 3.15.3
June 2022

What's new

Sort color libraries alphabetically: Until now we sort them by a capital letter (C, D, a, b, 3, m), but now we sort
them alphabetically (3, a, b, C, D, m).

Bug Fixes

Unit not updated when switching from custom to layout size in Print option.

neoCatalog 3.15.1
May 2022

https://app.shortcut.com/inedit/story/17095/import-progress-for-new-design-shows-last-imported-design-file-name-3-15
https://app.shortcut.com/inedit/story/16191/cannot-publish-a-design-from-panel-if-i-select-a-section-8-9-1
https://app.shortcut.com/inedit/story/16191/cannot-publish-a-design-from-panel-if-i-select-a-section-8-9-1
https://app.shortcut.com/inedit/story/17095/import-progress-for-new-design-shows-last-imported-design-file-name-3-15


What's new

Color Library in ACO format.

Bug Fixes

Add attachment in Gridster View Gallery mode in Windows.

neoCatalog 3.15.0
May 2022

What's new

Request Order in Print Automation : Now request orders can be automated using print presets when
printing to Print Server. The presets can be selected from every order or defined in the state action to start
automated send to the printer, when the order is moved in the state.
Export Excel of orders: In the request kanban select the state column and then within 3 dots options, you can
choose to export the Excel file (xlsx).
New user-based privileges: Now users can have independent from main general user privileges new
privileges to print, share or view:  Print option, Share items, Share Samples, and Sections.

Print dialog is more dynamic :
Remembering the last selected data in the Print dialog for the user session.
Support of ‘rep’ unit for custom page size.
Working with Rapport layouts it will use the full rapport image size that works with combinations in
destinations of XJB or sending to the Print Server queue.
Mandatory field to select scheme before sending the job to Print Server with new advanced preference
‘require_scheme_for_print’.
Confirmation print before sending to Print Server with new advanced preference
‘require_confirmation_for_print’.

Share samples improvements :
Share Samples with multiple gallery item selections.
Now emails split by comma will send the share sample email to the individual recipient.
Define the quality of the preview for image size in px with the new advanced preference
‘samples_resolution’.
Define the height of the preview in % when entering the sample page with the new advanced preference
‘samples_preview_percentage’.

Now the email of sharing samples uses a custom logo defined in user management or else as the global
(mini).
Now footer logo is customizable with the new advanced preference ‘neo_custom_logo_foother’.
Multiple sections (server only) : We added support to have multiple Sections in neoCatalog.

Custom dialogs (server only) : Improved setup on dialogs using default and custom fields. 

https://app.shortcut.com/inedit/story/16623/cannot-add-attachment-in-gridster-in-windows-3-15-0


Bug fixes

Underline in XJB job names cannot be processed in Reggiani RIPPER.

Release Notes nC v3.16

neoCatalog 3.16.18.1
April 2024

What’s New

not included.

Bug fixes

Fixed the issue causing Simulation previews to not generate properly.
Solved the handling of design code behavior during file import, deletion, and subsequent re-import.

neoCatalog 3.16.18
March 2024

neoCatalog now requires a minimum macOS version of Catalina 10.15.7 or later.

What’s New



We have introduced new functionality related to layout management within neoCatalog.  When a user has
access to multiple layouts, including public layouts and exclusive ones designated for specific roles (such as
designer or customer), the following behavior now applies:

Layout Renaming: If any layouts are renamed (e.g., from "Layout A" to "New Layout A" or vice versa),
these changes are reflected across the system.
Layout Visibility: One layout is always visible in the general view, ensuring that it is accessible to all
users.
Role-Based Access: When connecting as a designer or a customer:

Designers will only see layouts that are public and exclusive to the designer's role.
Customers will only see layouts that are public and exclusive to the customer role.
Any layouts not designated as public or exclusive to their respective roles will be hidden from view.

Watch Video: https://player.vimeo.com/video/927173667

Added a workflow option for archiving states in Requests, which are then stored in the Archived section for
better organization and management.

Watch Video: https://player.vimeo.com/video/925805432

Introduced a new feature that allows users to customize their experience in the request order kanban by
providing an option to hide and show states. Users can now personalize their views by choosing to hide
specific states. Additionally, the system remembers these preferences based on user sessions.

Watch Video: https://player.vimeo.com/video/927452512 

Implemented advanced preferences for Interpolation methods designed for separated and digital design types,
for precise and optimal previews of zoomed previews.

Colorways created in neoCatalog using colors from Photoshop and then converted to the neoCatalog profile
will maintain their original colors. 

Bug fixes

Resolved timeout problem during preference checks when starting the application.
Resolved timeout problem during design imports.
Fixed display to show the correct design type when importing designs.
Fixed editing design to stop asking for required fields unnecessarily, even when filled.
Resolved the issue causing Excel exports to fail when the content exceeds 65K rows.
Addressed the behavior of applying privileges to users who do not have access.
Resolved an issue where the modification date for updated designs was not updated.

neoCatalog 3.16.17
February 2024

What’s New

Interchange Colors in Random Colorways : Designers now can mix up the placement of colors within
channels, offering greater creative freedom and flexibility in their designs. The checkbox next to the generation
enables the use of interchange channel colors from selected colorways for new combinations.

Watch Video: https://player.vimeo.com/video/912206174 

Custom fields in Excel : Users who use custom fields want to see the data from those fields included in the
exported Excel file from the design selection.

Bug Fixes

Resolved the problem of company logos not being exported in documents when based on trademarks.
Fixed the print dialog crash occurring after deleting a print server connection with linked presets.

https://inedit.freshdesk.com/en/support/solutions/articles/14000139681
https://player.vimeo.com/video/927173667
https://inedit.freshdesk.com/en/support/solutions/articles/14000139879
https://player.vimeo.com/video/925805432
https://inedit.freshdesk.com/en/support/solutions/articles/14000141776
https://player.vimeo.com/video/927452512
https://inedit.freshdesk.com/en/support/solutions/articles/14000149957
https://player.vimeo.com/video/912206174


We enhanced translation and interface issues for a better user experience.

neoCatalog 3.16.16
February 2024

What’s New

Associate Simulation Object with Colorways: Users can associate a Simulation object with a specific
colorway by choosing the simulation name from the Colorway information. This becomes possible
once the field is added to the custom dialogs.

Watch Video: https://player.vimeo.com/video/908673375

Integrating trademark logos in print documents : neoCatalog 3.16.16 comes with a feature allowing users
to integrate trademark and sub-trademark logos into their designs based on simple rules . This feature offers
customization options, ensuring that users can incorporate their brand identity into their print design.

Bug Fixes

Addressed database migration failure during the installation process.
Resolved issue with the upload dialog used for importing design name files.
Fixed the inability to import digital designs with embedded colorway information.
Resolved the issue where the team selection field was not available in Request State action when placed in the
second position.
We enhanced translation and interface issues for a better user experience.

https://inedit.freshdesk.com/en/support/solutions/articles/14000149065
https://player.vimeo.com/video/908673375
https://inedit.freshdesk.com/en/support/solutions/articles/14000139303
https://inedit.freshdesk.com/en/support/solutions/articles/14000149429


neoCatalog 3.16.15
January 2024

What’s New

New option for random color variations for digital colorways : Added support for random colorways for digital
images, where we can apply HUE and Lightness on new colorway combinations.

Design with embedded colorway XCM: Now you can download the design file with embedded XCM colorway.



Request orders with User Privileges: The Request Orders are controlled by user privileges and user categories
in moving orders to the next state and editing the order information.

Colorways Groups : Added support for colorway groups with nT Colorations colorways.

Watch Video: https://player.vimeo.com/video/902305415 

Page access for users : Added control for page tabs to select individual User/Group to apply which tab should be
accessible.

https://media.app.shortcut.com/api/attachments/files/clubhouse-assets/5fe36902-265a-4314-b1dd-15d8aa45392d/6576ce19-5eb7-4452-ba57-7734eddd32fc/Screenshot%202023-12-11%20at%2009.53.11.png
https://player.vimeo.com/video/902305415


Layouts Administration : Now we can download the folder with the set of layouts from the neoCatalog Server to the
disk on the Administration page.

Administration for Updates:

We have reintroduced the beta update for the neoCatalog Server.
In addition to beta updates, also activates the manual upload option. With this feature, users can select and
upload a specific version directly from their disk to start a manual update. T



Bug Fixes

Fixed an issue where the image size didn't update after a digital design reset .
Resolved the problem of jobs rotating when the source file had a rotation flag .
Improved search functionality for existing requests.
Users removed from groups now correctly lose the label of the group they were removed from.
Fixed the publishing of hybrid colorways from Colorations to nC, ensuring proper use of extra channel colors in
previews.
Addressed that print alignment in the Print dialog is not being saved in presets.
Fixed the inability to save fabric texture in the Fabric type.
Resolved the issue of being unable to import files with special characters like 'Ñ'.
Contacts can now be selected and deactivated in the workflow state for team notifications.
Enhanced translation and interface issues for a better user experience.

neoCatalog 3.16.14
December 2023

With the integration of our engine 4.0.0, neoCatalog now requires a minimum macOS version of 
Mojave 10.14 or later.



What’s New

Gallery Attachments: You can now enhance your galleries by attaching files directly to the Gallery in all modes.

Profile Enforcement for Published Designs: Introducing the 'neo_require_profile' preference that enforces all
designs or colorways published must have a defined profile selected.



Advanced Object Alignment Settings: Customize object alignment settings in the Print Options (Designs,
Requests) with the new "neo_use_alignment" preference set to "YES."

Design/Colorway Print Dialog: Choose alignment options directly in the print dialog for the designs.



Request Item Alignment: Specify alignment for each request item, which will show the alignment selection in the
print dialog for the request order item information.



Workflow Email Notifications: Keep teams informed and engaged throughout the requests workflow processes by
selecting specific User/Group emails in workflow state actions to notify users.



Color Library Profile Selection: When connected to the Print Server, users can now associate a specific profile



from the scheme to their Color Library.

Colorway Naming Convenience: Set your preferred prefix separator for colorway names with user ID using the
'neo_next_colorway_separator' preference. By default, it is set to "_".

Bug Fixes

Users were experiencing temporary design name issues when importing new files on Windows. This has been resolved, and the .old
file is now replaced as expected.
Solved issue when attempting to import files containing the character Ñ.
Addressed an issue when the path contained the character Ñ and now jobs can now be executed without any obstacles related to
special characters in the path.
Corrected import behavior for files with dashes in the filename (Sample-1).
Solved problems with the panel being locked when downloading an existing design in neoCatalog.
Fixed error when attempting to create design previews in the cloud catalog.

neoCatalog 3.16.13
September 2023

What’s New

Request Types and Workflows:

Updated Request Workflows list to be sorted by name rather than creation date.
Implemented sorting of request orders by Request Type.
Added the display of request types on the request card .
Improved performance by loading request orders in batches of 100, with the ability to expand the next 100
using the 'Show More' button, resulting in a significant boost in system speed and responsiveness, even when
dealing with thousands of request orders.

Fabric Management Option:

Introduced the button to disable fabric type in Fabric management , allowing users to customize their fabric-
related settings in request type as needed.
Added the information of the fabric type inside the request Excel sheet .

Error Notifications for Background Jobs:

Implemented timely error notifications (within a 30-second time-out) for errors that occur during background job
execution and sending, ensuring users are promptly alerted to any issues.

https://inedit.freshdesk.com/en/support/solutions/articles/14000139879
https://inedit.freshdesk.com/en/support/solutions/articles/14000140214
https://inedit.freshdesk.com/en/support/solutions/articles/14000139724
https://inedit.freshdesk.com/en/support/solutions/articles/14000140220
https://inedit.freshdesk.com/en/support/solutions/articles/14000139388


Bug Fixes

Resolved an issue where fabric width units and values in the request item were not properly converted.
Addressed an issue where sessions were inadvertently switching to invited admin users.
Fixed an encoding error that prevented job generation when certain fields in the request order, such as
customer, comment, fabric, or finishing method, had specific characters.
Resolved issues related to incomplete request items ZIP downloads, particularly when handling large or
numerous request items.
Addressed a problem where colorway publishing from nT to nC failed when the channel name contained the
"&" symbol.
Fixed a bug where nT colorway statuses were not being published in neoCatalog.
Reversed the change, allowing users to once again enable exclusivity without requiring customer selection.

Update available with auto-update option

nC 3.16.13.1 (02/10/2023)

The hotfix will resolve the issue, allowing colorway updates to replace files in the background as intended.

nC 3.16.13.2 (10/10/2023)

Request orders will not progress to the next state until the request page is reloaded
Resolved an issue where a crash occurred when attempting to log in with a user account having double space
separation

neoCatalog 3.16.12
August 2023

What’s New

The release introduces the ability to change the background channel name , providing more customization
options.
Enjoy enhanced convenience with the process of cleaning multiple embedded colorways, streamlining your
workflow.
In the Requests feature, we've relocated the Print option from the Export menu, added the fabric width display
to request items, and included the count of request sizes in the State column .
Experience improved performance and faster loading times for previews and requests , ensuring a smoother
user experience.
The release includes improvements in galleries previews generation, making it easier to navigate and preview
your designs. Enjoy improved loading times for simulations when working in the accordion view , ensuring a
seamless and responsive experience. Increase productivity with the ability to move accordion view items using
keyboard arrows < and >.

https://inedit.freshdesk.com/en/support/solutions/articles/14000144278
https://inedit.freshdesk.com/en/support/solutions/articles/14000140214
https://inedit.freshdesk.com/en/support/solutions/articles/14000139724
https://inedit.freshdesk.com/en/support/solutions/articles/14000141776
https://inedit.freshdesk.com/en/support/solutions/articles/14000140214
https://inedit.freshdesk.com/en/support/solutions/articles/14000139701
https://inedit.freshdesk.com/en/support/solutions/articles/14000139703


Watch Video: https://player.vimeo.com/video/845937088?share=copy 

Bug Fixes

The release addresses issues related to the database migration of engraving items, ensuring a smooth and
seamless transition.
Fixed the presence of temporary files in the design folder, eliminating clutter and maintaining a clean
workspace.
Resolved issues with accordion previews for gallery items being remade each time the gallery is accessed,
improving efficiency and performance.
Fixed an issue where assigning the wrong value to new colorways would generate excessive data, leading to
proxy errors during the creation of new colorways.
Enhanced resolution for simulating texture on low-quality objects.
This update focuses on enhancing our product's translations for improved clarity and accuracy.

You might be wondering about the missing version 3.16.11. During the development process, we 
encountered compilation conflicts that led us to skip version 3.16.11. We decided to bypass 
version 3.16.11 and proceed directly to version 3.16.12. This decision did not lead to any 
loss of features or functionality.

neoCatalog 3.16.10
May 2023

What’s New

Destination "Save to Server" in Print Presets for Order Requests State Actions

Introduced a new destination option, " Save to Server ," in the Print Presets for Order Requests state actions. This
allows users to easily select "Save to Server" when configuring print presets for order requests.

With this feature, users can conveniently store print files directly on the server when the order is moved to the state
that automates the execution , simplifying their workflow and ensuring seamless storage of files associated with
order requests. This enhancement reduces manual effort, improves efficiency, and streamlines the overall print
process for handling order requests.

https://player.vimeo.com/video/845937088?share=copy
https://inedit.freshdesk.com/en/support/solutions/articles/14000139302
https://inedit.freshdesk.com/en/support/solutions/articles/14000136107--print-with-preset-as-workflow-state-action-in-requests
https://inedit.freshdesk.com/en/support/solutions/articles/14000136107-how-to-automated-print-file-generation-in-request-orders/preview


Notification for Download Background Item

We have introduced a new notification feature that enhances the user experience during background item
downloads. With this enhancement, users will receive notifications in two ways: through the notifications section in
the application and via email.

In-Application Notifications: Users will now see real-time notifications within the application, providing
updates on the progress and completion of background item downloads. These notifications will be
prominently displayed in the notifications panel, ensuring users can easily track the status of their downloads.

Email Notifications: In addition to in-application notifications, users will also receive email notifications
regarding the progress and completion of their background item downloads. These email notifications will be
sent to the email address associated with their account, ensuring users can stay updated even when they are
not actively using the application.

By implementing notifications in both the application and emails, we aim to provide users with multiple channels to
receive updates on their background item downloads. This ensures that users are always informed about the
progress of their downloads, regardless of whether they are actively using the application or not.

Request Order variables for orders and items with print layouts

https://inedit.freshdesk.com/en/support/solutions/articles/14000139388


The latest release introduces enhanced handling of request order variables for both orders and items with layouts .
The new feature allows for automatic variable assignment within the layouts. This functionality provides greater
flexibility and control over the placement and usage of request order information.

Bug Fixes

In this release, we have addressed bug fixes to ensure a smoother user experience by resolving issues related to
preview styles, preset outputs, color libraries, crashes, naming conventions, watermarks, and application stability.

Preview style customization in titles is now properly used in Galleries.
Case-sensitive Status names now correctly use the assigned color.
Delete color library kept selected on the coloring page and colorway information.
Design and Colorway selection was not highlighted after updating items .
Increased the channel name limit to solve importation issues.
The preset for Save to Server destination now saves the correct destination name.
Fixed an issue where the missing Printer "Alias" user for Save to Server destination created the wrong file

https://inedit.freshdesk.com/en/support/solutions/articles/14000143450-layout-for-neocatalog-request-order-and-items-data
https://inedit.freshdesk.com/en/support/solutions/articles/14000139727
https://inedit.freshdesk.com/en/support/solutions/articles/14000139303
https://inedit.freshdesk.com/en/support/solutions/articles/14000139889-import-designs-in-neocatalog


names in the wrong destination.
Watermarks are now properly saved on presets .

neoCatalog 3.16.9
April 2023

What’s New

Improved management for Sections . Now the sections can be removed from Categorizations.

Improved design and colorway update workflow.

Watch Video: https://player.vimeo.com/video/816852926

Improved multiple-session Print download progress.

Bug Fixes

Fixed crash on Simulation print after importing digital design
Fixed export quality that used PDF qualities

neoCatalog 3.16.8
March 2023

What’s New

Split request orders into multiple orders.
New footer options organization that groups Exit, Share & Download options for better accessibility.

https://inedit.freshdesk.com/en/support/solutions/articles/14000139684
https://inedit.freshdesk.com/en/support/solutions/articles/14000139302
https://inedit.freshdesk.com/en/support/solutions/articles/14000139357
https://inedit.freshdesk.com/en/support/solutions/articles/14000142261
https://player.vimeo.com/video/816852926
https://inedit.freshdesk.com/en/support/solutions/articles/14000139302
https://inedit.freshdesk.com/a/solutions/articles/14000140214?lang=en


Now you can duplicate existing galleries .
With advanced preference , we can show a color patch with channel names in subtitles and an expanded
channel patch view shows the channel color below the channel name.

The help widget connects with the Freshdesk knowledge base.

Print option got yards unit for custom size.
Email Notifications show the user's email instead user ID.
Now the invited users have been redirected to the neoCatalog URL instead Desktop app.
Updated Clarifai version. This update changes the Clarifai setup in neoCatalog with extra authentications.

Bug Fixes

Customer users cannot view attachments. New user privileges to manage the attachments.
Fixed status color and status replacement.
Request orders bulk handling when moving between states.
XJB file generation with big files.
Fixed minor interface issues.

neoCatalog 3.16.7
February 2023

What’s New

not included.

https://inedit.freshdesk.com/a/solutions/articles/14000130319?lang=en
https://inedit.freshdesk.com/a/solutions/articles/14000141780?lang=en
https://inedit.freshdesk.com/a/solutions/articles/14000141782/edit?lang=en
https://inedit.freshdesk.com/a/solutions/articles/14000139302?lang=en
https://inedit.freshdesk.com/en/support/solutions/articles/14000141948-how-to-tag-designs-with-clarifai-ai
https://inedit.freshdesk.com/a/solutions/articles/14000139300?lang=en


Bug Fixes

Fixed compilation error.

neoCatalog 3.16.6
February 2023

What’s New

The Shopping Cart setting moves to open administration preferences .

Bug Fixes

Fixed undefined users for requests when editing request orders.
Fixed update for digital design and colorway when uploading a file from the edit dialog.
Fixed error downloading separated design by the user who owns it.

neoCatalog 3.16.5
January 2023

What’s New

QuickLogin to authenticate users without a password: Advanced option to enable and activate quick login
feature for individual users. Once in use, just with only one click the user is logged in.

Watch Video: https://player.vimeo.com/video/794041306 

Filter Gallery Items by keywords
Extended option to use high-quality simulations in printouts.
Designs and Colorways sort type Sort by ID (Descending) .

Bug Fixes

Fixed login captcha in Windows.
Fixed crashes in Request order creation and management.
Fixed user customer logos uploads.

neoCatalog 3.16.4
December 2022

What’s New

Custom information dialog : New custom dialog that allows customizing content and order of design and
colorway information.

Watch Video: https://player.vimeo.com/video/783304065

https://inedit.freshdesk.com/en/support/solutions/articles/14000140891-how-to-enable-request-orders-and-shopping-cart-features
https://app.shortcut.com/inedit/story/24290/error-downloading-separated-design-by-the-user-who-owns-it-3-16-5-b-8
https://inedit.freshdesk.com/a/solutions/articles/14000140639?lang=en
https://player.vimeo.com/video/794041306
https://inedit.freshdesk.com/a/solutions/articles/14000130319/edit?lang=en
https://inedit.freshdesk.com/en/support/solutions/articles/14000140640-max-quality-for-print-simulation-objects-advanced-
https://inedit.freshdesk.com/en/support/solutions/articles/14000139928-design-searching-and-navigation
https://player.vimeo.com/video/783304065


New option in open administration to replace status in designs.

Watch Video: https://player.vimeo.com/video/783304118

Channel name shown in colorways patches.
New user privilege "Advanced edit". When is set to "Not Allowed", then the Section and Verifications options
are hidden for users with Edit privileges.
Show gallery name in ribbon in designs thumbnails.
New field for coordinated designs in Advanced Search.
Added preference to enable double confirmation when deleting design.
Now we can rename titles in the glossary in design and colorway information.

Bug Fixes

Fixed crashes in one session after a logged-in User deletes one design in another session
Fixed deleting digital design with digital colorways.
Fixed Error downloading digital designs owned by the logged-in customer.
Fixed comments in emails when sending PDFs.
Fixed Hotfolder QuickPrint Scenarios.
Fixed group selection when inviting users.

neoCatalog 3.16.3
November 2022

What’s New

Possibility to have the different watermark texture blend mode in previews.
Share sample preview alignment on the origin of the sample page.
Notifications type for deleting items (design & colorway).

Bug Fixes

Fixed downloading with Layout Size horizontal turns the layout to vertical.

neoCatalog 3.16.2
October 2022

What’s New

Support implementation for Alph file format.

https://player.vimeo.com/video/783304118


Bug Fixes

Fixed sending quick-print jobs from iOS to neoCatalog Server.
Fixed failed connection and publish colorways from Control Center.
Gridster component replaced to fix object position and resize.

neoCatalog 3.16.0
September 2022

What’s New

Improved colorway coloring: Type color libraries' color names in the channel to search and apply color.
Move from one to the next channel with the tab keyboard. Color picker is supported and based on your web
browser where you have started your neoCatalog session.

Watch Video: https://player.vimeo.com/video/749518213

Request Orders: Based on user privileges (Now Allowed for Sales Information) we can hide the customer
names in the request orders. Additionally, you can create new orders with new items.

Watch Video: https://player.vimeo.com/video/749524619 

New state "Status" action rule for request orders: When the action to change status is used in a state and once
a request is moved to this state, then the status is created the same as the name of the state that will be

embedded in the design information. 
Shared Samples preview has new advanced preferences to increase the preview quality and modify inside
sizes.

Accordion previews have new advanced preferences to increase preview quality and modify inside sizes.

Custom offset is now applied in thumbnails automatically.

The ruler in the detailed previews can be disabled from advanced preferences.

The modification date of the colorway is new as one of the default fields for colorway information that can be
added in the dialog.

New process of advanced integrity to repair wrong digital designs files path when they have been moved or
changed.

New option to select the section in Multiple file import that will import all files from the defined folder path into
the section. 

Bug Fixes

Fixed ICC path when working with embedded profiles in colorways.

Fixed multiple file importation when importing with Multiple file importation process.

Fixed to be able to change the state position for Request Order.

Fixed crash on replacing keyboards in administration.

Fixed that Gridster view in Galleries can show attachments in all supported web browsers.

https://player.vimeo.com/video/749518213
https://player.vimeo.com/video/749524619


Release Notes nC v3.2

neoCatalog 3.2
June 2019

What’s New

Automatic Image and tags

The automated option will index your designs and detect if similar designs in your neoCatalog exist. It allows you to
search images with two options:

Automatically generated tags so that the search of designs is easier using design character parameters.
Search images that are visually similar to any designated query image.

As a neoCatalog admin user, you need to configure the option of using Clarifai API . In neoCatalog Administration
go to Preferences > Modules and enable the 'Tags':

Create and share neoCatalogs (Desktop app)

After app installation and activation, you will reach the neoCatalog viewer. The viewer is providing two options to
create and work with neoCatalog:

https://inedit.freshdesk.com/en/support/solutions/articles/14000141948
https://www.clarifai.com/search


Local is to create a local neoCatalog.
Remote is to connect to an existing neoCatalog Server.

Bug Fixes

Fixed minor bugs.

Release Notes nC v3.3

neoCatalog 3.3
November 2019

What’s New

New thumbnail preview style for modern, clean, and easy customizations.

https://inedit.freshdesk.com/en/support/solutions/articles/14000139727




New Print option for cleaner, and more intuitive and it displays all the pages using high-quality previews.

https://inedit.freshdesk.com/en/support/solutions/articles/14000139302


New functionality to share Design Samples by mail also with people who do have not access to neoCatalog.
Improved multiple selection modes and added an option to select the whole page.
Added Option to download auto-compressed and archived logs from the Administration page .

Bug Fixes

Fixed minor bugs and stability improvements.

Release Notes nC v3.4

neoCatalog 3.4
December 2019

What’s New

Sharing samples pages with QR code

This function is perfect to share your colorways in a sample page with design information and simulations with
people without access to neoCatalog. It will share a public link that can be accessed without a login.

https://inedit.freshdesk.com/en/support/solutions/articles/14000139301
https://inedit.freshdesk.com/en/support/solutions/articles/14000139928
https://inedit.freshdesk.com/en/support/solutions/articles/14000139740
https://inedit.freshdesk.com/en/support/solutions/articles/14000139301


New Activation System

It allows you to register the product , request trials, or get reminders about the demo licenses.

Watch Video: https://www.youtube.com/embed/CTY-42IUCsA?&wmode=opaque 

More:

Added rating dialog, so you can help us improve.
On the user management page, you can set the user Agent person or group , so they can see the customer-
exclusive items.
Added option to show the Coordinated design code on the design thumbnails.
Added preference to allow wild cards in Alias than searching for designs. I.e.: *CDE*.
Improved performance on big databases.
Improved speed when logging into the application.
Now the preview is getting refreshed automatically when modifying size in Preview Style .
Improved Thumbnails by adding an option to show/hide field labels in design preview Cards.
Improved Thumbnails by showing “...” when the text doesn’t fit the label.
Improved Print dialog by disabling the Download button when there is no element selected to print.
Deprecated old Quickprint dialogs.

Bug Fixes

Fixed minor bugs and wrong translations.

Release Notes nC v3.5

https://inedit.freshdesk.com/en/support/solutions/articles/14000101460
https://www.youtube.com/embed/CTY-42IUCsA?&wmode=opaque
https://inedit.freshdesk.com/en/support/solutions/articles/14000139304
https://inedit.freshdesk.com/en/support/solutions/articles/14000139727


neoCatalog 3.5
February 2020

What’s New

Watermarks in neoCatalog 
Applies your company logo as a watermark in your design view and output according to the user privileges. The
preview in preview modes will use the watermark.

More:

Added option to print to the system printer .

https://inedit.freshdesk.com/en/support/solutions/articles/14000139684
https://inedit.freshdesk.com/en/support/solutions/articles/14000139302


Added status indicator in System Info (Administration) for neoCatalog availability from the internet .
Added option to select Administrators and Managers as colorists.
Added agents field also for Contacts and moved to make it more visible.
Improved the quality of thumbnails and HQ previews.
Also using progressive JPEGs for HQ previews to improve speed on slow connections.
Improved app start time 2x faster.
Improved app general performance.

Bug Fixes

Fixed creating new local neoCatalog.
Fixed install redistributable packages when needed.

Release Notes nC v3.6

neoCatalog 3.6
April 2020

What’s New

Groups of simulation models 
Now they can be added to one or multiple groups from Simulations Management in Administration and it will show
the simulations objects grouped on the designs navigation, Simulations view, and Printing view.

Rulers on the design's detail view 
Being in detail view , on the top and left in the preview a ruler is positioned that adapts to the zoom in and out.

https://inedit.freshdesk.com/en/support/solutions/articles/14000139740
https://inedit.freshdesk.com/en/support/solutions/articles/14000139683-simulations-objects-management
https://inedit.freshdesk.com/en/support/solutions/articles/14000139697
https://inedit.freshdesk.com/en/support/solutions/articles/14000139929




Azure authentication (neoCatalog Server) 
New option to use Microsoft Azure authentication. Having the Azure authentication in neoCatalog, when login, the
Azure Authentication Agent retrieves the username and encrypted password. The preference is used in
neoCatalog's Advanced preferences.

More:

Email validation on users management form - Save preset name validation on the printing view.
Improved device connection dialog with sub-apps and goBack button.
Removed option to download Low Quality in .v format.
Improved keyword search accuracy.
Improved the Spanish Translation.

Bug Fixes

Now the exported simulations JPG do not use disabled parts of the simulations object.
Country codes language like English-GB were not detected and showed no translated variables.
Wrong selected design and colorway when using multiple selection modes after a single selection mode.

Release Notes nC v3.7

neoCatalog 3.7
July 2020

What’s New

Share files via the Amazon link

Send PDF files to Amazon from the Print option that can be downloaded with the link in the email.

https://inedit.freshdesk.com/en/support/solutions/articles/14000139302


Embedded keyword detected from XMP metadata

When importing a design that contains a keyword in XMP added in Photoshop, later when importing a design, it will
be detected as a neoCatalog tag.

Bug Fixes

Fixed crash with new drag&drop dialog when being in Catalan or Spanish system language.
Fixed page crash when canceling new drag&drop importation (black screen).
Fixed send crash reports service.

https://inedit.freshdesk.com/en/support/solutions/articles/14000142908
https://inedit.slack.com/team/U03TL5S01


Release Notes nC v3.8

neoCatalog 3.8
November 2020

What’s New

Flooring paneling simulation

Once the paneling options are created , being in the design's detail view or going to the Simulations page, a new
button appears that will apply the paneling options .

Bug Fixes

Error when trying to remove tags.
Updating the design from the Edit design information does not detect the metadata from the existing design.
Automatic tags are not created in the Portuguese language.
Fixed minor bugs.

Release Notes nC v3.9

neoCatalog 3.9
January 2021

What’s New

Restyled color patches in color libraries

You can customize the view of the library with the adjustment button next to the library name, where you choose the
size of the patches and view the color name, or not. The adjustments are based on the logged-in user and will remain
for the user only on the coloring colorway and simulations page.

https://inedit.freshdesk.com/en/support/solutions/articles/14000139699
https://inedit.freshdesk.com/en/support/solutions/articles/14000139698
https://inedit.freshdesk.com/en/support/solutions/articles/14000140077


Download files from the Cloud service

Every user has the option to enable or disable cloud download under the user icon. Once enabled and when
downloading the design file, then it will be sent and stored on the cloud and kept there for 7 days.

Add Support for the new Section Module

With the new Sections Modules , you can create new areas to define files like Artwork, Original, etc. The new section
is located on the top tabs and at the beginning having no data included.

https://inedit.freshdesk.com/en/support/solutions/articles/14000139691
https://inedit.freshdesk.com/en/support/solutions/articles/14000139357


Bug Fixes

Fixed zoom for the simulations previews.
Fixed publishing colorways from the panel to the app.
Fixed when creating a new color library then it replaces another library.
Previews for colorways created from T colorways.
Fixed minor interface issues.

Inèdit Software | All rights reserved
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